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Basic Safety Instructions

Always read through and comply with the following safety instructions!

All plants and locations of the Rohde & Schwarz group of companies make every effort to keep the safety
standards of our products up to date and to offer our customers the highest possible degree of safety. Our
products and the auxiliary equipment they require are designed, built and tested in accordance with the
safety standards that apply in each case. Compliance with these standards is continuously monitored by
our quality assurance system. The product described here has been designed, built and tested in
accordance with the attached EC Certificate of Conformity and has left the manufacturer’s plant in a
condition fully complying with safety standards. To maintain this condition and to ensure safe operation,
you must observe all instructions and warnings provided in this manual. If you have any questions
regarding these safety instructions, the Rohde & Schwarz group of companies will be happy to answer
them.

Furthermore, it is your responsibility to use the product in an appropriate manner. This product is designed
for use solely in industrial and laboratory environments or, if expressly permitted, also in the field and must
not be used in any way that may cause personal injury or property damage. You are responsible if the
product is used for any intention other than its designated purpose or in disregard of the manufacturer's
instructions. The manufacturer shall assume no responsibility for such use of the product.

The product is used for its designated purpose if it is used in accordance with its product documentation
and within its performance limits (see data sheet, documentation, the following safety instructions). Using
the product requires technical skills and a basic knowledge of English. It is therefore essential that only
skilled and specialized staff or thoroughly trained personnel with the required skills be allowed to use the
product. If personal safety gear is required for using Rohde & Schwarz products, this will be indicated at
the appropriate place in the product documentation. Keep the basic safety instructions and the product
documentation in a safe place and pass them on to the subsequent users.

Observing the safety instructions will help prevent personal injury or damage of any kind caused by
dangerous situations. Therefore, carefully read through and adhere to the following safety instructions
before and when using the product. It is also absolutely essential to observe the additional safety
instructions on personal safety, for example, that appear in relevant parts of the product documentation. In
these safety instructions, the word "product” refers to all merchandise sold and distributed by the Rohde &
Schwarz group of companies, including instruments, systems and all accessories.

Symbols and safety labels

A A&AMNAASG BN L

Notice, general Caution Danger of Warning! PE terminal Ground Ground Be careful when
danger location when electric Hot surface terminal handling
handling shock electrostatic
Observe prqduct heavy sensitive
documentation equipment devices

| O D — ~ ~ O

ON/OFF supply | Standby Direct current Alternating current | Direct/alternating | Device fully protected by
voltage indication (DC) (AC) current (DC/AC) double (reinforced) insulation
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Basic Safety Instructions

Tags and their meaning

The following signal words are used in the product documentation in order to warn the reader about risks
and dangers.

indicates a hazardous situation which, if not avoided, will result in death or
A DANGER serious injury.

indicates a hazardous situation which, if not avoided, could result in death or
serious injury.

A WARNING

indicates a hazardous situation which, if not avoided, could result in minor or
moderate injury.

indicates the possibility of incorrect operation which can result in damage to
NOTICE the product.

In the product documentation, the word ATTENTION is used synonymously.

A CAUTION

These tags are in accordance with the standard definition for civil applications in the European Economic
Area. Definitions that deviate from the standard definition may also exist in other economic areas or
military applications. It is therefore essential to make sure that the tags described here are always used
only in connection with the related product documentation and the related product. The use of tags in
connection with unrelated products or documentation can result in misinterpretation and in personal injury
or material damage.

Operating states and operating positions

The product may be operated only under the operating conditions and in the positions specified by the
manufacturer, without the product's ventilation being obstructed. If the manufacturer's specifications are
not observed, this can result in electric shock, fire and/or serious personal injury or death. Applicable local
or national safety regulations and rules for the prevention of accidents must be observed in all work
performed.

1. Unless otherwise specified, the following requirements apply to Rohde & Schwarz products:
predefined operating position is always with the housing floor facing down, IP protection 2X, pollution
severity 2, overvoltage category 2, use only indoors, max. operating altitude 2000 m above sea level,
max. transport altitude 4500 m above sea level. A tolerance of £10 % shall apply to the nominal
voltage and +5 % to the nominal frequency.

2. Do not place the product on surfaces, vehicles, cabinets or tables that for reasons of weight or stability
are unsuitable for this purpose. Always follow the manufacturer's installation instructions when
installing the product and fastening it to objects or structures (e.g. walls and shelves). An installation
that is not carried out as described in the product documentation could result in personal injury or
death.

3. Do not place the product on heat-generating devices such as radiators or fan heaters. The ambient
temperature must not exceed the maximum temperature specified in the product documentation or in
the data sheet. Product overheating can cause electric shock, fire and/or serious personal injury or
death.
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Basic Safety Instructions

Electrical safety

If the information on electrical safety is not observed either at all to the extent necessary, electric shock,
fire and/or serious personal injury or death may occur.

1. Prior to switching on the product, always ensure that the nominal voltage setting on the product
matches the nominal voltage of the AC supply network. If a different voltage is to be set, the power
fuse of the product may have to be changed accordingly.

2. Inthe case of products of safety class | with movable power cord and connector, operation is
permitted only on sockets with an earthing contact and protective earth connection.

3. Intentionally breaking the protective earth connection either in the feed line or in the product itself is
not permitted. Doing so can result in the danger of an electric shock from the product. If extension
cords or connector strips are implemented, they must be checked on a regular basis to ensure that
they are safe to use.

4. If the product does not have a power switch for disconnection from the AC supply network, the plug of
the connecting cable is regarded as the disconnecting device. In such cases, always ensure that the
power plug is easily reachable and accessible at all times (corresponding to the length of connecting
cable, approx. 2 m). Functional or electronic switches are not suitable for providing disconnection from
the AC supply network. If products without power switches are integrated into racks or systems, a
disconnecting device must be provided at the system level.

5. Never use the product if the power cable is damaged. Check the power cable on a regular basis to
ensure that it is in proper operating condition. By taking appropriate safety measures and carefully
laying the power cable, you can ensure that the cable will not be damaged and that no one can be
hurt by, for example, tripping over the cable or suffering an electric shock.

6. The product may be operated only from TN/TT supply networks fused with max. 16 A (higher fuse
only after consulting with the Rohde & Schwarz group of companies).

7. Do notinsert the plug into sockets that are dusty or dirty. Insert the plug firmly and all the way into the
socket. Otherwise, sparks that result in fire and/or injuries may occur.

8. Do not overload any sockets, extension cords or connector strips; doing so can cause fire or electric
shocks.

9. For measurements in circuits with voltages Vs > 30 V, suitable measures (e.g. appropriate
measuring equipment, fusing, current limiting, electrical separation, insulation) should be taken to
avoid any hazards.

10. Ensure that the connections with information technology equipment, e.g. PCs or other industrial
computers, comply with the IEC60950-1/EN60950-1 or IEC61010-1/EN 61010-1 standards that apply
in each case.

11. Unless expressly permitted, never remove the cover or any part of the housing while the product is in
operation. Doing so will expose circuits and components and can lead to injuries, fire or damage to the
product.

12. If a product is to be permanently installed, the connection between the PE terminal on site and the
product's PE conductor must be made first before any other connection is made. The product may be
installed and connected only by a licensed electrician.

13. For permanently installed equipment without built-in fuses, circuit breakers or similar protective
devices, the supply circuit must be fused in such a way that anyone who has access to the product, as
well as the product itself, is adequately protected from injury or damage.
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14.

15.

16.

17.

18.

Basic Safety Instructions

Use suitable overvoltage protection to ensure that no overvoltage (such as that caused by a bolt of
lightning) can reach the product. Otherwise, the person operating the product will be exposed to the
danger of an electric shock.

Any object that is not designed to be placed in the openings of the housing must not be used for this
purpose. Doing so can cause short circuits inside the product and/or electric shocks, fire or injuries.

Unless specified otherwise, products are not liquid-proof (see also section "Operating states and
operating positions", item 1. Therefore, the equipment must be protected against penetration by
liquids. If the necessary precautions are not taken, the user may suffer electric shock or the product
itself may be damaged, which can also lead to personal injury.

Never use the product under conditions in which condensation has formed or can form in or on the
product, e.g. if the product has been moved from a cold to a warm environment. Penetration by water
increases the risk of electric shock.

Prior to cleaning the product, disconnect it completely from the power supply (e.g. AC supply network
or battery). Use a soft, non-linting cloth to clean the product. Never use chemical cleaning agents such
as alcohol, acetone or diluents for cellulose lacquers.

Operation

1.

Operating the products requires special training and intense concentration. Make sure that persons
who use the products are physically, mentally and emotionally fit enough to do so; otherwise, injuries
or material damage may occur. It is the responsibility of the employer/operator to select suitable
personnel for operating the products.

Before you move or transport the product, read and observe the section titled "Transport".

As with all industrially manufactured goods, the use of substances that induce an allergic reaction
(allergens) such as nickel cannot be generally excluded. If you develop an allergic reaction (such as a
skin rash, frequent sneezing, red eyes or respiratory difficulties) when using a Rohde & Schwarz
product, consult a physician immediately to determine the cause and to prevent health problems or
stress.

Before you start processing the product mechanically and/or thermally, or before you take it apart, be
sure to read and pay special attention to the section titled "Waste disposal", item 1.

Depending on the function, certain products such as RF radio equipment can produce an elevated
level of electromagnetic radiation. Considering that unborn babies require increased protection,
pregnant women must be protected by appropriate measures. Persons with pacemakers may also be
exposed to risks from electromagnetic radiation. The employer/operator must evaluate workplaces
where there is a special risk of exposure to radiation and, if necessary, take measures to avert the
potential danger.

Should a fire occur, the product may release hazardous substances (gases, fluids, etc.) that can
cause health problems. Therefore, suitable measures must be taken, e.g. protective masks and
protective clothing must be worn.

If a laser product (e.g. a CD/DVD drive) is integrated into a Rohde & Schwarz product, absolutely no
other settings or functions may be used as described in the product documentation. The objective is to
prevent personal injury (e.g. due to laser beams).
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Basic Safety Instructions

Repair and service

1.

The product may be opened only by authorized, specially trained personnel. Before any work is
performed on the product or before the product is opened, it must be disconnected from the AC supply
network. Otherwise, personnel will be exposed to the risk of an electric shock.

Adjustments, replacement of parts, maintenance and repair may be performed only by electrical
experts authorized by Rohde & Schwarz. Only original parts may be used for replacing parts relevant
to safety (e.g. power switches, power transformers, fuses). A safety test must always be performed
after parts relevant to safety have been replaced (visual inspection, PE conductor test, insulation
resistance measurement, leakage current measurement, functional test). This helps ensure the
continued safety of the product.

Batteries and rechargeable batteries/cells

If the information regarding batteries and rechargeable batteries/cells is not observed either at all or to the
extent necessary, product users may be exposed to the risk of explosions, fire and/or serious personal
injury, and, in some cases, death. Batteries and rechargeable batteries with alkaline electrolytes (e.g.
lithium cells) must be handled in accordance with the EN 62133 standard.

1.
2.

Cells must not be taken apart or crushed.

Cells or batteries must not be exposed to heat or fire. Storage in direct sunlight must be avoided.
Keep cells and batteries clean and dry. Clean soiled connectors using a dry, clean cloth.

Cells or batteries must not be short-circuited. Cells or batteries must not be stored in a box orin a
drawer where they can short-circuit each other, or where they can be short-circuited by other
conductive materials. Cells and batteries must not be removed from their original packaging until they
are ready to be used.

Keep cells and batteries out of the hands of children. If a cell or a battery has been swallowed, seek
medical aid immediately.

Cells and batteries must not be exposed to any mechanical shocks that are stronger than permitted.

If a cell develops a leak, the fluid must not be allowed to come into contact with the skin or eyes. If
contact occurs, wash the affected area with plenty of water and seek medical aid.

Improperly replacing or charging cells or batteries that contain alkaline electrolytes (e.g. lithium cells)
can cause explosions. Replace cells or batteries only with the matching Rohde & Schwarz type (see
parts list) in order to ensure the safety of the product.

Cells and batteries must be recycled and kept separate from residual waste. Rechargeable batteries
and normal batteries that contain lead, mercury or cadmium are hazardous waste. Observe the
national regulations regarding waste disposal and recycling.

Transport

1.

The product may be very heavy. Therefore, the product must be handled with care. In some cases,
the user may require a suitable means of lifting or moving the product (e.g. with a lift-truck) to avoid
back or other physical injuries.
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Informaciones elementales de seguridad

2. Handles on the products are designed exclusively to enable personnel to transport the product. It is
therefore not permissible to use handles to fasten the product to or on transport equipment such as
cranes, fork lifts, wagons, etc. The user is responsible for securely fastening the products to or on the
means of transport or lifting. Observe the safety regulations of the manufacturer of the means of
transport or lifting. Noncompliance can result in personal injury or material damage.

3. If you use the product in a vehicle, it is the sole responsibility of the driver to drive the vehicle safely
and properly. The manufacturer assumes no responsibility for accidents or collisions. Never use the
product in a moving vehicle if doing so could distract the driver of the vehicle. Adequately secure the
product in the vehicle to prevent injuries or other damage in the event of an accident.

Waste disposal

1. If products or their components are mechanically and/or thermally processed in a manner that goes
beyond their intended use, hazardous substances (heavy-metal dust such as lead, beryllium, nickel)
may be released. For this reason, the product may only be disassembled by specially trained
personnel. Improper disassembly may be hazardous to your health. National waste disposal
regulations must be observed.

2. If handling the product releases hazardous substances or fuels that must be disposed of in a special
way, e.g. coolants or engine oils that must be replenished regularly, the safety instructions of the
manufacturer of the hazardous substances or fuels and the applicable regional waste disposal
regulations must be observed. Also observe the relevant safety instructions in the product
documentation. The improper disposal of hazardous substances or fuels can cause health problems
and lead to environmental damage.

Informaciones elementales de seguridad

Es imprescindible leer y observar las siguientes instrucciones e informaciones de seguridad!

El principio del grupo de empresas Rohde & Schwarz consiste en tener nuestros productos siempre al dia
con los estandares de seguridad y de ofrecer a nuestros clientes el maximo grado de seguridad. Nuestros
productos y todos los equipos adicionales son siempre fabricados y examinados segun las normas de
seguridad vigentes. Nuestro sistema de garantia de calidad controla constantemente que sean cumplidas
estas normas. El presente producto ha sido fabricado y examinado segun el certificado de conformidad
adjunto de la UE y ha salido de nuestra planta en estado impecable segun los estandares técnicos de
seguridad. Para poder preservar este estado y garantizar un funcionamiento libre de peligros, el usuario
debera atenerse a todas las indicaciones, informaciones de seguridad y notas de alerta. El grupo de
empresas Rohde & Schwarz esta siempre a su disposicion en caso de que tengan preguntas referentes a
estas informaciones de seguridad.

Ademas queda en la responsabilidad del usuario utilizar el producto en la forma debida. Este producto
estd destinado exclusivamente al uso en la industria y el laboratorio o, si ha sido expresamente
autorizado, para aplicaciones de campo y de ninguna manera debera ser utilizado de modo que alguna
persona/cosa pueda sufrir dafio. El uso del producto fuera de sus fines definidos o sin tener en cuenta las
instrucciones del fabricante queda en la responsabilidad del usuario. El fabricante no se hace en ninguna
forma responsable de consecuencias a causa del mal uso del producto.
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Informaciones elementales de seguridad

Se parte del uso correcto del producto para los fines definidos si el producto es utilizado conforme a las
indicaciones de la correspondiente documentacion del producto y dentro del margen de rendimiento
definido (ver hoja de datos, documentacion, informaciones de seguridad que siguen). El uso del producto
hace necesarios conocimientos técnicos y ciertos conocimientos del idioma inglés. Por eso se debe tener
en cuenta que el producto solo pueda ser operado por personal especializado o personas instruidas en
profundidad con las capacidades correspondientes. Si fuera necesaria indumentaria de seguridad para el
uso de productos de Rohde & Schwarz, encontraria la informacion debida en la documentacion del
producto en el capitulo correspondiente. Guarde bien las informaciones de seguridad elementales, asi
como la documentacion del producto, y entréguelas a usuarios posteriores.

Tener en cuenta las informaciones de seguridad sirve para evitar en lo posible lesiones o dafios por
peligros de toda clase. Por eso es imprescindible leer detalladamente y comprender por completo las
siguientes informaciones de seguridad antes de usar el producto, y respetarlas durante el uso del
producto. Deberan tenerse en cuenta todas las demas informaciones de seguridad, como p. €j. las
referentes a la proteccién de personas, que encontraran en el capitulo correspondiente de la
documentacion del producto y que también son de obligado cumplimiento. En las presentes
informaciones de seguridad se recogen todos los objetos que distribuye el grupo de empresas

Rohde & Schwarz bajo la denominacién de "producto”, entre ellos también aparatos, instalaciones asi
como toda clase de accesorios.

Simbolos y definiciones de seguridad

1 (i) 1

18 kg —
Aviso: punto de Atencién en Peligro de Adver- Conexién a Conexion | Conexién Aviso: Cuidado
peligro general el manejo de | choque tencia: conductor de | a tierra amasa en el manejo de
dispositivos eléctrico superficie proteccion dispositivos
Observar la o, de peso caliente sensibles a la
documentacion elevado electrostatica

del producto

(ESD)
| O <D —— N TN D
Tension de Indicacion de Corriente Corriente alterna | Corriente El aparato esta protegido
alimentacion de estado de continua (DC) (AC) continua / en su totalidad por un
PUESTAEN espera Corriente alterna | aislamiento doble
MARCHA / (Standby) (DC/AC) (reforzado)
PARADA
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Informaciones elementales de seguridad

Palabras de seiial y su significado

En la documentacion del producto se utilizan las siguientes palabras de sefal con el fin de advertir contra
riesgos y peligros.

PELIGRO identifica un peligro inminente con riesgo elevado que
A PELIGRO provocara muerte o lesiones graves si no se evita.
ADVERTENCIA identifica un posible peligro con riesgo medio de
A ADVERTENCIA provocar muerte o lesiones (graves) si no se evita.

ATENCION identifica un peligro con riesgo reducido de provocar

A ATENCION lesiones leves o0 moderadas si no se evita.
AVISO indica la posibilidad de utilizar mal el producto y, como
m consecuencia, danarlo.

En la documentacién del producto se emplea de forma sinénima el
término CUIDADO.

Las palabras de sefal corresponden a la definicion habitual para aplicaciones civiles en el area
economica europea. Pueden existir definiciones diferentes a esta definicidon en otras areas econémicas o
en aplicaciones militares. Por eso se debera tener en cuenta que las palabras de sefal aqui descritas
sean utilizadas siempre solamente en combinacion con la correspondiente documentacion del producto y
solamente en combinacién con el producto correspondiente. La utilizacién de las palabras de senal en
combinacion con productos o documentaciones que no les correspondan puede llevar a interpretaciones
equivocadas y tener por consecuencia dafios en personas u objetos.

Estados operativos y posiciones de funcionamiento

El producto solamente debe ser utilizado segun lo indicado por el fabricante respecto a los estados
operativos y posiciones de funcionamiento sin que se obstruya la ventilacion. Si no se siguen las
indicaciones del fabricante, pueden producirse choques eléctricos, incendios y/o lesiones graves con
posible consecuencia de muerte. En todos los trabajos deberan ser tenidas en cuenta las normas
nacionales y locales de seguridad del trabajo y de prevencion de accidentes.

1. Sino se convino de otra manera, es para los productos Rohde & Schwarz valido lo que sigue:
como posicion de funcionamiento se define por principio la posicién con el suelo de la caja para
abajo, modo de proteccion IP 2X, grado de suciedad 2, categoria de sobrecarga eléctrica 2, uso
solamente en estancias interiores, utilizacion hasta 2000 m sobre el nivel del mar, transporte hasta
4500 m sobre el nivel del mar. Se aplicara una tolerancia de £10 % sobre el voltaje nominal y de
+5 % sobre la frecuencia nominal.

2. No situe el producto encima de superficies, vehiculos, estantes o mesas, que por sus caracteristicas
de peso o de estabilidad no sean aptos para él. Siga siempre las instrucciones de instalacion del
fabricante cuando instale y asegure el producto en objetos o estructuras (p. ej. paredes y estantes). Si
se realiza la instalacién de modo distinto al indicado en la documentacién del producto, pueden
causarse lesiones o incluso la muerte.

3. No ponga el producto sobre aparatos que generen calor (p. €j. radiadores o calefactores). La
temperatura ambiente no debe superar la temperatura maxima especificada en la documentacion del
producto o en la hoja de datos. En caso de sobrecalentamiento del producto, pueden producirse
choques eléctricos, incendios y/o lesiones graves con posible consecuencia de muerte.
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Informaciones elementales de seguridad

Seguridad eléctrica

Si no se siguen (o se siguen de modo insuficiente) las indicaciones del fabricante en cuanto a seguridad
eléctrica, pueden producirse choques eléctricos, incendios y/o lesiones graves con posible consecuencia
de muerte.

1.

10.

11.

Antes de la puesta en marcha del producto se debera comprobar siempre que la tensién
preseleccionada en el producto coincida con la de la red de alimentacion eléctrica. Si es necesario
modificar el ajuste de tension, también se deberan cambiar en caso dado los fusibles
correspondientes del producto.

Los productos de la clase de proteccién | con alimentacion moévil y enchufe individual solamente
podran enchufarse a tomas de corriente con contacto de seguridad y con conductor de proteccion
conectado.

Queda prohibida la interrupcion intencionada del conductor de proteccion, tanto en la toma de
corriente como en el mismo producto. La interrupcién puede tener como consecuencia el riesgo de
que el producto sea fuente de choques eléctricos. Si se utilizan cables alargadores o regletas de
enchufe, debera garantizarse la realizacion de un examen regular de los mismos en cuanto a su
estado técnico de seguridad.

Si el producto no esta equipado con un interruptor para desconectarlo de la red, se debera considerar
el enchufe del cable de conexién como interruptor. En estos casos se debera asegurar que el enchufe
siempre sea de facil acceso (de acuerdo con la longitud del cable de conexion, aproximadamente

2 m). Los interruptores de funcion o electronicos no son aptos para el corte de la red eléctrica. Si los
productos sin interruptor estan integrados en bastidores o instalaciones, se debera colocar el
interruptor en el nivel de la instalacion.

No utilice nunca el producto si esta dafiado el cable de conexién a red. Compruebe regularmente el
correcto estado de los cables de conexion a red. Asegurese, mediante las medidas de proteccion y
de instalacion adecuadas, de que el cable de conexién a red no pueda ser danado o de que nadie
pueda ser danado por él, p. €j. al tropezar o por un choque eléctrico.

Solamente esta permitido el funcionamiento en redes de alimentacion TN/TT aseguradas con fusibles
de 16 A como maximo (utilizaciéon de fusibles de mayor amperaje solo previa consulta con el grupo de
empresas Rohde & Schwarz).

Nunca conecte el enchufe en tomas de corriente sucias o llenas de polvo. Introduzca el enchufe por
completo y fuertemente en la toma de corriente. La no observacion de estas medidas puede provocar
chispas, fuego y/o lesiones.

No sobrecargue las tomas de corriente, los cables alargadores o las regletas de enchufe ya que esto
podria causar fuego o choques eléctricos.

En las mediciones en circuitos de corriente con una tensidon Ug; > 30 V se deberan tomar las medidas
apropiadas para impedir cualquier peligro (p. €j. medios de medicién adecuados, seguros, limitaciéon
de tension, corte protector, aislamiento etc.).

Para la conexiéon con dispositivos informaticos como un PC o un ordenador industrial, debe
comprobarse que éstos cumplan los estandares IEC60950-1/EN60950-1 o IEC61010-1/EN 61010-1
validos en cada caso.

A menos que esté permitido expresamente, no retire nunca la tapa ni componentes de la carcasa
mientras el producto esté en servicio. Esto pone a descubierto los cables y componentes eléctricos y
puede causar lesiones, fuego o dafios en el producto.
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12.

13.

14.

15.

16.

17.

18.

Informaciones elementales de seguridad

Si un producto se instala en un lugar fijo, se debera primero conectar el conductor de proteccion fijo
con el conductor de proteccion del producto antes de hacer cualquier otra conexion. La instalacion y
la conexion deberan ser efectuadas por un electricista especializado.

En el caso de dispositivos fijos que no estén provistos de fusibles, interruptor automatico ni otros
mecanismos de seguridad similares, el circuito de alimentacién debe estar protegido de modo que
todas las personas que puedan acceder al producto, asi como el producto mismo, estén a salvo de
posibles dafnos.

Todo producto debe estar protegido contra sobretension (debida p. ej. a una caida del rayo) mediante
los correspondientes sistemas de proteccion. Si no, el personal que lo utilice quedara expuesto al
peligro de choque eléctrico.

No debe introducirse en los orificios de la caja del aparato ningin objeto que no esté destinado a ello.
Esto puede producir cortocircuitos en el producto y/o puede causar choques eléctricos, fuego o
lesiones.

Salvo indicacion contraria, los productos no estan impermeabilizados (ver también el capitulo
"Estados operativos y posiciones de funcionamiento”, punto 1). Por eso es necesario tomar las
medidas necesarias para evitar la entrada de liquidos. En caso contrario, existe peligro de choque
eléctrico para el usuario o de dafos en el producto, que también pueden redundar en peligro para las
personas.

No utilice el producto en condiciones en las que pueda producirse o ya se hayan producido
condensaciones sobre el producto o en el interior de éste, como p. €j. al desplazarlo de un lugar frio a
otro caliente. La entrada de agua aumenta el riesgo de choque eléctrico.

Antes de la limpieza, desconecte por completo el producto de la alimentacién de tension (p. ej. red de
alimentacion o bateria). Realice la limpieza de los aparatos con un pafio suave, que no se deshilache.
No utilice bajo ningun concepto productos de limpieza quimicos como alcohol, acetona o diluyentes
para lacas nitrocelulésicas.

Funcionamiento

1.

2.
3.

4.

El uso del producto requiere instrucciones especiales y una alta concentracion durante el manejo.
Debe asegurarse que las personas que manejen el producto estén a la altura de los requerimientos
necesarios en cuanto a aptitudes fisicas, psiquicas y emocionales, ya que de otra manera no se
pueden excluir lesiones o dafios de objetos. El empresario u operador es responsable de seleccionar
el personal usuario apto para el manejo del producto.

Antes de desplazar o transportar el producto, lea y tenga en cuenta el capitulo "Transporte".

Como con todo producto de fabricacion industrial no puede quedar excluida en general la posibilidad
de que se produzcan alergias provocadas por algunos materiales empleados, los llamados alérgenos
(p. €j. el niquel). Si durante el manejo de productos Rohde & Schwarz se producen reacciones
alérgicas, como p. €j. irritaciones cutaneas, estornudos continuos, enrojecimiento de la conjuntiva o
dificultades respiratorias, debe avisarse inmediatamente a un médico para investigar las causas y
evitar cualquier molestia o dafio a la salud.

Antes de la manipulacién mecanica y/o térmica o el desmontaje del producto, debe tenerse en cuenta
imprescindiblemente el capitulo "Eliminacion”, punto 1.
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Informaciones elementales de seguridad

Ciertos productos, como p. €j. las instalaciones de radiocomunicacion RF, pueden a causa de su
funcion natural, emitir una radiacion electromagnética aumentada. Deben tomarse todas las medidas
necesarias para la proteccion de las mujeres embarazadas. También las personas con marcapasos
pueden correr peligro a causa de la radiacién electromagnética. El empresario/operador tiene la
obligacién de evaluar y sefializar las areas de trabajo en las que exista un riesgo elevado de
exposicion a radiaciones.

Tenga en cuenta que en caso de incendio pueden desprenderse del producto sustancias toxicas
(gases, liquidos etc.) que pueden generar dafos a la salud. Por eso, en caso de incendio deben
usarse medidas adecuadas, como p. e€j. mascaras antigas e indumentaria de proteccion.

En caso de que un producto Rohde & Schwarz contenga un producto laser (p. €j. un lector de
CD/DVD), no debe usarse ninguna otra configuracion o funcién aparte de las descritas en la
documentacién del producto, a fin de evitar lesiones (p. €j. debidas a irradiacion laser).

Reparaciéon y mantenimiento

1.

El producto solamente debe ser abierto por personal especializado con autorizacion para ello. Antes
de manipular el producto o abrirlo, es obligatorio desconectarlo de la tension de alimentacion, para
evitar toda posibilidad de choque eléctrico.

El ajuste, el cambio de partes, el mantenimiento y la reparaciéon deberan ser efectuadas solamente
por electricistas autorizados por Rohde & Schwarz. Si se reponen partes con importancia para los
aspectos de seguridad (p. €j. el enchufe, los transformadores o los fusibles), solamente podran ser
sustituidos por partes originales. Después de cada cambio de partes relevantes para la seguridad
debera realizarse un control de seguridad (control a primera vista, control del conductor de
proteccion, medicion de resistencia de aislamiento, medicién de la corriente de fuga, control de
funcionamiento). Con esto queda garantizada la seguridad del producto.

Baterias y acumuladores o celdas

Si no se siguen (o se siguen de modo insuficiente) las indicaciones en cuanto a las baterias y
acumuladores o celdas, pueden producirse explosiones, incendios y/o lesiones graves con posible
consecuencia de muerte. El manejo de baterias y acumuladores con electrolitos alcalinos (p. ej. celdas de
litio) debe seguir el estandar EN 62133.

1.
2.

No deben desmontarse, abrirse ni triturarse las celdas.

Las celdas o baterias no deben someterse a calor ni fuego. Debe evitarse el almacenamiento a la luz
directa del sol. Las celdas y baterias deben mantenerse limpias y secas. Limpiar las conexiones
sucias con un pafo seco Y limpio.

Las celdas o baterias no deben cortocircuitarse. Es peligroso almacenar las celdas o baterias en
estuches o cajones en cuyo interior puedan cortocircuitarse por contacto reciproco o por contacto con
otros materiales conductores. No deben extraerse las celdas o baterias de sus embalajes originales
hasta el momento en que vayan a utilizarse.

Mantener baterias y celdas fuera del alcance de los nifios. En caso de ingestién de una celda o
bateria, avisar inmediatamente a un médico.

Las celdas o baterias no deben someterse a impactos mecanicos fuertes indebidos.
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6. En caso de falta de estanqueidad de una celda, el liquido vertido no debe entrar en contacto con la

piel ni los ojos. Si se produce contacto, lavar con agua abundante la zona afectada y avisar a un
médico.

En caso de cambio o recarga inadecuados, las celdas o baterias que contienen electrolitos alcalinos
(p. €j. las celdas de litio) pueden explotar. Para garantizar la seguridad del producto, las celdas o
baterias solo deben ser sustituidas por el tipo Rohde & Schwarz correspondiente (ver lista de
recambios).

Las baterias y celdas deben reciclarse y no deben tirarse a la basura doméstica. Las baterias o
acumuladores que contienen plomo, mercurio o cadmio deben tratarse como residuos especiales.
Respete en esta relacién las normas nacionales de eliminacion y reciclaje.

Transporte

1.

El producto puede tener un peso elevado. Por eso es necesario desplazarlo o transportarlo con
precaucion y, si es necesario, usando un sistema de elevaciéon adecuado (p. ej. una carretilla
elevadora), a fin de evitar lesiones en la espalda u otros dafios personales.

Las asas instaladas en los productos sirven solamente de ayuda para el transporte del producto por
personas. Por eso no esta permitido utilizar las asas para la sujecion en o sobre medios de transporte
como p. ej. gruas, carretillas elevadoras de horquilla, carros etc. Es responsabilidad suya fijar los
productos de manera segura a los medios de transporte o elevacion. Para evitar dafos personales o
dafios en el producto, siga las instrucciones de seguridad del fabricante del medio de transporte o
elevacién utilizado.

Si se utiliza el producto dentro de un vehiculo, recae de manera exclusiva en el conductor la
responsabilidad de conducir el vehiculo de manera segura y adecuada. El fabricante no asumira
ninguna responsabilidad por accidentes o colisiones. No utilice nunca el producto dentro de un
vehiculo en movimiento si esto pudiera distraer al conductor. Asegure el producto dentro del vehiculo
debidamente para evitar, en caso de un accidente, lesiones u otra clase de dafos.

Eliminacion

1.

Si se trabaja de manera mecanica y/o térmica cualquier producto o componente mas alla del
funcionamiento previsto, pueden liberarse sustancias peligrosas (polvos con contenido de metales
pesados como p. ej. plomo, berilio o niquel). Por eso el producto solo debe ser desmontado por
personal especializado con formacion adecuada. Un desmontaje inadecuado puede ocasionar dafios
para la salud. Se deben tener en cuenta las directivas nacionales referentes a la eliminacion de
residuos.

En caso de que durante el trato del producto se formen sustancias peligrosas o combustibles que
deban tratarse como residuos especiales (p. j. refrigerantes o aceites de motor con intervalos de
cambio definidos), deben tenerse en cuenta las indicaciones de seguridad del fabricante de dichas
sustancias y las normas regionales de eliminacion de residuos. Tenga en cuenta también en caso
necesario las indicaciones de seguridad especiales contenidas en la documentacién del producto. La
eliminacién incorrecta de sustancias peligrosas o combustibles puede causar dafios a la salud o
dafios al medio ambiente.
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GSM/EDGE Preface

Documentation Overview

1 Preface

1.1 Documentation Overview

The user documentation for the R&S Signal Generator consists of the following parts:

e Online Help system on the instrument,
e "Quick Start Guide" printed manual,

e Documentation CD-ROM with:
— Online help system (*.chm) as a standalone help,

— Operating Manuals for base unit and options,
— Service Manual,

— Data sheet and specifications,

— Links to useful sites on the R&S internet.

Online Help

The Online Help is embedded in the instrument's firmware. It offers quick, context-sen-
sitive access to the complete information needed for operation and programming. The
online help contains help on operating the R&S Signal Generator and all available
options.

Quick Start Guide

This manual is delivered with the instrument in printed form and in PDF format on the
Documentation CD-ROM. It provides the information needed to set up and start working
with the instrument. Basic operations and an example of setup are described. The manual
includes also general information, e.g., Safety Instructions.

Operating Manuals

The Operating Manuals are a supplement to the Quick Start Guide. Operating Manuals
are provided for the base unit and each additional (software) option.

These manuals are available in PDF format - in printable form - on the Documentation
CD-ROM delivered with the instrument. In the Operating Manual for the base unit, all
instrument functions are described in detail. Furthermore, it provides an introduction to
remote control and a complete description of the remote control commands with pro-
gramming examples. Information on maintenance, instrument interfaces and error mes-
sages is also given.

In the individual option manuals, the specific instrument functions of the option are
described in detail. For additional information on default settings and parameters, refer
to the data sheets. Basic information on operating the R&S Signal Generator is not inclu-
ded in the option manuals.

These manuals can also be orderd in printed form (see ordering information in the data
sheet).

|
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Preface

1.2

Typographical Conventions

Service Manual

This Service Manual is available in PDF format - in printable form - on the Documentation
CD-ROM delivered with the instrument. It describes how to check compliance with rated
specifications, on instrument function, repair, troubleshooting and fault elimination. It
contains all information required for repairing the instrument by the replacement of mod-
ules.

This manual can also be orderd in printed form (see ordering information in the data
sheet).
Release Notes

The release notes describe new and modified functions, eliminated problems, and last
minute changes to the documentation. The corresponding firmware version is indicated
on the title page of the release notes. The current release notes are provided in the
Internet.

Typographical Conventions

The following text markers are used throughout this documentation:

Convention Description

"Graphical user interface elements” All names of graphical user interface elements on the
screen, such as dialog boxes, menus, options, but-
tons, and softkeys are enclosed by quotation marks.

KEYS Key names are written in capital letters.

File names, commands, program code File names, commands, coding samples and screen
output are distinguished by their font.

Input Input to be entered by the user is displayed in italics.
Links Links that you can click are displayed in blue font.
"References" References to other parts of the documentation are

enclosed by quotation marks.

Operating Manual 1171.5254.12 — 10 6



GSM/EDGE Introduction

2 Introduction

The R&S Signal Generator equipped with option K40 enables you to generate signals in
accordance with the GSM/EDGE standard, based on the GMSK and 8PSK modulation.
Option K41 EDGE Evolution extends the GSM/EDGE signal generation with simulation
of higher order modulations (QPSK, 16QAM and 32QAM) for higher symbol rate bursts
and higher order modulations (16QAM and 32QAM) for normal symbol rate bursts.

GSM is a TDMA standard for cellular mobile radio networks and is used worldwide. The
R&S Signal Generator is suitable as a signal generator for all GSM variants. There is no
restriction regarding the use of GSM slots, EDGE slots and EDGE Evolution slots.

The R&S Signal Generator can generate both the transmitter signal of a base station (BS)
and the transmitter signal of user equipment (UE).

Every TDMA frame consists of 8 timeslots (or simply "slots"). Each slot can be separately
turned on or off. A maximum of 7 different level attenuation values can be defined and
allocated separately to the 8 slots quite independently of one another.

In order to configure a slot it is necessary to define a burst type. Different burst types are
available, depending on the installed options on the instrument.

For instruments equipped only with option K40, you can choose between data bursts
Normal (full rate and half rate) and EDGE; control bursts Access, Frequency Correction
and Synchronization; a Dummy Burst; and bursts for test purposes, All_Data (GSM and
EDGE). Not only can you generate half rate slots but you can also define multislots for
HSCSD (high speed circuit switched data) and (E)GPRS (general packet radio service)
configurations at the physical level, if necessary allocating multiple slots to a single con-
nection (channel banding).

The option K41 extends the available burst types with burst types defined for normal
symbol rate and higher order modulation schemes such as the data burst Normal
(16QAM and 32QAM) and All_Data (16QAM and 32QAM) as well as with the burst types
defined for higher symbol rates HSR (QPSK, 16QAM and 32QAM) and HSR All_Data
(QPSK, 16QAM and 32QAM).

Higher symbol rates are achieved by reduction of the symbol period and employing of
higher symbol rate bursts (HB) instead of the normal burst (NB). A normal burst contains
116 encrypted symbols and uses time slots with normal duration (156 or 157 symbols
long). The higher symbol rate bursts carry information on full rate packet traffic channels,
contain 138 encrypted symbols and use time slots with reduced symbol duration (187 or
188 symbols long).

The modulation data is continuously inserted into the chosen slots (in realtime). In this
fashion the data generator uses a digital signal processor to generate a data stream
complete with modulation data and control signals for power ramping.

This data stream is converted into 1/Q signals in the modulation encoder.

The signal is processed depending on the configured modulation scheme and selected
symbol rate mode:

e In accordance with the GSM standard, the MSK modulation type is set by default to
a symbol rate of 270.833ksymb/s and Gauss filtering. The symbol rate can be

Operating Manual 1171.5254.12 — 10 7



GSM/EDGE Introduction

changed in the R&S Signal Generator. FSK with adjustable span can also be used
as the modulation type.

e In accordance with the standard, in the case of EDGE slots the 8PSK modulation
type is set by default to 3/8( rotation at a symbol rate of 270.833ksymb/s and Gauss
linearized filtering.

e In accordance to EDGE Evolution specifications (option K41), the EDGE Evolution
slots in a normal burst (NB) are 16QAM or 32QAM modulated at a symbol rate of
270.833ksymb/s and Gauss linearized filtering. The EDGE Evolution slots in a higher
symbol rate bursts (HB) are QPSK, 16QAM or 32QAM modulated at a symbol rate
of 325ksymb/s and spectrally Narrow or Wide Pulse Shape filtering.

Three modes for each the normal and the higher symbol rate mode are available for
configuring a GSM/EDGE signal:

e Mode Unframed - a signal with standard-compliant modulation parameters but with-
out slot and frame structure is generated.

e Mode Frame (Single) - a signal consisting of a frame is generated; it is also possible
to choose half rate bursts and to define multislots.

e Mode Frame (Double) - a signal consisting of two frames is generated; the frames
are repeated according to a defined default.
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GSM/EDGE User Interface

GSM/EDGE Main Menu

3 GSM/EDGE User Interface

— TDMA Standards — «

GSMIEDGE...

3.1

To access the dialog for setting the digital standard, select "Baseband block > GSM/
EDGE" or use the menu tree under "Baseband".

GSM/EDGE Main Menu

The menu offered different differs according to the mode selected. Most of the submenus
and settings are available to all modes, however.

The upper part of the menu is used for turning on the GSM/EDGE digital standard and
choosing the mode.

The "Set to Default" button calls the default settings for the GSM/EDGE standard.

FEX

&2 GSM/EDGE A
State

SaveRecall... |

Set To Default |

Data List Management... |

The submenus for choosing the modulation, for setting the trigger and clock parameters
and for data list management are available to all modes.

For all modes except Unframed, the submenus for saving and loading a frame and for
setting the power ramping and slot attenuation are also available.

Sequence Mode | Framed (Single) j
Symbol Rate Mode I Higher Symbol Rate j
Modulation Filter... |
Power Ramp/Slot Attenuatiuns...l Cosine / 2.0 sym
TriggerMarker... | Auto
Fuming >
Clock... | Internal

The lower part of the menu displays the chosen frame configuration, except in Unframed
mode when it displays the signal configuration.

In this graphical display you can select the slot that you wish to edit. The burst editor then
opens.
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GSM/EDGE Main Menu

Frame: Select Slot To Configure

Horm Norm
8PSK & 320AM

0 1 2

SaveRecall Frame...

State

Switches the GSM/EDGE standard on/off.
Enabling this standard disables all the other digital standards and digital modulation

modes (in case of two-path instruments, this affects the same path).

GSM/EDGE is a realtime system (no precalculated signal), and therefore all parameter
changes (in the ON state) directly affect the output signal.

SCPI command:

[ :SOURce<hw>] :BB:GSM:STATe on page 63

Set to Default

Calls default settings. The values are shown in the following table.

Parameter Value

State Not affected by Set to Default
Mode Framed (single)

Modulation

Symbol Rate Mode

Normal Symbol Rate

Symbol Rate 270.833 ksymb/s
Ignore %a... Off
Force Dummy Bits to 1 Off

Mod. Type GSM

MSK 1bit/sym

Filter

Gauss

Filter Par. BT

0.3

Mod. Type Edge

8 PSK EDGE (3PI/8 8PSK)

Filter Gauss linear
Trigger

Mode Auto

Source Internal

Ext. Delay 0 symbols
Ext. Inhibit 0 symbols
Marker Mode Frame
Marker Period 0 frames
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GSM/EDGE User Interface

GSM/EDGE Main Menu

Parameter Value
Marker Delay 0 symbols
Clock

Source Internal
Mode Symbol
Delay 0 symbols

Power Ramp Control

Ramp Time 2 sym
Function Cosine
Delay 0 symbols
Rise Offset 0 symbols
Fall Offset 0 symbols
Slot Attenuation 1...7 0dB

Slot 0 Configuration

Burst Type Normal (full rate)
Slot Level Full

Multislot Off

Number of Slots 1

Data PRBS 9

Use Stealing Flag On

Stealing Flag 0

TSC TSCO

Slot 1-7 Configuration

Slot Level, Off

other settings as slot 0

Recall GSM Settings
Save GSM Settings

SCPI command:
[ :SOURce<hw>] :BB:GSM: PRESet on page 59

Save/Recall
Calls the "Save/Recall" menu.

From the "Save/Recall" menu, the "File Select" windows for saving and recalling GSM
configurations and the "File Manager" can be called.

"Recall GSM  Opens the "File Select" window for loading a saved GSM configuration.
setting" The configuration of the selected (highlighted) file is loaded by pressing
the "Select" button.

|
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|
GSM/EDGE Main Menu

"Save GSM set-Opens the "File Select" window for saving the current GSM signal con-
ting" figuration.
The name of the file is specified in the "File name" entry field, the directory
selected in the "save into" field. The file is saved by pressing the
"Save" button.

"File Manage" Calls the "File Manager".

The "File Manager" is used to copy, delete and rename files and to create
new directories.

SCPI command:

[ :SOURce<hw>] :BB:GSM: SETTing:CATalog on page 60
[ :SOURce<hw>] :BB:GSM: SETTing:LOAD on page 61

[ :SOURce<hw>] :BB:GSM:SETTing: STORe On page 61

[ :SOURce<hw>] :BB:GSM: SETTing:DELete on page 60

Data List Management
Calls the "Data List Management" menu. This menu is used to select and edit a data list.

& | Data List Management

I Data List._. | Nunel

Edit Data List... None

All data lists are stored as files with the predefined file extension * .dm iqgd. The file
name and the directory they are stored in are user-definable.

The data lists must be selected as a data source in the Burst Editor.

Note: All data lists are generated and edited by means of the SOURce : BB : DM subsystem
commands. Files containing data lists end with *.dm_iqgd. The data lists are selected
as a data source for a specific function in the individual subsystems of the digital standard.

Example: Creating and editing the data list
SOUR:BB:DM:DLIS:SEL "gsm"

SOUR:BB:DM:DLIS:DATA 1,1,0,1,0,1,0,1,1,1,1,0,0,0
SOUR:BB:DM:DLIS:DATA:APP 1,1,0,1,0,1,0,1,1,1,1,0,0,0

SCPI command:

[ : SOURce<hw>] :BB:GSM[ : FRAMe<di>] : SLOT<st0>[ : USER<ch>] [ : SOURce] :
DATA on page 95

[ : SOURce<hw>] :BB:GSM[ : FRAMe<di>] : SLOT<st0>[ :USER<ch>] [ : SOURce] :
DATA:DLISt on page 96

Generate Waveform File...
Calls the "Generate Waveform" menu. This menu is used to store the current GSM/EDGE
signal as ARB signal in a waveform file.

This file can be loaded in the "ARB" menu and processed as multicarrier or multisegment
signal.

|
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GSM/EDGE Main Menu

The file name is entered in the submenu. The file is stored with the predefined file exten-
sion * .wv. The file name and the directory it is stored in are user-definable.

SCPI command:
[ :SOURce<hw>] :BB:GSM:WAVeform: CREate on page 63

Sequence Mode
Selects GSM/EDGE mode.

There are three modes available:
e Unframed
see chapter 3.2, "Mode Unframed", on page 14
e Framed (single)
see chapter 3.3, "Mode Framed (single)", on page 16
e Framed (double)
see chapter 3.4, "Mode Framed (double)", on page 17

SCPI command:
[ :SOURce<hw>] :BB:GSM:MODE on page 59

Symbol Rate Mode
(for instruments equipped with option K41 only)

Set the symbol rate mode, i.e. determines whether a normal bursts (NB) or higher symbol
rate bursts (HB) will be generated.

SCPI command:
[ : SOURce<hw>] :BB:GSM: SRATe : MODE on page 62

Sequence Length

(For R&S WinlQSIM2 only)

Selects the sequence length of the arbitrary waveform file in the number of frames or
symbols.

For unframed "GSM Mode", the sequence length is set in number of symbols and in
number of frames for framed GSM mode respectively.

In case the "GSM Mode" is set to double framed, the sequence length of the generated
ARB file is determined by the parameter "Frame Repetition" for both frames:

Sequence Length = Frame Repetition of Frame 1 + Frame Repetition of Frame 2.
SCPI command:

[ :SOURce<hw>] :BB:GSM: SLENgth on page 57
[ :SOURce<hw>] :BB:GSM: FLENgth on page 56

Modulation/Filter
Calls the "Modulation/Filter" menu. The Modulation menu is used for setting the modu-
lation and filter parameters, see chapter 3.6, "Modulation/Filter", on page 21.

SCPI command:
n.a.

|
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GSM/EDGE User Interface

3.2

Mode Unframed

Power Ramping/Slot Attenuations

Calls the "Power Ramping/Slot Attenuation" menu. This menu is used to set the power
ramping parameters and for setting values for the level attenuation in dB, see chapter 3.7,
"Power Ramping/Slot Attenuation”, on page 27.

The currently selected ramp function and ramp time are displayed.

SCPI command:
n.a.

Trigger/Marker
Calls the "Trigger/Marker/Clock" menu.

This menu is used to select the trigger source, configure the marker output signals and
set the time delay on an external trigger signal, see chapter 3.8, "Trigger/Marker/Clock
Settings", on page 30.

SCPI command:
n.a.

Execute Trigger
Executes trigger manually. A manual trigger can be executed only when an internal trig-
ger source and a trigger mode other than Auto have been selected.

SCPI command:
[ : SOURce<hw>] :BB:GSM: TRIGger :EXECute on page 79

Clock
Calls the "Trigger/Marker/Clock" menu. This menu is used to select the clock source, see
chapter 3.8.4, "Clock Settings", on page 38.

SCPI command:
n.a.

Mode Unframed

In "Unframed" mode a modulation signal without slot or frame structure is generated. The
modulated carrier without power ramping is often enough for initial tests, and in case the
complete signal is not yet needed.

Since all the modulation parameters for the signal are conform to the standard, only the
symbol rate mode (normal or higher symbol rate) and the modulation (MSK or FSK for
GSM, 8PSK EDGE for EDGE and 16QAM EDGE or 32QAM EDGE for EDGE Evolution)
have to be selected. The symbol rate and filter configuration are set accordingly.

This mode can be used for quick measurements of the spectrum or signal quality (e.g.
EVM).

The submenus for selecting the modulation (see chapter 3.6, "Modulation/Filter",
on page 21), as well as the trigger, marker and clock (see chapter 3.8, "Trigger/Marker/
Clock Settings", on page 30) are offered.

|
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GSM/EDGE User Interface

Mode Unframed

= GSM/EDGE A Al=.3
Set To Default | saveRecall... |
Data List Management... |

Sequence Mode I Unframed j
Symbol Rate Mode INnrmaI Symbol Rate j
[simulation Mode | EDGE ~|

Modulation/Filter... | 8PSKEDGE /| Gauss linear

TriggerMarker... | Auto
Fumwing >

Clock... | Internal

Signal Configuration
Data PRBS 9 |

Simulation Mode
Selects the modulation for the signal.

The signal is generated without slot or frame structure.

The available simulation modes depend on the selected symbol rate:

e Normal Symbol Rate - GSM, EDGE (8PSK), 16QAM and 32QAM

e Higher Symbol Rate - HSR QPSK, HSR 16QAM and HSR32QAM.

For GSM, the modulation to be used (MSK or FSK) is set by means of the parameter
"Modulation" in the "Modulation/Filter" menu.

Note: "Higher Symbol Rate" Mode and "Simulation Modes" 16QAM, 32QAM, HSR
QPSK, HSR 16QAM and HSR 32QAM are available for instruments equipped with option
K41 only.

The graphical display shows the signal in Unframed mode - no frames, no power ramping.
Slot Configuration

SCPI command:
[ :SOURce<hw>] :BB:GSM: SMODe on page 61

Data
Selects data source.
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GSM/EDGE User Interface

3.3

Mode Framed (single)

You may choose from the following data sources:
"All O, All 1" 0 data or 1 data is internally generated.

"Pattern" A user-definable bit pattern with a maximum length of 32 bits is internally
generated.
The bit pattern is defined in the "Pattern” input box.

"PRBS xx" PRBS data in accordance with the IUT-T with period lengths between
29-1 and 223-1 are internally generated.

"Data List" Internal data from a programmable data list created with the aid of the
data editor is used.
Data lists are selected from the Select List submenu.

SCPI command:

[ :SOURce<hw>] :BB:GSM|[ : FRAMe<di>] : SLOT<st0>[ :USER<ch>] [ : SOURce] :
DATA on page 95

[ : SOURce<hw>] :BB:GSM[ : FRAMe<di>] : SLOT<st0>[ : USER<ch>] [ : SOURce] :
DATA:PATTern on page 97

[ : SOURce<hw>] :BB:GSM[ : FRAMe<di>] : SLOT<st0>[ :USER<ch>] [ : SOURce] :
DATA:DLISt on page 96

Mode Framed (single)

The "Framed (single)" mode generates a modulation signal which is defined by the struc-
ture of a single frame. The frame structure is repeated cyclically, but the useful data is
continuously generated.

The frame structure is displayed in graphical form. Slot parameters can be defined in the
burst editor, which is called when the slot is selected in the graphical display (see chap-
ter 3.9, "Burst Editor", on page 40). You can define half rate slots. The characteristics
of each half rate slot can be defined separately. Each active slot is represented by a burst
symbol. Two half rate slots occupy the space of a full rate slot. A slot in which the level
has been attenuated is represented by a lower amplitude burst. Inactive slots (Slot Level
= Off) are shown as a horizontal bar. If multislots have been defined, the banded slots
are surrounded by a frame (slots 5 to 7 in the illustration).

SO—00E

0 1 2 3 4 5

When a half rate slot has been selected, two frames are generated alternately. Each
frame holds one of the two half rate users:

|
Operating Manual 1171.5254.12 — 10 16



GSM/EDGE GSM/EDGE User Interface
Mode Framed (double)
Example:
The following configuration is set, from a frame with two slots that contain half rate users:
0 1 2 3 4 Li] i ¥
As a result, the following two frames are generated alternately:
e Frame with half rate user 1:
0 1 2 3 4 5 i ¥
e Frame with half rate user 2
] 1 2 3 4 H 6 ¥
The following submenus are offered:
e For saving and loading a frame structure (see chapter 3.5, "Save Recall Frame/
Slots", on page 19).
e For selecting the modulation (see chapter 3.6, "Modulation/Filter", on page 21).
e For selecting the trigger, marker and clock (see chapter 3.8, "Trigger/Marker/Clock
Settings"”, on page 30).
e For power ramping and defining the attenuation (see chapter 3.7, "Power Ramping/
Slot Attenuation”, on page 27).
Save/Recall Frame ...
Call the Save/Recall Frame menu for selecting of predefined or user defined frames.
The menu is described in chapter 3.5, "Save Recall Frame/Slots", on page 19.
SCPI command:
n.a.
3.4 Mode Framed (double)

The "Framed (double) "mode generates multiframe signals which are defined by the
structure of two frames.
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Mode Framed (double)

For this purpose two frames are defined as in "Framed (single)" mode. A repetition factor
is then specified for each of the two frames. Following a trigger the first frame is repeated
the specified number of times, and then the second frame. The frame structures are
repeated cyclically, but the useful data is continuously generated.

If one of the frames contains half rate slots (and so actually consists of 2 frames itself),
the repetition factor must be a multiple of 2 (see chapter 3.3, "Mode Framed (single)",
on page 16).

The frame structure of the two frames is displayed in graphical form. Slot parameters can
be defined in the burst editor, which is called when the slot is selected in the graphical
display (see chapter 3.9, "Burst Editor", on page 40).

Frame1: Select Slot To Configure

0 1 2 3 4 5 L3 7

SaveRecall Frame... Frame Repetition I 1

Frame2: Select Slot To Configure

0 1 2 3 4 5 L3 7

Sawve/Recall Frame... Frame Repetition I 1

The following submenus are offered:

e For saving and loading a frame structure (see chapter 3.5, "Save Recall Frame/
Slots", on page 19).

e For selecting the modulation (see chapter 3.6, "Modulation/Filter", on page 21).

e For selecting the trigger, marker and clock (see chapter 3.8, "Trigger/Marker/Clock
Settings”, on page 30).

e For power ramping and defining the attenuation (see chapter 3.7, "Power Ramping/
Slot Attenuation”, on page 27).

Save/Recall Frame ...
Call the Save/Recall Frame menu for selecting of predefined or user defined frames.

The menu is described in chapter 3.5, "Save Recall Frame/Slots", on page 19.

SCPI command:
n.a.

|
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GSM/EDGE User Interface

3.5

Save Recall Frame/Slots

Frame Repetition
Enters the number of repetitions for frame 1 or frame 2. First frame 1 is repeated the
specified number of times, and then frame 2, then frame 1 starts again, and so on.

SCPI command:
[ : SOURce<hw>] :BB:GSM: FRAMe<di>:REPetitions on page 58

Save Recall Frame/Slots

The "Save/Recall Frame" menu is accessed via the "GSM/EDGE" main menu.
The "Save/Recall Slots" menu is accessed via the "Burst Editor" sub menu.

When you call the submenu using the corresponding button a box opens from which you
can select the function you require:

Recall Predefined Frame Recall Predefined Slot |
Recall User Frame Recall User Slot

Save User Frame Save User Slot

File Manager... File Manager...

The "File Select" menus save and load (i.e. recall) user-defined frames or slots. Prede-
fined frames or slots can also be recalled. Each menu offer access to the "File Man-
ager" for general file management.

Predefined Frames and Slots are stored on a predefined path. This path is automatically
set in the "File Select” window.

In the Normal Symbol Rate mode, user-defined Frames and Slots are stored as files with
the specific file extensions *.gsm_fu or * .gsm_slu, respectively.

In the Higher Symbol Rate mode, user-defined Frames and Slots are stored as files with
the specific file extensions *.gsm _hfu or *.gsm_hslu, respectively. Independent of
the selected symbol rate mode, the files with user-defined Frames and Slots can be
stored in a user-determined directory and called from there.

It is not possible to use other file extensions. Attempting to do so will cause an error
message. If the file extension is modified (e.g. by directly accessing the file system) the
files are no longer recognized and therefore invalid.

\\ In the following examples of commands the files are stored in the default directory which

J is defined by command MMEM: CDIRectory.

Recall Predefined Frame/Slot
Calls the File Select menu for loading a predefined frame/slot.

|
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Save Recall Frame/Slots

& Recall Predefined Frame |Z||E|rg|

3 recent data sets
Edgel

Edgedll

GsmEdge
HNormalBurst
NormalBurstAll

Select | File
Manager...

"EDGEOQ" Predefined frame
slot 0 = On, full level, EDGE burst, all other slots off.
"EDGEAII" Predefined frame

all slots On, full level, EDGE burst

"GsmEdge" Predefined frame
alternately one slot with NORMAL burst and EDGE burst

"NormalBurst0" Predefined frame
slot 0 = On, full level, NORMAL burst (full rate), all other slots off

"NormalBur-  Predefined frame

stAll" all slots On, full level, NORMAL burst (full rate)
"GSM_NB_PN9Predefined slot
_Tsco" NORMAL burst (full rate), full level, attenuation A1, multislot = Off, num-

ber of multislots = 1, Data = PRBS 9, Use Stealing Flag = On, TSCQO, all
slot-marker set to "all down".

"GSM_NB_PN9Predefined slot

_Tsco" EDGE burst (full rate), full level, attenuation A1, multislot = Off, number
of multislots = 1, Data = PRBS 9, Use Stealing Flag = On, TSCQO, all slot-
marker set to "all down"

SCPI command:

[ :SOURce<hw>] :BB:GSM[ : FRAMe<di>] : PREDefined:CATalog on page 65
[ :SOURce<hw>] :BB:GSM[ : FRAMe<di>] : PREDefined:LOAD On page 65

[ : SOURce<hw>] :BB:GSM[ : FRAMe<di>] : SLOT<st0>[ :USER<ch>] :
PREDefined:CATalog on page 66

[ :SOURce<hw>] :BB:GSM|[ : FRAMe<di>] : SLOT<st0>[ :USER<ch>] :
PREDefined:LOAD on page 66

Recall User Frame/Slot
Calls the "File Select" menu for loading a user-defined frame/slot.

SCPI command:

[ : SOURce<hw>] :BB:GSM: FRAMe<di>:ULISt :CATalog on page 64

[ :SOURce<hw>] :BB:GSM: FRAMe<di>:ULISt : LOAD On page 64

[ :SOURce<hw>] :BB:GSM[ : FRAMe<di>] : SLOT<st0>[:USER<ch>] :ULISt:
CATalog on page 66

[ : SOURce<hw>] :BB:GSM[ : FRAMe<di>] : SLOT<st0>[ : USER<ch>] : ULISt : LOAD
on page 67
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GSM/EDGE User Interface

3.6

Modulation/Filter

Save User Frame/Slot

Calls the File Select menu for saving the current frame or slot settings.

SCPI command:

[ :SOURce<hw>] :BB:GSM: FRAMe<di>:ULISt : STORe on page 65

[ :SOURce<hw>] :BB:GSM[ : FRAMe<di>] : SLOT<st0>[ :USER<ch>] :ULISt:
STORe on page 68

File Manager
Calls the "File Manager".

The "File Manager" is used to copy, delete and rename files and to create new directories.

SCPI command:

[ :SOURce<hw>] :BB:GSM: FRAMe<di>:ULISt:DELete on page 64

[ :SOURce<hw>] :BB:GSM[ : FRAMe<di>] : SLOT<stO0>[ :USER<ch>] :ULISt:
DELete on page 67

Modulation/Filter

The "Modulation/Filter" menu is accessed via the "GSM/EDGE" main menu.

The parameters displayed depend on the selected "Symbol Rate Mode". The parameters
are grouped in different sections, according to the modulation (GSM, EDGE, QPSK,
16QAM or 32QAM) they apply to.

"Higher Symbol Rate" Mode and higher order modulations (16QAM and 32QAM) are
available for instruments equipped with option K41 only.

|
Operating Manual 1171.5254.12 — 10 21



GSM/EDGE GSM/EDGE User Interface

Modulation/Filter

&= GSM/EDGE A: Modulation/Filter (2 )(57|[5) I & GSM/EDGE A: Modulation/Filter =ES

ISymhoI Rate I 270.833 333 I ksymis vll ISy‘mhnI Rate I 325.000 000 Iksym!s vil
Ignore 1/4 sym (slot length 156 sym) I Ignore 1/2 sym (slot length 187 sym) r
Force Dummy Bits to 1 I~ Force Dummy Bits to 1 I

GSM HSR QPSK
Modulation MSK 1bit'sym =] Modulation L FEDIENEE
. . Narrow Pulse Shape,
G ]
Filter auss AL Wide Pulse Shape
Filter Parameter 0.30 HSR 160AM
EDGE Modulation 160AM EDGE
Modulation 8 PSK EDGE (3P1/8 8PSK) ..
. . Narrow Pulse Shape
Filter !
Filter Gauss linear B e an
HSR 320AM
160AN Modulati ’ 32QAM EDGE
Modulation 16QAM EDGE oduiation ..
. i Filt Narrow Pulse Shape,
Filter Gauss linear =ty Wide Pulse Shape
320AM
Modulation 32GAM EDGE
Filter Gauss linear
3.6.1 General Settings
Symbol Rate
Sets the symbol rate. The symbol rate is determined by the selected "Symbol Rate
Mode".

For normal symbol rate mode, the default value for GSM/EDGE is 270.833 33 ksymb/s.
For higher symbol rate mode, the default value for EDGE Evolution is 325 ksymb/s.

SCPI command:
[ : SOURce<hw>] :BB:GSM: SRATe on page 62

Ignore 1/4 symbol (slot length 156 sym) / Ignore 1/2 symbol (slot length 187 sym)
Selects constant slot length. This setting affects all burst types.
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3.6.2

Modulation/Filter

In a normal burst (NB), the GSM slot has a length of 156.25 symbols. Compensation for
the 1/4 symbol takes the form of an extra symbol every 4th slot. This means that some

slots are 156 long and some are 157 long. Compensation takes place in the guard field
of the burst (see chapter 3.9, "Burst Editor", on page 40).

In a higher symbol rate burst (HB), the average slot is 187.5 symbols long. Compensation
for %2 symbol means that each second slot gets an extra symbol and is 188 symbols long,
while the rest uses a slot length of 187 symbols.

If the field "Ignore 1/4 symbol (slot length 156 symbols) / Ignore 1/2 symbol (slot length
187 symbols)" is enabled, all slots are 156 respectively 187 symbols long. The extra V4
resp. ¥2 symbol is omitted. The guard field for the burst always has the same length
regardless of the slot index.

For normal burst, a frame is therefore 1248 symbols long instead of 1250.

Respectively, the length of the frame in a higher symbol rate burst is then 1496 symbols
long instead of 1500 symbols.

SCPI command:
[ :SOURce<hw>] :BB:GSM: ISLength on page 58

Force Dummy Bits to 1
A modulating bit stream consisting of consecutive ones is used for inactive slots (accord-
ing to GSM 05.04). If this parameter is disabled, the inactive slots are filled in with 0.

SCPI command:
[ :SOURce<hw>] :BB:GSM: FONE on page 57

Oversampling
(For R&S WinlQSIM2 only)

Determines the upsampling factor. If the check box is activated, the most sensible param-
eter values are selected. The value depends on the coherence check. If the check box
is deactivated, the values can be changed manually.

SCPI command:
[ :SOURce<hw>] :BB:GSM:FILTer:0SAMpling:AUTO on page 72
[ :SOURce<hw>] :BB:GSM: FILTer :0OSAMpling on page 72

GSM

The settings for GSM modulation are brought together in the GSM section.

Modulation Type GSM
Selects modulation type for GSM signal.

"MSK 1bit/symbol" = Minimum Shift Keying
"FSK 1bit/symbol" = Frequency Shift Keying

The selected modulation is also displayed in graphical form:

|
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Modulation/Filter

Fig. 3-1: GSM with MSK or FSK

SCPI command:
[ :SOURce<hw>] :BB:GSM: FORMat on page 68

FSK Deviation
Sets the deviation when selecting FSK.

When MSK is selected, the deviation is set permanently to symbol_rate/4.

SCPI command:
[ :SOURce<hw>] :BB:GSM:FSK:DEViation on page 69

Filter
Displays filter for GSM signal. The filter is permanently set to GAUSS.

SCPI command:
[ :SOURce<hw>] :BB:GSM:FILTer: TYPE on page 71

Filter Parameter
Sets the BxT value for the GAUSS filter. The GSM default value is 0.3.

SCPI command:
[ :SOURce<hw>] :BB:GSM:FILTer: PARameter on page 72

3.6.3 EDGE
The settings for EDGE modulation are brought together in the EDGE section.

Modulation Type EDGE

Displays modulation type for EDGE signal. The modulation type is set permanently to
8PSK EDGE (3pi/8 8PSK). Unlike the modulation types for GSM the modulation type for
EDGE has 3 bits per symbol.

The selected modulation is also displayed in graphical form:

Fig. 3-2: EDGE with 8PSK

SCPI command:
[ :SOURce<hw>] :BB:GSM:EDGE : FORMat on page 68

Filter
Displays filter for EDGE signal. The filter is permanently set to GAUSS linearized.

SCPI command:
[ :SOURce<hw>] :BB:GSM: FILTer : EDGE: TYPE on page 73
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Modulation/Filter

3.6.4 16QAM

(for instruments equipped with option K41 only)

The settings for 16QAM modulation are brought together in the 16QAM section.

Modulation Type 16QAM
Displays modulation type for signal.

The modulation type 16QAM has 4 bits per symbol.
The selected modulation is also displayed in graphical form:

Fig. 3-3: 16QAM EDGE

SCPI command:
[ :SOURce<hw>] :BB:GSM:N16Qam: FORMat on page 70

Filter
Displays filter for 16QAM signal. The filter is permanently set to GAUSS linearized.

SCPI command:
[ : SOURce<hw>] :BB:GSM: FILTer:N16Qam: TYPE on page 73

3.6.5 32QAM

(for instruments equipped with option K41 only)

The settings for 32QAM modulation are brought together in the 32QAM section.

Modulation Type 32QAM
Displays modulation type for signal.

The modulation type 32QAM has 5 bits per symbol.

The chosen modulation is also displayed in graphical form:

Fig. 3-4: 32QAM EDGE

SCPI command:
[ : SOURce<hw>] :BB:GSM:N32Qam: FORMat on page 71

Filter
Displays filter for 32QAM signal. The filter is permanently set to GAUSS linearized.

SCPI command:
[ : SOURce<hw>] :BB:GSM: FILTer:N16Qam: TYPE on page 73
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3.6.6

3.6.7

GSM/EDGE User Interface

Modulation/Filter

HSR QPSK
The settings for QPSK modulation are brought together in the HSR QPSK section.

Modulation Type HSR QPSK
(for Higher Symbol Rate only)

Displays modulation type for signal.
The modulation type QPSK EDGE has 2 bits per symbol.
The selected modulation is also displayed in graphical form:

Fig. 3-5: QPSK EDGE

SCPI command:
[ :SOURce<hw>] :BB:GSM:HQPSk: FORMat on page 70

Filter
(for Higher Symbol Rate only)

Displays the filters for HSR QPSK EDGE signal.

The two possible filters are displayed. The currently used filter is set per HSR QPSK slot
with the parameter "Filter".

SCPI command:

[ :SOURce<hw>] :BB:GSM[ : FRAMe<di>] : SLOT<stO0>[ :USER<ch>] :FILTer:
TYPE on page 94

[:SOURce<hw>] :BB:GSM:FILTer:HQPSk:TYPE on page 74

HSR 16QAM

The settings for 16QAM modulation are brought together in the HSR 16QAM section.

Modulation Type HSR 16QAM
(for Higher Symbol Rate only)

Displays modulation type for signal.
The modulation type 16QAM has 4 bits per symbol.
The selected modulation is also displayed in graphical form:

Fig. 3-6: 16QAM EDGE

SCPI command:
[ :SOURce<hw>] :BB:GSM:HI16Qam: FORMat on page 69
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I EEEEEEEEE———
Power Ramping/Slot Attenuation

Filter
(for Higher Symbol Rate only)

Displays filter for HSR 16QAM signal.

The two possible filters are displayed. The currently used filter is set per HSR 16QAM
slot with the parameter Filter.

SCPI command:

[ :SOURce<hw>] :BB:GSM[ : FRAMe<di>] : SLOT<stO0>[:USER<ch>] :FILTer:
TYPE on page 94

[ :SOURce<hw>] :BB:GSM:FILTer:H320am: TYPE on page 74

3.6.8 HSR 32QAM
The settings for 32QAM modulation are brought together in the HSR 32QAM section.

Modulation Type HSR 32QAM
(for Higher Symbol Rate only)

Displays modulation type for signal.
The modulation type 32QAM has 5 bits per symbol.
The selected modulation is also displayed in graphical form:

Fig. 3-7: 32QAM EDGE

SCPI command:
[ :SOURce<hw>] :BB:GSM:H32Qam: FORMat on page 70

Filter
(for Higher Symbol Rate only)

Displays filter for 32QAM signal.

The two possible filters are displayed. The currently used filter is set per HSR 32QAM
slot with the parameter Filter.

SCPI command:

[ :SOURce<hw>] :BB:GSM|[ : FRAMe<di>] : SLOT<st0>[:USER<ch>] :FILTer:
TYPE on page 94

[ :SOURce<hw>] :BB:GSM:FILTer:H320am:TYPE On page 74

3.7 Power Ramping/Slot Attenuation

The "Power Ramping/Slot Attenuation" menu is accessed via the "GSM/EDGE" main
menu.

This menu is used to enter the settings for power ramping and level attenuation.
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Power Ramping/Slot Attenuation

The "Power Ramp Control" section is used for setting the power ramp envelope.

& GSM/EDGE A: PRAMP / Slot Atten [ ][T1/X]

Power Ramp Control

Ramp Function m
Ramp Time WISYTLI
Rise Delay wm
Fall Delay [ 0.00[sym ~|

The "Slot Attenuations (Used in Burst Editors)" section is used to define seven possible
values for level attenuation. These values can be selected from the burst editor for the
slot currently being edited. An eighth value is permanently set to 0 dB and corresponds
to the "Slot Level Full" setting in the burst editor.

—Slot Attenuations (Used In Burst Editors) —

[0l =]
(ool <]
[oofw <]
[0l -]
[oofw <]
[0l <]

The "Power Ramping/ Level Attenuation” section is used for restricting power ramping to
the baseband signal.

Power Ramping / Level Attenuation
In Baseband Only [~ On

E & 22 B

z

Ramp Time
Enters the power ramping rise time and fall time for a burst. The setting is expressed in
symbols.

The transmitted power must not be switched abruptly at the start and end of a burst,
because the switching operation would otherwise generate excessively strong non-har-
monics; the switching operation is therefore stretched over several symbol clocks.

SCPI command:
[ :SOURce<hw>] :BB:GSM: PRAMp: TIME on page 91

Ramp Function
Enters the form of the transmitted power during the switching operation, i.e. the shape of
the rising and falling edges of the envelope.

"Linear" The transmitted power rises and falls linear fashion.

|
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|

Power Ramping/Slot Attenuation

"Cosine" The transmitted power rises and falls with a cosine-shaped edge. This
gives rise to a more favorable spectrum than the Linear setting.

SCPI command:
[ :SOURce<hw>] :BB:GSM: PRAMp: SHAPe on page 91

Rise Delay - Power Ramp Control

Sets the offset in the rising edge of the envelope at the start of a burst. A positive value
gives rise to a delay and a negative value causes an advance. The setting is expressed
in symbols.

SCPI command:
[ : SOURce<hw>] :BB:GSM: PRAMp : RDELay on page 91

Fall Delay - Power Ramp Control

Sets the offset in the falling edge of the envelope at the end of a burst. A positive value
gives rise to a delay and a negative value causes an advance. The setting is expressed
in symbols.

SCPI command:
[ :SOURce<hw>] :BB:GSM: PRAMp: FDELay on page 90

Slot Attenuation A1 to A7
Enters seven different values for level attenuation.

The burst editor can be used to set the level attenuation for the 8 slots to one of these
predefined values independently of one another.

The ability to set a sequence of slots purposely to different levels (loud - soft - loud) in
order to measure transmission stability is a requirement of measurement recommenda-
tion 11.21 in the latest GSM version 8.6.09.

The burst editor is likewise used to assign the "Slot Level" attribute "Attenuated" to indi-
vidual slots.

SCPI command:
[ :SOURce<hw>] :BB:GSM: SATTenuation<ch> on page 59

Baseband Only - Power Ramp Control
(Instruments with RF output only)

Restricts power ramping to the baseband signal.

"Off" Level attenuation is effected via the attenuator stages in the RF section;
only the remaining part is attenuated in the baseband. The signal is
issued at the RF output with the defined level values. This setting pro-
vides the best possible dynamic for bursted signals.

|
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"On" Level attenuation is effected in the baseband only.
This setting is mandatory in the following cases:

e When only the baseband signal is issued at the 1/Q outputs. It is thus
ensured that, with power ramping active, this signal is output with the
defined level values.

e When a baseband signal is applied to two RF paths of an two-path
instrument. The RF paths having separate frequency and level set-
tings, the remaining attenuation to be effected in the baseband would
have to be different for the two paths and is therefore not possible.

e When a bursted baseband signal (GSM/EDGE) is combined with a
continuous baseband signal (e.g. 3GPP) or a noise signal and both
signals are applied to one RF path of an two-path instrument. Blank-
ing in the RF paths is not suitable, because the RF section would not
only blank the bursted signal of the first baseband but also the con-
tinuous signal of the second baseband or the noise signal.

SCPI command:
[ :SOURce<hw>] :BB:GSM: PRAMp:BBON1ly [ :STATe] on page 90

Trigger/Marker/Clock Settings

N\ The trigger, clock, and marker delay functions are available for R&S SMx and R&S AMU

/ instruments only.

Additional marker settings are entered at the slot level (see chapter 3.9, "Burst Editor",
on page 40). For instance, at that level a data mask signal can be assigned to a marker
connector. Such settings take effect when the marker signal "As defined in Slots" is
selected.

Synchronizing the R&S Signal Generator to an external GSM frame sync signal
When synchronizing the R&S Signal Generator to an external GSM frame sync signal,
the following settings are recommended:

e Trigger Mode = Armed_Auto

e Trigger Source = External Clock

e Clock Source = External

e Clock Mode = Fractional Symbol

e Symbol Clock Divider = 1250

The external GSM frame sync signal must be provided only at the clock input.

Trigger/Marker/Clock Dialog

To access this dialog, select "Main Menu > Trigger/Marker".
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The "Trigger In" section is where the trigger for the signal is set. Various parameters will
be provided for the settings, depending on which trigger source - internal or external - is
selected. The current status of signal generation ("Running" or "Stopped") is indicated
for all trigger modes.

Trigger In
Mode [Retrigger |
Execute Trigger |
Source IInternaI j

The "Marker Mode" section is where the marker signals at the MARKER output connec-
tors are configured.

Marker Mode
Marker 1 |Frame | Period | 1 |Frame(s) x|
IMarkEr 2 |As Defined In Slots jl
Marker 3 | Pulse j Divider | 2
Frequency Im kHz
Marker 4 | OnjOff Ratio = onTime | 1 [sym =
off Time | 1 [sym |

The "Marker Delay" section is where a marker signal delay can be defined, either without
restriction or restricted to the dynamic section, i.e., the section in which it is possible to
make settings without restarting signal and marker generation.

Marker Delay
Current Range Without Recalculation
——
Marker 1 I U'UUUI Samples j (R B A A R A B
0 2000 Samples
——
Marker 2 I U.UUUI Samples j T B o I A A I A R A
0 2000 Samples
——
“arkers I 0IUUUI Sﬁmpleﬁ j | L T L O I I I | LI T T O O Y A |
] 2000 Samples
——
“arker4 I 0IUUUI Sﬁl‘l"lples j | L T L O I I I | LI T T O O Y A |
0 2000 Samples
Fix Marker Delay To Current Range [

The "Clock Settings" section is where the clock source is selected and - in the case of an
external source - the clock type.

Clock Settings:
Clock Source Ilnternal vl
The buttons in the last section lead to submenu for general trigger, clock and mapping
settings.
Global Trigger/Clock Settings... |
User Marker | AUX Ii0 Settings...
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3.8.1 Trigger In

\ The trigger functions are available for R&S SMx and R&S AMU instruments only.

The "Trigger In" section is where the trigger for the signal is set. Various parameters will
be provided for the settings, depending on which trigger source - internal or external - is
selected. The current status of signal generation ("Running" or "Stopped") is indicated
for all trigger modes.

Trigger Mode
Selects trigger mode.

The trigger mode determines the effect of a trigger on the signal generation.
"Auto" The signal is generated continuously.

"Retrigger" The signal is generated continuously. A trigger event (internal or exter-
nal) causes a restart.

"Armed_Auto" The signal is generated only when a trigger event occurs. Then the signal
is generated continuously.
Button "Arm" stops signal generation. A subsequent trigger event (inter-
nal with "Execute Trigger" or external) causes a restart.
"Armed_Retrig- The signal is generated only when a trigger event occurs. Then the signal

ger is generated continuously. Every subsequent trigger event causes a
restart.
Button "Arm" stops signal generation. A subsequent trigger event (inter-
nal with "Execute Trigger" or external) causes a restart.

"Single" The signal is generated only when a trigger event occurs. Then the signal

is generated once to the length specified at "Signal Duration".
Every subsequent trigger event (internal with "Execute Trigger" or exter-
nal) causes a restart.

SCPI command:
[ :SOURce<hw>] :BB:GSM[: TRIGger] : SEQuence on page 78

Signal Duration Unit
Defines the unit for the entry of the length of the signal sequence to be outputin the Single
trigger mode. Available units are symbols or frames.

SCPI command:
[ :SOURce<hw>] :BB:GSM: TRIGger : SLUNit on page 82

Signal Duration
Defines the length of the signal sequence to be output in the "Single" trigger mode.

Itis possible to output deliberately just part of the signal, an exact sequence of the signal,
or a defined number of repetitions of the signal.

SCPI command:
[ :SOURce<hw>] :BB:GSM: TRIGger : SLENgth on page 81
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Running - Stopped
Displays the status of signal generation for all trigger modes. This display appears only
when signal generation is enabled ("State" On).

"Running"” The modulation signal is generated; a trigger was (internally or exter-
nally) initiated in triggered mode.
If "Armed_Auto" and "Armed_Retrigger" have been selected, generation
of signals can be stopped with the "Arm" button. A new trigger (internally
with "Execute Trigger" or externally) causes a restart.

"Stopped"” The signal is not generated, and the instrument waits for a trigger event
(internal or external).

SCPI command:
[ : SOURce<hw>] :BB:GSM: TRIGger : RMODe on page 81

Arm
Stops signal generation for trigger modes "Armed Auto" and "Armed Retrigger". A sub-
sequent internal or external trigger event restart signal generation.

SCPI command:
[ :SOURce<hw>] :BB:GSM:TRIGger : ARM: EXECute on page 78

Execute Trigger
Executes trigger manually. A manual trigger can be executed only when an internal trig-
ger source and a trigger mode other than "Auto" have been selected.

SCPI command:
[ :SOURce<hw>] :BB:GSM: TRIGger : EXECute on page 79

Trigger Source
Selects trigger source. This setting is effective only when a trigger mode other than
"Auto" has been selected.

"Internal” The trigger event is executed by "Execute Trigger".

"Internal (Base- (two-path instruments only)
band A/B)" The trigger event is executed by the trigger signal from the second path

"External The trigger event is executed with the aid of the active edge of an external
(TRIGGER 1/ trigger signal.
2)" The trigger signal is supplied via the TRIGGER connector.

The polarity, the trigger threshold and the input impedance of the TRIG-
GER input can be set in the "Global Trigger/Clock Settings" dialog.

SCPI command:
[ :SOURce<hw>] :BB:GSM: TRIGger : SOURce on page 82

Sync. Output to External Trigger
(enabled for Trigger Source External)

Enables/disables output of the signal synchronous to the external trigger event.
For R&S SMBYV instruments:

|
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For or two or more R&S SMBVs configured to work in a master-slave mode for synchro-
nous signal generation, configure this parameter depending on the provided system trig-
ger event and the properties of the output signal. See the table below for an overview of
the required settings.

Table 3-1: Typical Applications

System Trigger Application "Sync. Output to External Trig-
ger"

Common External Trigger event for | All instruments are synchronous to | ON
the master and the slave instru- the external trigger event
ments

All instruments are synchronous OFF
among themselves but starting the
signal from first symbol is more
important than synchronicity with
external trigger event

Internal trigger signal of the master | All instruments are synchronous | OFF

R&S SMBYV for the slave instru- among themselves
ments
"On" Corresponds to the default state of this parameter.

The signal calculation starts simultaneously with the external trigger
event but because of the instrument’s processing time the first samples
are cut off and no signal is outputted. After elapsing of the internal pro-
cessing time, the output signal is synchronous to the trigger event.

l External
Trigger Event

/!

A Calculated signal

| —
/ll/— \‘\
|
|

\ /’}

Signal at the output
-

Processing Tima
I

|
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"Off" The signal output begins after elapsing of the processing time and starts
with sample 0, i.e. the complete signal is outputted.
This mode is recommended for triggering of short signal sequences with
signal duration comparable with the processing time of the instrument.

l External
Trigger Event

| —
A N
Y

/ \\I Calculated signal

|
| | ]
| \ /
|
|

\\‘x_\_\_\__'_r//
/’ _‘_“"-\\
| \
’/ \ Signal at the output

| \ .
Processing Time \ y

1 S "

SCPI command:
[ :SOURce<hw>] :BB:GSM:TRIGger:EXTernal :SYNChronize:OUTPut
on page 79

Trigger Delay
Sets the trigger signal delay in samples on external triggering or on internal triggering via
the second path.

Sets the trigger signal delay in samples on external triggering.

This enables the R&S Signal Generator to be synchronized with the device under test or
other external devices.

For two-path instruments, the delay can be set separately for each of the two paths.
SCPI command:

[ :SOURce<hw>] :BB:GSM:TRIGger [ :EXTernal<ch>] :DELay on page 83

[ : SOURce<hw>] :BB:GSM: TRIGger : OBASeband: DELay on page 80

Trigger Inhibit
Sets the duration for inhibiting a new trigger event subsequent to triggering. The input is
to be expressed in samples.

In the "Retrigger" mode, every trigger signal causes signal generation to restart. This
restart is inhibited for the specified number of samples.

This parameter is only available on external triggering or on internal triggering via the
second path.

For two-path instruments, the trigger inhibit can be set separately for each of the two
paths.

SCPI command:

[ :SOURce<hw>] :BB:GSM: TRIGger [ :EXTernal<ch>] : INHibit on page 84

[ :SOURce<hw>] :BB:GSM: TRIGger : OBASeband: INHibit on page 80
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3.8.2 Marker Mode

The marker output signal for synchronizing external instruments is configured in the
marker settings section "Marker Mode".

The R&S SMBYV supports only two markers.

Marker Mode
Selects a marker signal for the associated "MARKER" output.

"As defined in  The marker defined for each slot separately in the burst editor is used.

Slots" The name of the marker is displayed to the right of the selection. Defini-
tion of the slot marker is described in chapter 3.10, "Slot Marker Defini-
tion", on page 51.

"Slot" A slot clock with the slot period specified under Period is generated on

the output connector. The marker signal is generated after every speci-
fied number of slots.
It is important to be aware of the variation in the GSM/EDGE slot length
between 156 and 157 symbols. At a slot length of 156 symbols, a period
of 1 symbol and a symbol rate of 270.833 ksymb/s the clock is 0.577 ms,
and at 157 symbols it is 0.580 ms

"Restart" A marker signal is generated at the start of each ARB sequence.

"Frame " A frame clock with the frame period specified under Period is generated
on the output connector. The marker signal is generated after every
specified number of frames.

A GSM/EDGE frame has 1250 symbols. At a symbol rate of 270.833
ksymb/s and a period of 1 the clock is 4.615 ms.

"Pulse" A regular marker signal is generated. The pulse frequency is defined by
entering a divider. The frequency is derived by dividing the sample rate
by the divider. The input box for the divider opens when "Pulse" is
selected, and the resulting pulse frequency is displayed below it.

The maximum pulse frequency is half the symbol rate.

SCPI command:

[ :SOURce<hw>] :BB:GSM: TRIGger : OUTPut<ch>:PULSe:DIVider on page 89

[ :SOURce<hw>] :BB:GSM: TRIGger:OUTPut<ch>:PULSe [ :FREQuency]

on page 89

"Pattern " A marker signal that is defined by a bit pattern is generated. The pattern
has a maximum length of 64 bits and is defined in an input field which
opens when pattern is selected.

SCPI command:
[ :SOURce<hw>] :BB:GSM:TRIGger : OUTPut<ch>:PATTern on page 88
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"ON/OFF A regular marker signal that is defined by an ON/OFF ratio is generated.
Period" A period lasts one ON and OFF cycle.
The "ON Time" and "OFF Time" are each expressed as a number of
samples and are set in an input field which opens when ON/OFF ratio is
selected.

Start of signal

ON time OFF time ON time OFF time

SCPI command:
[ : SOURce<hw>] :BB:GSM: TRIGger : OUTPut<ch>:0ONTime on page 87
[ : SOURce<hw>] :BB:GSM: TRIGger : OUTPut<ch>:0FFTime on page 87

SCPI command:
[ :SOURce<hw>] :BB:GSM: TRIGger : OUTPut<ch>:MODE on page 86

3.8.3 Marker Delay

The delay of the signals on the MARKER outputs is set in the"Marker Delay" section.

@ The marker delay functions are available for R&S SMx and R&S AMU instruments only.

The R&S SMBYV supports only two markers.

Marker x Delay
Enters the delay between the marker signal at the marker outputs and the start of the
frame or slot.

If the setting "Fix marker delay to dynamic range" is enabled, the setting range is restricted
to the dynamic range. In this range the delay of the marker signals can be set without
restarting the marker and signal.

SCPI command:
[ :SOURce<hw>] :BB:GSM:TRIGger : OUTPut<ch>:DELay on page 85

Current Range without Recalculation
Displays the dynamic range within which the delay of the marker signals can be set with-
out restarting the marker and signal.

The delay can be defined by moving the setting mark.

SCPI command:
[ :SOURce<hw>] :BB:GSM:TRIGger : OUTPut<ch>:DELay:MINimum on page 86
[ :SOURce<hw>] :BB:GSM: TRIGger : OUTPut<ch>:DELay:MAXimum on page 85
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Fix marker delay to current range
Restricts the marker delay setting range to the dynamic range. In this range the delay
can be set without restarting the marker and signal.

SCPI command:
[ : SOURce<hw>] :BB:GSM: TRIGger : OUTPut :DELay: FIXed on page 84

Clock Settings

The Clock Settings is used to set the clock source and a delay if required.

\ The clock functions are available for R&S SMx and R&S AMU instruments only.

Sync. Mode
(for R&S SMBYV only)

Selects the synchronization mode.

This parameter is used to enable generation of very precise synchronous signal of several
connected R&S SMBVs.

Note: If several instruments are connected, the connecting cables from the master
instrument to the slave one and between each two consecutive slave instruments must
have the same length and type.

Avoid unnecessary cable length and branching points.

"None" The instrument is working in stand-alone mode.

"Sync. Master" The instrument provides all connected instrument with its synchronisa-
tion (including the trigger signal) and reference clock signal.

lock Settings
ISync Mode | Sync Master Zﬂ

Seat Synchronisation Settings |

"Sync. Slave" The instrument receives the synchronisation and reference clock signal
from another instrument working in a master mode.

SCPI command:
[ : SOURce<hw>] :BB:GSM:CLOCk:SYNChronization:MODE on page 77

Set Synchronization Settings
(for R&S SMBYV only)

Performs automatically adjustment of the instrument's settings required for the synchro-
nization mode, selected with the parameter "Synchronization Mode".

SCPI command:
[ : SOURce<hw>] :BB:GSM:CLOCk:SYNChronization:EXECute on page 76

Clock Source
Selects the clock source.

"Internal” The internal clock reference is used to generate the symbol clock.

|
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"External” The external clock reference is fed in as the symbol clock or multiple
thereof via the CLOCK connector.
The symbol rate must be correctly set to an accuracy of +/-2 % (see data
sheet).
The polarity of the clock input can be changed with the aid of "Global
Trigger/Clock Settings".
In the case of two-path instruments this selection applies to path A.

SCPI command:
[ :SOURce<hw>] :BB:GSM:CLOCk : SOURce on page 76

Clock Mode

Enters the type of externally supplied clock.

"Symbol" A symbol clock is supplied via the CLOCK connector.

"Bit" A bit clock is supplied via the CLOCK connector; the symbol clock is

derived internally from this.
"Multiple Sym- A multiple of the symbol clock is supplied via the CLOCK connector; the

bol" symbol clock is derived internally from this.
"Fractional A fraction of the symbol clock is supplied via the CLOCK connector; the
Symbol" symbol clock is derived internally from this.

Note: This selection is only available for external clock signals with a
clock rate of at least 200 Hz.

SCPI command:
[ : SOURce<hw>] :BB:GSM: CLOCk : MODE on page 74

Clock Multiplier
Enters the multiplication factor for clock type "Multiple".

SCPI command:
[ :SOURce<hw>] :BB:GSM:CLOCk:MULTiplier on page 75

Symbol Clock Divider
Enters the divider for clock type "Fraction".

SCPI command:
[ :SOURce<hw>] :BB:GSM:CLOCk:DIVider on page 75

Measured External Clock
Indicates the measured frequency of the external clock signal. This enables the user to
permanently monitor the frequency of the externally introduced clock.

This information is displayed only if the external clock source has been selected.

SCPI command:
CLOC:INP:FREQ?

Global Settings

The buttons in this section lead to submenu for general trigger, clock and mapping set-
tings.
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Burst Editor

This settings are available for R&S SMx and R&S AMU instruments only.

Global Trigger/Clock Settings
Calls the "Global Trigger/Clock/Input Settings" dialog.

This dialog is used among other things for setting the trigger threshold, the input impe-
dance and the polarity of the clock and trigger inputs.

In the case of two-path instruments, these settings are valid for both paths.

The parameters in this menu affect all digital modulations and standards, and are descri-
bed in chapter "Global Trigger/Clock/Input Settings" in the Operating Manual.

User Marker / AUX I/O Settings
Calls the "User Marker AUX I/O Settings" menu, used used to map the connector on the
rear of the instruments.

See also "User Marker / AUX I/O Settings" in the Operating Manual.

Burst Editor

To call the burst editor, select a slot from the graphical display in the GSM/EDGE menu.

At the top of the menu the structure of the current burst type for the selected slot is
displayed. Individual fields of the burst are color-coded:

Field Color
Data, Fixed, Mixed, Stealing white

Training Sequences: TSC, ETSC, SYNC yellow
Tail, extended Tail green
Guard, extended Guard blue

|
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B GSM/EDGE A: Burst@Slot3

IBurst Type I Normal (Full Rate) jl
SaveRecall Slots... |
Slot Level | off =
Slot Attenuation (0.0 dB (A1) |
[~ Multislot Configuration Number Of Slots |_1
Burst Fields
Tail Bits 000
Data | PRBS 9 =l
|+ Use Stealing Flag Stealing Flag II]_
Training Sequence TSC ITSC 3 j
User TSC 0100 0111... |
Guard 1111 1111
Slot Marker Definition... |

The rest of the menu displays the data contained in fields predefined by the standard for
the current burst type. Data fields with variable content can be edited. The value at which
they are currently set is shown on a button. Pressing the button activates the value that
has been entered. Values in fields with permanently predefined content are not highligh-
ted in any way.

The following sections list all possible settings and displays for the various burst types.

If a setting applies only to a particular burst type, this is mentioned for the parameter
concerned.

Burst Type
Selects burst type.

The available burst types depend on the selected "Symbol Rate Mode".

Note: "Higher Symbol Rate" Mode and higher order modulation schemes (16QAM and
32QAM) are available for instruments equipped with option K41 only.

"Normal (Normal Symbol Rate)
(GMSK/Full The useful data is transmitted in the Normal Burst (NB).
Rate)" A normal burst carries 2*58 = 116 encrypted symbols.

& GSM/EDGE A: Burst @Frame1/Slot0 BE®
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(GMSK/Half
Rate)"

Burst Editor

(Normal Symbol Rate)

The useful data is transmitted in the Normal burst.

Half rate user 1 is transmitted in all the frames with an even index (frames
0, 2, 4, etc.) and half rate user 2 is transmitted in the frames with an odd
index (frames 1, 3, etc.)

See alsochapter 3.3, "Mode Framed (single)", on page 16.

& GSM/EDGE A: Burst@Slot0 9=

User 1

Data S| TsC |s Data
57 1 26 1 57
Data S| TsC |s Data
57 1 26 1 57

IBurs1 Type INnrmaI (GMSK / Half Rate) i;{

User 2

"Normal (8PSK/(Normal Symbol Rate)

EDGE)"

"Normal
(16QAM)"

"Normal
(32QAM)"

The higher bit clock associated with EDGE achieves correspondingly
higher data transfer rates.

If a frame contains an active EDGE burst, the higher bit clock (3 x symbol
clock) is always output on the clock outputs. If the EDGE burst is removed
from the frame, the lower bit clock (=symbol clock) is automatically output
again.

An EDGE burst carries 2x(3*58) = 348 encrypted symbols.

&2 GSM/EDGE A: Burst@Slot0

HIBursl Type I Normal (8PSK / EDGE) J

(Normal Symbol Rate)

Selects a normal burst with 16QAM modulation scheme (4 bits per sym-
bol).

A normal 16QAM burst carries 2x(4*58) = 464 encrypted symbols.

B GSM/EDGE A: Burst@Slot0

‘IBurst Type |Nurma| (16QAM) jll

(Normal Symbol Rate)

Selects a normal burst with 32QAM modulation scheme (5 bits per sym-
bol).

A normal 32QAM burst carries 2x(5*58) = 580 encrypted symbols.

B GSMIEDGE A: Burst@Slot0

IBursl Type INnrmaI (320AM) Jl
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"Synchroniza-

tion"

"Frequency
Correction”

llDummyll

"Access"

"All Data
(GMSK)"

Burst Editor

(Normal Symbol Rate)

The Synchronization burst is sent by the base station only and is used
for bit synchronization. For this purpose it contains a 64-bit Extended
Training Sequence.

&5 GSM/EDGE A: Burst @Frame1/Slot

IBurst Type | Synchronization J

(Normal Symbol Rate)

The Frequency Correction burst is sent by the base station only. The user
equipment uses the burst in order to synchronize with the carrier fre-
quency and to compensate for any possible Doppler effect.

& GSM/EDGE A: Burst @Frame1/Slot0 BE®

IBurst Type | Frequency Correction jl

(Normal Symbol Rate)

The Dummy burst is sent by the base station only. It acts as a modulation
signal when there is no data burst available. This burst type is defined in
the standard and has an unalterable, precisely defined data pattern.

& GSM/EDGE A: Burst @Frame1/Slot0 BE®

IBurst Type | Dummy ~

(Normal Symbol Rate)

This burst type is sent by a user equipment to a base station as the first
burst, in order to determine the timing advance. It is used for synchro-
nizing with the base station.

&5 GSM/EDGE A: Burst @Frame1/Slotd

ACLESS i

Burst Type

(Normal Symbol Rate)

This and the following normal symbol rate burst types are not defined in
the standard. They serve as the output basis for defining a new burst
type with user-programmable data content for test purposes.

B2 GSM/EDGE A: Burst@Slot0

[Burst Type | All Data (GMSK) J
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"All Data (Normal Symbol Rate)
(8PSK/EDGE)" An All_Data EDGE burst carries 3x148 = 444 encrypted symbols.

& GSM/EDGE A: Burst@Slot0

IBurst Type IAII Data (8PSK / EDGE) viI

"All Data (Normal Symbol Rate)
(16QAM)" An All_Data 16QAM burst carries 4x148 = 592 encrypted symbols.

& GSM/EDGE A: Burst@Slot0

IBursl Type IAII Data (16QAM) 'il

"All Data (Normal Symbol Rate)
(32QAM)" An All_Data 32QAM burst carries 5x148 = 740 encrypted symbols.

B GSM/EDGE A: Burst@Slot0

[Burst Type | All Data (320AM) ~|

"HSR (QPSK)" (Higher Symbol Rate)
Selects a higher symbol rate burst with QPSK modulation scheme (2 bits
per symbol).
A higher symbol rate burst carries 2*69 = 138 unmodulated encrypted
symbols, i.e. a HSR QPSK burst carries 2x(2*69) = 276 encrypted sym-
bols.

B2 GSM/EDGE A: Burst@Slot0

Data
138

||Bur51 Type | HSR (QPSK) Jl

"HSR (16QAM)"(Higher Symbol Rate)
Selects a higher symbol rate burst with 16QAM modulation scheme (4
bits per symbol).
A HSR 16QAM burst carries 4x(2*69) = 552 encrypted symbols.

B GSM/EDGE A: Burst@Slot0

Data
276

[Burst Type | HSR (160AM) j||

|
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"HSR (32QAM)"(Higher Symbol Rate)
Selects a higher symbol rate burst with 32QAM modulation scheme (5
bits per symbol).
A HSR 32QAM burst carries 5x(2*69) = 690 encrypted symbols.

B GSM/EDGE A: Burst@Slot0 =13

Data
345

||Bur51 Type | HSR (320AM) j||

"HSR All Data (Higher Symbol Rate)

(QPSK)" This and the following higher symbol rate burst types are not defined in
the standard. They serve as the output basis for defining a new burst
type with user-programmable data content for test purposes.

A HSR All_Data QPSK burst carries 2x177 = 354 encrypted symbols.

FEX

B GSM/EDGE A: Burst@Slot0

Data
354

IBurst Type | HSR All Data (QPSK) j||

"HSR All Data (Higher Symbol Rate)
(16QAM)" A HSR All_Data 16QAM burst carries 4x177 = 708 encrypted symbols.

B GSM/EDGE A: Burst@Slot0 =19

IBursl Type IHSR All Data (16QAM) 'il

"HSR All Data (Higher Symbol Rate)
(32QAM)" A HSR All_Data 32QAM burst carries 5x177 = 885 encrypted symbols.

E% GSM/EDGE A: Burst@Slot0 =13

[Burst Type | HSR All Data (320AM) j||

SCPI command:
[ : SOURce<hw>] :BB:GSM[ : FRAMe<di>] : SLOT<st0>:TYPE on page 93

Recall Predefined Slot Save-Recall Slots

Recall User Siot Calls the Save/Recall Slot menu.

zmg::;::m From the Save/Recall Slot menu the File Select windows for saving and recalling slot
configurations and the File Manager can be called (see chapter 3.5, "Save Recall Frame/

Slots", on page 19).

SCPI command:
n.a.
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User x
When burst type "Normal (Half Rate)" is selected the users can be set separately in menu
sections User 1 and User 2.

SCPI command:
n.a.

Slot Level
Sets the level for the selected slot.

"Off" Attenuation is maximum. The slot is inactive.
"Attenuated" Level is reduced by the level attenuation set in "Slot Attenuation".
"Full" The level corresponds to the level indicated in the display.

SCPI command:
[ : SOURce<hw>] :BB:GSM[ : FRAMe<di>] : SLOT<st0>[ :USER<ch>] :LEVel
on page 93

Slot Attenuation

Selects the level attenuation for the Slot Level Attenuated setting. You can use the "Power
Ramping" menu (see chapter 3.7, "Power Ramping/Slot Attenuation”, on page 27) to
define seven different values for level attenuation. You may select from the values dis-
played.

SCPI command:

[ : SOURce<hw>] :BB:GSM[ : FRAMe<di>] : SLOT<stO0>[ :USER<ch>]:
ATTenuation on page 93

Filter
(for Higher Symbol Rate slots and instruments equipped with K41 only)

Selects whether a Narrow Pulse Shape or a Wide Pulse Shape filter should be use for
the selected burst type and modulation.

SCPI command:
[ :SOURce<hw>] :BB:GSM|[ : FRAMe<di>] : SLOT<st0>[:USER<ch>] :FILTer:
TYPE on page 94

Multislot Configuration
Enables the previously set multislot mode.

Since multislot involves connecting multiple slots to a single user channel, this configu-
ration is possible for Normal (Full Rate) bursts, Normal (8PSK/EDGE) burst and EDGE
Evolution bursts.

A number of multislot groups can be defined within a frame. These are highlighted when
the frame structure is displayed in the main menu (see chapter 3.3, "Mode Framed (sin-
gle)", on page 16).
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————————————Frame: Select Slot to Configure ———

DeE—oew

The first slot in a multislot group is the master slot. This determines the parameters of all
the slots in the group. All the slots in a multislot group therefore have identical parameters.

The multislot settings are valid for all the slots in the frames of a multiframe configuration.
If slots 1 and 2 are connected, for example, both these slots are connected in all the
frames of the multiframe signal.

SCPI command:
[ :SOURce<hw>] :BB:GSM[ : FRAMe<di>] :MULTislot<st0>:STATe on page 95

Number of Slots
Defines the number of consecutive slots that will be linked to a multislot.

The multislot always starts with the current slot. The value range therefore depends on
the current slot index. A maximum of 8 slots (slot 0 to slot 7) can be combined: 1 ... (8 -
current index).

SCPI command:
[ :SOURce<hw>] :BB:GSM[ : FRAMe<di>] :MULTislot<st0>:COUNt on page 94

Extended Tail Bits
Displays the data content in the "ETail" data field of the Access burst.

Extended Tail Bits fields are 8 bits long and permanently set at 0011 1010.

SCPI command:
n.a.

Tail Bits
Displays the data content in the "Tail" data field.

The GSM Tail Bit field is 3 bits long and permanently set at 000.
The EDGE Tail Bit field is 9 bits long and permanently set at 1111 1111 1.

SCPI command:
n.a.

Data for Data Field of Slot
Selects a data source for the DATA field.

If a burst contains multiple DATA fields, these are treated as a continuous field, and for
instance a pseudo-random sequence is continued without interruption from one DATA
field to the next.

You may choose from the following data sources:
"All 0, All1" 0 data or 1 data is internally generated.

"PRBS" PRBS data in accordance with the IUT-T with period lengths between
2°9-1 and 223-1 are internally generated.

|
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"Pattern” A user-definable bit pattern with a maximum length of 64 bits is internally
generated.
The bit pattern is defined in the "Pattern” input box.

"Data List" Uses data from a programmable data list. The data can be generated
internally with the aid of the binary editor in the R&S Signal Generator or
externally by the user with the aid of any editor.

Data lists are selected from the Select List file menu.

SCPI command:

[ : SOURce<hw>] :BB:GSM[ : FRAMe<di>] : SLOT<st0>[ :USER<ch>] [ : SOURce] :
DATA on page 95

[ : SOURce<hw>] :BB:GSM[ : FRAMe<di>] : SLOT<st0>[ :USER<ch>] [ : SOURce] :
DATA:PATTern on page 97

[ :SOURce<hw>] :BB:GSM][ : FRAMe<di>] : SLOT<st0>[ :USER<ch>] [ : SOURce] :
DATA:DLISt on page 96

Use Stealing Flag
Sets the Use Stealing Flag feature. The setting applies to both S fields. If not used, the
flag stealing bit is allocated to the data field concerned, which then becomes 58 data bits
long instead of 57.

SCPI command:
[ : SOURce<hw>] :BB:GSM[ : FRAMe<di>] : SLOT<st0>[ :USER<ch>] : SFLag:USE
on page 98

Stealing Flag

Sets a value for the Stealing Flag feature. The setting applies to both S fields.
SCPI command:

[ : SOURce<hw>] :BB:GSM[ : FRAMe<di>] : SLOT<stO0>[:USER<ch>] :SFLag
on page 97

Training Sequence TSC
Selects the "Training Sequence Code".

There are 8 predefined training sequences to choose from in each case; those for GSM
are 26 bits long and those for EDGE are 78 bits.

raining Sequence TSC

User TSC

Guard

A user-defined training sequence can be created in the User TSC field and is then also
available for selection.

SCPI command:
[ :SOURce<hw>] :BB:GSM|[ : FRAMe<di>] : SLOT<st0>[ :USER<ch>] [ : SOURce] :
TSC:SELect on page 98
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User TSC
Edits selected training sequence.

When a sequence has been changed, the TSC field displays the indication "User".
When a frame/slot is saved the amended training sequence is also saved.

User-defined training sequences can be used among other things to test the reaction of
receivers to interference-laden training sequences (e.g. 1 bit toggle).

SCPI command:

[ :SOURce<hw>] :BB:GSM|[ : FRAMe<di>] : SLOT<st0>[:USER<ch>] [ : SOURce] :
TSC:USER on page 99

Ext Training Seq ETSC
Selects the Extended Training Sequence Code for the Synchronization burst.

There is a choice of three predefined, 64-bit extended training sequences. Additionally a

user-defined extended training sequence can be defined in the User ETSC field and is
then also available for selection.

SCPI command:
[ :SOURce<hw>] :BB:GSM[ : FRAMe<di>] : SLOT<st0>[ :USER<ch>] :ETSC
on page 99

User ETSC
Edits selected ETSC for the Synchronization burst.

When a sequence has been changed, the "Ext Training Seq ETSC" field also displays
"User" as a possible choice.

When a frame/slot is saved, the changed extended training sequence is also saved.
SCPI command:

[ :SOURce<hw>] :BB:GSM[ : FRAMe<di>] : SLOT<st0>[ :USER<ch>] :ETSC:USER
on page 99

Training Sequence Sync
Selects Training Sequence Sync for the Access burst.

ITraining Sequence Sync

User Sync

Data

There is a choice of three predefined, 41-bit training sequences sync. Additionally user-
defined training sequence sync can be defined in the "User Sync" field and is then also
available for selection.

SCPI command:
[ :SOURce<hw>] :BB:GSM[ : FRAMe<di>] : SLOT<st0>[ :USER<ch>] : SYNC:
SELect on page 100

User Sync
Edits the Training Sequence Sync for the Access burst.

When a sequence has been changed, the "Training Sequence Sync" field also displays
"User" as a possible choice.
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When a frame/slot is saved the amended training sequence sync is also saved.

SCPI command:
[ :SOURce<hw>] :BB:GSM[ : FRAMe<di>] : SLOT<stO0>[ :USER<ch>] : SYNC:USER
on page 100

Fixed

Selects the data content of the Fixed field in the Frequency Correction burst. There is a
choice of two fixed, 142-bit data contents prescribed by the standard. The "User" data
content can also be selected. This pattern can be edited in the Fixed Pattern field and
must likewise be 142 bits long.

IFixEﬂ | Standard ﬂ
d aaro
Fixed Pattern Compact
User

Gwead - L v T

SCPI command:
[ :SOURce<hw>] :BB:GSM|[ : FRAMe<di>] : SLOT<stO0>[ :USER<ch>] :
FCORrection:FIxed on page 101

Fixed Pattern

Displays the data content of the Fixed field in the Frequency Correction burst when "Fixed
Standard" or "Compact" is selected.

Enter the data content of the Fixed field in the Frequency Correction burst when "Fixed
User" is selected. The pattern is 142 bits long.

SCPI command:
[ :SOURce<hw>] :BB:GSM|[ : FRAMe<di>] : SLOT<stO0>[ :USER<ch>] :
FCORrection:FIXed:PATTern on page 101

Mixed
Displays the data content of the Mixed field in the Dummy burst. It contains a fixed, 142-
bit data content prescribed by the standard.

SCPI command:
[ :SOURce<hw>] :BB:GSM|[ : FRAMe<di>] : SLOT<st0>[ :USER<ch>] : DUMMy :
MIXed:PATTern on page 101

Guard
Displays the data content of the Guard field in binary notation.

In order for a frame to contain exactly 1250 bits for normal burst and 1500 for higher
symbol rate burst as prescribed in the GSM standard, the length of the Guard fields is
different for different slots (see table).

Normal Symbol Rate

Slot # 0,4 1..3,6..7

Guard Length 9 symbol periods 8 symbol periods

Higher Symbol Rate

|
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Slot # 0,2,4,6 1,3,57

Guard Length 11 symbol periods 10 symbol periods

If the field Ignore "1/4 symbol (slot length 156 symbols) / Ignore 1/2 symbol (slot length
187 symbols)" is enabled, all slots are 156 respectively 187 symbols long. The extra 4
resp. ¥2 symbols is omitted. The guard field for the burst always has the same length
regardless of the slot index.

For normal burst, a frame is therefore 1248 symbols long instead of 1250.

Respectively, the length of the frame in a higher symbol rate burst is then 1496 symbols
long instead of 1500 symbols.

SCPI command:
n.a.

Extended Guard
Displays the data content of the Extended Guard field in the Access burst.

In order for a frame to contain exactly 1250 symbols as prescribed in the GSM standard,
the length of the extended Guard fields is different for different slots:

The field length is 68 bits in slots 1, 2, 3, 5, 6, 7 and 69 bits in slots 0 and 4.

If the field "Ignore 1/4 symbol (slot length 156 symbols)" is enabled, all slots are 156
symbols long. The extra ¥4 symbol is omitted. The extended guard field for the burst
always has the same length regardless of the slot index. A frame is therefore 1248 sym-
bols long in place of 1250.

SCPI command:
n.a.

Slot Marker Definition
Calls the menu for defining the marker signal at slot level. This menu is described in the
chapter 3.10, "Slot Marker Definition", on page 51.

SCPI command:
n.a.

3.10 Slot Marker Definition

To call the "Control List Editor" for defining the marker signal at slot level, use the "Slot
Marker Definition" button in the burst editor of the GSM/EDGE menu.

Siof Marker Definition .

\ The marker signals thus defined will only become effective if the "As defined in slot"
/ marker type in the "Trigger/Marker/Clock menu" is selected.

The structure of the selected slot (in the example, synchronization burst) is displayed in
the menu header. The individual fields of the burst are color-coded.

|
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The available marker signals are also color-coded. In the left "Configure Control Sig-
nal" section, each individual signal is assigned a color; a check in the check box shows
the marker for which the "As defined in slot" marker type has been selected.

In the next section, "Select Ramp to Edit", the signal characteristics are graphically dis-
played.

The ramps can be assigned the exact bit position in the signal by means of

e The schematic display of the slot above the section.

e The bit scale below the marker/control signal characteristic.

e The display of the current cursor position in the "Cursor" menu section if the cursor
marks the ramp. The field at the selected position in the slot is displayed on the side.
The bit position of the cursor within this field is displayed below

The ramps can be set either graphically in the "Select Ramp to Edit" section or in the
table of the "Positions Marker x" section. To make the setting easy, a selection of preset
ramp characteristics is offered in the "Preset Ramp Marker x" section.

&2 Slot Marker GSM A (Frame 1 : Slot 3)

Tail Data TSC Data Tail
9 174 78 174 9

Fonfigure Control Signalg Select Ramp to edit
wo cl I
Marker 2 |_- :
Marker 3 |_-
Marker 4 |_-
- |IIIIIIIII|IIIIIIIII|IIIIIIIII|I\IIIIIII|I\III
[ Total List Length—}g 100 200 300 400 Position /Bit
Length IdBB
Preset Ramp Marker 1 Cursor Positions Marker 1 —Save
Preset Type IAII down 'l Positionl 54 Data Edit Table... | Save |
174
Preset | S
Position in Data 45

Configure Control Signal
Displays the color the marker and the Burst Gate signal has been assigned.

Displays whether the "CList" marker type has been selected in the Trigger/Marker/Clock
menu for this marker.

Displays whether the "As defined in Slot" source has been selected for this marker signal
in the individual setting menu.

The source can be selected here as well and will then be used in the associated menus.
Note: The burst gate signal is only displayed and cannot be edited.

SCPI command:
[ :SOURce<hw>] :BB:GSM|[ : FRAMe<di>] : SLOT<st(0>[ :USER<ch>] : TRIGger:
OUTPut : TAG on page 102
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Select Ramp to Edit
Graphically edit marker signals.

For this purpose, the cursor is set to the position where a ramp is required. The ramp is
generated by pressing Enter (e.g. clicking on the rotary knob). Any number of ramps can
be defined per marker. Each of the generated ramp positions will be saved even if the
definition of another ramp produces a low/low or high/high transition. The ramps are dis-
played as dashed lines.

Existing ramps can be shifted after the cursor has been placed on the ramp and Enter
has been pressed — it then changes color twice. The ramp is shifted by using the cursor
keys or the rotary knob. The new position is determined by pressing Enter again.

Ramps can be deleted by means of the BACKSPACE key after the cursor has been
placed on the ramp.

SCPI command:
n.a.

Preset Ramp
Activates presetting for the ramp characteristic of the selected control signal. The pre-
setting is selected with Select Preset Type and activated by means of the "Preset" button.

You can select from:

"All Up" The marker signal is continuously high.

"All Down" The marker signal is continuously low.

"Ramp Up" The marker signal contains a ramp from low to high. The ramp is shifted
to the center of the displayed signal area and can subsequently be shifted
as required.

"Ramp Down" The marker signal contains a ramp from high to low. The ramp is shifted
to the center of the displayed signal area and can subsequently be shifted

as required.
"Ramp Up/ The marker signal contains a ramp from low to high and from high to low.
Down" The ramps are symmetrically shifted around the center of the displayed

signal area and can subsequently be shifted as required.

"Ramp Down/ The marker signal contains a ramp from high to low and from low to high.
Up" The ramps are symmetrically shifted around the center of the displayed
signal area and can subsequently be shifted as required.

SCPI command:
n.a.

Cursor Position
Enters the cursor position.

In the graphic display, the cursor is positioned according to the entry.
Vice versa, graphically shifting the cursor will change the displayed value.

The field at the selected position in the slot is displayed on the side. The bit position of
the cursor within this field is displayed below.

SCPI command:
n.a.
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Position Marker x
Opens table by using the "Edit Table" button.

The ramps of the selected signal can be edited in the table. When the table is opened,
the current configuration of the selected marker/control signal is displayed.

&5 Position TableGSM A (0:0) EEE

Ramp Positions | Ramp State | * |
1 4 High
2 20 Low
3 29 High
4 34 Low
5 52 High
6 100 Low
7 104 Low _
8 hd|
—

Accept

The bit position is specified in the "Ramp Position" column, the high or low signal status
in the "Ramp State" column. At the end of the list, there is always a blank row for entering
new values.

The changes are accepted in the graphic display after pressing the "Accept” button.

SCPI command:
n.a.

Save

Saves the settings made in the "Slot Marker" menu into a file with file name format
GsmMarkSlotDefP<x>F<y>S<z>U<w>.dm igc, where:

e x the path number,

e v is the Frame number,

e z is the Slot number and

e wis the User number.

SCPI command:
n.a.
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4 Remote-Control Commands

This subsystem contains the commands for setting the GSM/EDGE standards.

O\ The R&S Signal Generator can be used to define multiframe signals. This requires the
/ inclusion of the keyword FRAMe in the commands concerned. However, this keyword is
optional in the case of single-frame signals.

When the keyword is not specified the commands are compatible with the corresponding
commands in the R&S SMIQ generator family (see also the list comparing R&S SMU and
R&S SMIQ commands).

In Frame (Double) mode (SOURce : BB: GSM: MODE DOUBIle) the suffix to FRAMe defines
the frame to which the setting applies.

In Frame (Single) mode the keyword FRAMe is ignored and can be omitted.

The suffix to SLOT defines the slot to which the setting applies. The 8 slots of which a
frame is composed can be selected.

GSM (slot 0 to slot 7). SCPI prescribes that suffix 1 is the default state and used when
no specific suffix is specified. Therefore, slot 1 (and not slot 0) is selected when no suffix
is specified.

@ In case of remote control, suffix counting for slots corresponds to the suffix counting with

When burst type HALF is selected, the suffix to USER defines the half rate user to which
the setting applies. For all other burst types the keyword USER is ignored and can be
omitted.

SOURce<hw>
For one-path instruments, the keyword SOURCce is optional and can be omitted.

The numeric suffix to SOURce distinguishes between multicarrier generation for path A
and path B in the case of two-path instruments:

e SOURce<1> = path A
The keyword SOURce is optional and can be omitted

e SOURce2 =path B
The keyword SOURce is mandatory, i.e. the command must contain the keyword with
suffix 2.

OUTput<ch>
The numeric suffix to oUTPut distinguishes between the available markers.

Only two markers are available for the R&S SMBYV, i.e. the allowed values for the suffix
are 1 or 2.

Placeholder <root>
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4.1

Primary Commands

For commands that read out or save files in the default directory, the default directory is
set using command MMEM: CDIRectory. The examples in this description use the place
holder <root> in the syntax of the command.

e D:\ -for selecting the internal hard disk of Windows instruments

e E:\ -forselecting the memory stick which is inserted at the USB interface of Windows
instruments

® /var/<instrument> - for selecting the internal flash card of Linux instrument,
where <instrument> is the instument name, e.g. smbv.

e /usb - for selecting the memory stick which is inserted at the USB interface of Linux
instrument.

Primary Commands

[:SOURCe<hw>]:BB:GSM:FLENGh....ccuiiieeieeieee e e e e 56
[:SOURCe<hW>]:BB:GSM:SLENGN....ccuuiiiiiieiieeiiie e et e e et e e e e e e een e e e eananas 57
[:SOURCE<hW>]:BB:GSIM:FONE.......ctuiiiiiiteieeeiiie ettt e e ettt e e e et eeeeena e e s eeb e eeeeraneeeeennanns 57
[:SOURce<hw>]:BB:GSM:FRAMe<di>:REPEtItiONS......cciuiiriiiiiiiicicee e 58
[:SOURCe<hw>]:BB:GSM:ISLENGN.....cuieieiie ettt e e 58
[:SOURCe<hW>]:BB:GSM:MODE..... et ce e e e e e e e e e e e et e e e e e enen 59
[:SOURCE<hW>]:BB:GSM:PRESEL.....cccceeetueeiieeiiiieeeeeeeice s e e e eetee e e e et s e e e ee e s e e e e e e e e eeanan s 59
[:SOURce<hw>]:BB:GSM:SATTeNUatiON<CR>....ccouiiiiiiiieiii e e e e e e 59
[:SOURCce<hw>]:BB:GSM:SETTING:CATAIOF. ... ceieereeeeeirieeeeeriieeeeetiaseeeennaeeeeennaeseesneeeeesnnnns 60
[:SOURCe<hw>]:BB:GSM:SETTING:DELEE.....cuuueiieiiiiieeeeiieiee et ee et e e et e e e e e e eananns 60
[:SOURce<hw>]:BB:GSM:SETTING:LOAD. .. ..ttt ettt e e e e e e e e e e e e eaaae 61
[:SOURce<hw>]:BB:GSM:SETTING:STORE. . ...ttt et e e e eaas 61
[:SOURCE<hW>]:BB:GSM:SMODAE......ceieeeieieie et e e e e e et et et e e e e e e e eeaen 61
[[SOURCESNW>]:BB:GSMiSRATE. .. ittt eieeeeieieeeieit e e e e e e e e e e e e eeeeaeeenaaaeaeeeaeeeeeeeeeneennnnanns 62
[:SOURce<hw>]:BB:GSM:SRATE:MODE..........ccttteiuuaieeeeeeeeeeanineaaeeeeeeeeeaennnaaaeeaeeeeeenennnnns 62
[[SOURCESNWS | BB G SIM ST AT . . cettuuieeeeitiieee ettt ee ettt e e e e etta e e e ettt e e e eeta e esasteeeeatasaerennnnns 63
[:SOURce<hw>]:BB:GSM:WAVEfOrm:CREGLE. ........ccieeeeiieiieieeeeeeiiieeeeeernieeeeeseerneeeeeeennnnns 63

[:SOURce<hw>]:BB:GSM:FLENgth <FLength>
(for R&S WinlQSIM2 only)
(Framed mode only)

The command sets the sequence length of the generated arbitrary waveform file in num-
ber of frames.

For GSM mode Framed Double, this command is query only, since the length of the
generated ARB file is determined by the parameter Frame Repetition ([ :
SOURce<hw>] :BB:GSM: FRAMe<di>:REPetitions) for both frames:

Sequence Length = Frame Repetition of Frame 1 + Frame Repetition of Frame 2.

For GSM mode (BB : GSM: MODE) set to Unframed, the length of the generated ARB file
is set in symbols with the command [ : SOURce<hw>] : BB:GSM: SLENgth.
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Parameters:

<FLength> float
Range: 1 frame to 13 107 frames
*RST: 1 frame

Example: BB:GSM:MODE SING

selects framed single GSM mode.
BB:GSM:FLEN 2

sets the sequence length to 2 frames.
BB:GSM:MODE DOUB

selects framed double GSM mode.
BB:GSM:FRAM1:REP 2

sets the frame repetition of frame 1 to 2.
BB:GSM:FRAM2:REP 1

sets the frame repetition of frame 2 to 1.
BB:GSM:FLEN?

queries the sequence length.
Response: 3

[:SOURce<hw>]:BB:GSM:SLENgth <SLength>
for R&S WinlQSIM2 only
(Unframed mode only)

The command sets the sequence length of the generated arbitrary waveform file in num-
ber of symbols.

For GSM mode (BB : GSM: MODE) set to Single or Double, the length of the generated ARB
file in symbols is a read-only value and depends on the sequence length in frames, set
with the command BB: GSM: FLEN.

Parameters:

<SLength> integer
Range: 1 symbol to 16 384 000 symbols
*RST: 1250 symbols

Example: BB:GSM:MODE UNFR

selects unframed GSM mode.
BB:GSM:SLEN 5000

sets the sequence length to 5000 symbols.

[:SOURce<hw>]:BB:GSM:FONE <FOne>

A modulating bit stream consisting of consecutive ones is used for inactive slots (accord-
ing to GSM 05.04).

If this parameter is disabled, the inactive slots are filled in with 0.
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Parameters:
<FOne> 0]1|OFF|ON

*RST: OFF
Example: BB:GSM:FONE ON

A modulating bit stream consisting of consecutive ones is used for
inactive slots.

[:SOURce<hw>]:BB:GSM:FRAMe<di>:REPetitions <Repetitions>

The command defines the number of repetitions for the selected frame in GSM mode
Frame (Double).

Suffix:
<di> [1112
Parameters:
<Repetitions> integer
Range: 1 to 500000
*RST: 1/1
Example: BB:GSM:MODE DOUB

selects GSM mode Frame (Double).
BB:GSM:FRAM2:REP 10

sets 10 repetitions for frame 2.

[:SOURce<hw>]:BB:GSM:ISLength <ISLength>
Selects constant slot length.

For Normal Symbol Rate mode, the command selects whether the 1/4 symbol of a GSM
slot (length = 156.25 symbols) will be ignored (ON) or compensated for by an extra symbol
every 4th slot (OFF). When ON is selected, all slots are 156 symbols long. When OFF is
selected, some slots are 157 symbols long.

For Higher Symbol Rate mode, the command selects whether the 1/2 symbol of a aver-
age slot with a length of 187.5 symbols will be ignored (ON) or compensated for by an
extra symbol every secend slot (OFF). When ON is selected, all slots are 187 symbols
long. When OFF is selected, some slots are 188 symbols long.

Parameters:
<ISLength> 0]1|OFF|ON

*RST: OFF

|
Operating Manual 1171.5254.12 — 10 58



GSM/EDGE Remote-Control Commands
|

Primary Commands

Example: BB:GSM:SRAT:MODE NSR
selects normal symbol rate mode.
BB:GSM:ISL ON

selects a constant length of 156 symbols for all slots.

[:SOURce<hw>]:BB:GSM:MODE <Mode>
The command selects GSM mode.

Parameters:
<Mode> UNFRamed|SINGle|DOUBIle|MULTiframe

UNFRamed
Modulation signal without slot and frame structure.

SINGle
Modulation signal consisting of one frame.

DOUBIe
Modulation signal in which two frames are defined and then
combined by some method into a single multiframe signal.

MULTiframe
Multiframe signal.

*RST: SINGle

Example: BB:GSM:MODE SING
sets the "Single Frame" GSM mode. Only the commands for defin-
ing a single frame are valid.

[:SOURce<hw>]:BB:GSM:PRESet

The command sets all modulation parameters, including slot settings, to their GSM
default values. The ON status (SOURce:BB:GSM:STATe ON | OFF)is not affected by
this command.

Example: BB:GSM: PRES
resets all GSM settings to default values.

Usage: Event

[:SOURce<hw>]:BB:GSM:SATTenuation<ch> <SAttenuation>

The command sets up to seven different values for level attenuation. The various values
are defined by the suffix to SATTenuation. These values are used when defining the

level attenuation of individual slots with the aid of the command [ : SOURce<hw>] : BB:
GSM[ : FRAMe<di>] : SLOT<st0>[ :USER<ch>] :ATTenuation.
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Suffix:

<ch> 1..7

Parameters:

<SAttenuation> float
Range: 0 to 60dB
Increment: 0.01 dB
*RST: 0dB

Example: BB:GSM:MODE SING

selects GSM mode Frame (Single).
BB:GSM:SLOT1:LEV ATT

sets level attenuation mode for slot 1.
BB:GSM:SATT1 12dB

sets the level attenuation for selection A1 to 12 dB.
BB:GSM:SLOT1:ATT Al

sets the level attenuation for slot 1 to 12 dB.

[:SOURce<hw>]:BB:GSM:SETTing:CATalog?

This command reads out the files with GSM settings in the default directory. The default
directory is set using command MMEM: CDIRectory. Only files with the file extension
* . gsm will be listed.

Return values:
<Catalog> string

Example: MMEM:CDIR '<root>\user\dig mod
sets the default directory to <root>\user\dig_mod.
BB:GSM:SETT:CAT?
reads out all the files with GSM settings in the default directory.
Response: gsm 1

Usage: Query only

[:SOURce<hw>]:BB:GSM:SETTing:DELete <Filename>

This command deletes the selected file with GSM settings. The directory is set using
command MMEM: CDIRectory. A path can also be specified, in which case the files in
the specified directory are read. The file extension may be omitted. Only files with the file
extension * . gsm will be deleted.

Setting parameters:
<Filename> string
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Example: BB:GSM:SETT:DEL 'gsm 1'
deletes file gsm 1.

Usage: Setting only

[:SOURce<hw>]:BB:GSM:SETTing:LOAD <Filename>

This command loads the selected file with GSM settings. The directory is set using com-
mand MMEM: CDIRectory. A path can also be specified, in which case the files in the
specified directory are read. The file extension may be omitted. Only files with the file
extension * . gsm will be loaded.

Setting parameters:
<Filename> string

Example: BB:GSM:SETT:LOAD 'gsm 1'
loads file gsm_1

Usage: Setting only

[:SOURce<hw>]:BB:GSM:SETTing:STORe <Filename>

This command stores the current GSM settings into the selected file. The directory is set
using command MMEM: CDIRectory. A path can also be specified, in which case the
files in the specified directory are read. Only the file name has to be entered. GSM settings
are stored as files with the specific file extensions * . gsm.

Setting parameters:
<Filename> string

Example: BB:GSM:SETT:STOR 'gsm_ 1'
stores the current GSM settings into file gsm 1.

Usage: Setting only

[:SOURce<hw>]:BB:GSM:SMODe <SMode>

The command selects the modulation signal for the mode Unframed (: BB : GSM: MODE
UNFR) . The modulation type and filter type are set in accordance with the selection.

The available simulation modes depend on the selected symbol rate:

e Normal Symbol Rate - GSM, EDGE (8PSK), 16QAM and 32QAM

e Higher Symbol Rate - HSR QPSK, HSR 16QAM and HSR 32QAM.

Note: "Higher Symbol Rate" Mode and "Simulation Modes" 16QAM, 32QAM, HSR

QPSK, HSR 16QAM and HSR 32QAM are available for instruments equipped with option
R&S SMx/AMU-K41 only.
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Parameters:
<SMode> GSM|EDGE|N16Qam|N32Qam|HQPSk|H16Qam|H32Qam
*RST: GSM
Example: BB:GSM:MODE UNFR
sets unframed mode.
BB:GSM:SRAT:MODE HSR
selects higher symbol rate mode.
BB:GSM:SMOD H16Q
selects a HSR 16QAM modulation signal for the Unframed mode.
BB:GSM: SRAT :MODE NSR
selects normal symbol rate mode.
BB:GSM:SMOD GSM
selects a GSM modulation signal for the Unframed mode.
Options: N16Qam | N32Qam | HQPSk | H16Qam | H32Qam require R&S

SMx/AMU-K41

[:SOURce<hw>]:BB:GSM:SRATe <SRate>

The command sets the symbol clock. Possible units are Hz, kHz, MHz, Sym/s, kSym/s,

MSym/s.

Parameters:

<SRate> float
Range: 400 Hz to 25 MHz
Increment: 0.001 Hz
*RST: 270.833 kHz
Default unit: Hz

Example: BB:GSM:SRAT 270.9 kHz

sets the symbol clock to 270.9 kHz.

[:SOURce<hw>]:BB:GSM:SRATe:MODE <Mode>

Set the symbol rate mode, i.e. determines whether a normal bursts (NB) or higher symbol
rate bursts (HB) will be generated.

Parameters:
<Mode> NSRate|HSRate
*RST: NSRate
Example: BB:GSM:SRAT HSR
selects higher symbol rate mode
BB:GSM: SRAT?
queries the symbol clock.
Response: 325
Options: (for instruments equipped with option K41 only)
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[:SOURce<hw>]:BB:GSM:STATe <State>

The command switches on the modulation in accordance with the GSM standard. Any
other standards or digital modulation that may be in the ON state will be automatically
turned OFF (in case of two-path instruments, this affects the same path).

Parameters:
<State> 0]1|OFF|ON

*RST: OFF
Example: BB:GSM:STAT ON

switches GSM modulation on.

[:SOURce<hw>]:BB:GSM:WAVeform:CREate <Filename>
for R&S WinlQSIM2 only

This command creates a waveform using the current settings of the GSM/EDGE menu.
The file name is entered with the command. The file is stored with the predefined file
extension * .wv. The file name and the directory it is stored in are user-definable.

Setting parameters:
<Filename> string

Example: MMEM:CDIR '<root>\user\waveform'

sets the default directory to <root>\user\waveform.
BB:GSM:WAV:CRE 'gsm 1'
creates the waveform file gsm.wv in the default directory.

Usage: Setting only

4.2 Save Recall Frame/Slots

FRAMe<di>

Valuerange [1] |2
SLOT<st0>

Valuerange 0| [1] .. 7
USER<ch>

Value range [1] ]2

[:SOURce<hw>]:BB:GSM:FRAMe<di>:ULISt:CATAlOg......ceturriereeeriniieeeeeeiiee e e e e eeae e e e eeeenanes 64
[:SOURce<hw>]:BB:GSM:FRAMe<di>:ULISt:DELEt.......ccevrrueeieeeiieenineieeeeeeeeeineae e e eeeeeeennas 64
[:SOURce<hw>]:BB:GSM:FRAMe<di>:ULISt:LOAD......c.iitiiiiiiieeeceeie et eeaas 64
[:SOURce<hw>]:BB:GSM:FRAMEe<di>:ULISt:STORE.......ccettueeeiiiiieeeitieeeeeeee et e e enaens 65
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:PREDEAINEA: CATAIOG ... ereeeererereeeerererererereseresees 65
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:PREDefined:LOAD.......ccccttiiiiiiiiiiieneneeeeee e 65
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[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:PREDefined:CATalog......... 66
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:PREDefined:LOAD............. 66
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:ULISt:CATalog.................. 66
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:ULISt:DELete.................... 67
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:ULISt:LOAD........c...ceuv...... 67
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:ULISt:STORe.................... 68

[:SOURce<hw>]:BB:GSM:FRAMe<di>:ULISt:CATalog?

This command reads out the files with user defined frame settings in the default directory.
The default directory is set using command MMEM: CDIRectory. Only files with the file
extension *.gsm_fu and *.gsm_hfu will be listed.

Return values:
<Catalog> string

Example: MMEM:CDIR '<root>\user\frames'
sets the default directory to <root>\user\frames.
BB:GSM:FRAM:ULIS:CAT?
reads out all the files with user defined frame settings in the default
directory.
Response: 'NB all'
the file NB_all with a user defined frame setting is available.

Usage: Query only

[:SOURce<hw>]:BB:GSM:FRAMe<di>:ULISt:DELete <Filename>

This command deletes the selected file with user defined frame settings. The directory
is set using command MMEM: CDIRectory. A path can also be specified, in which case
the files in the specified directory are read. The file extension may be omitted. Only files
with the file extension *.gsm_fu and *.gsm_hfu will be deleted.

Setting parameters:
<Filename> string

Example: BB:GSM:FRAM:ULIS:DEL 'NB all’
deletes file NB_all.

Usage: Setting only

[:SOURce<hw>]:BB:GSM:FRAMe<di>:ULISt:LOAD <Filename>

This command loads the selected file with user defined frame settings. The directory is
set using command MMEM: CDIRectory. A path can also be specified, in which case the
files in the specified directory are read. The file extension may be omitted. Only files with
the file extension *.gsm_fu and *.gsm_hfu will be loaded.
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Setting parameters:
<Filename> string

Example: BB:GSM:FRAM:ULIS:LOAD 'NB all’
loads file NB_all.

Usage: Setting only

[:SOURce<hw>]:BB:GSM:FRAMe<di>:ULISt:STORe <Filename>

This command stores the current frame settings into the selected file. The directory is set
using command MMEM: CDIRectory. A path can also be specified, in which case the
files in the specified directory are read. Only the file name has to be entered. User Stand-
ards are stored as files with the specific file extensions *.gsm_fu and *.gsm_hfu.

Setting parameters:
<Filename> string

Example: BB:GSM:FRAM:ULIS:STOR 'EDGE all'
stores the current frame settings into file EDGE_all.

Usage: Setting only

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:PREDefined:CATalog?

This command reads out the files with predefined frame settings. The directory is preset,
therefore a path cannot be specified.

Return values:
<Catalog> string

Example: BB:GSM:FRAM: PRED:CAT?
reads out all the files with predefined frame settings.
Response: 'Edge(O, EdgeAll, GsmEdge,
NormalBurst0, NormalBurstAll'
the file names of the files with the predefined frame settings are
returned

Usage: Query only

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:PREDefined:LOAD <Filename>

This command loads the selected file with predefined frame settings. The directory is pre-
set, therefore a path cannot be specified.

Setting parameters:
<Filename> string
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Example: BB:GSM:MODE SING

selects GSM mode Frame (Single).
BB:GSM:SRAT:MODE NSR

selects normal symbol rate.

BB:GSM:FRAM: PRED:LOAD 'EdgeO'

loads file Edge0 with the predefined frame setting Edge Burst in
Slot 0.

Usage: Setting only

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:PREDefined:
CATalog?

This command reads out the files with predefined slot settings. The directory is preset,
therefore a path cannot be specified.

The numeric suffixes in all key words are irrelevant for this command.

Return values:
<Catalog> string

Example: BB:GSM:SLOT:PRED:CAT?

reads out all the files with predefined frame settings.
Response: GSM NB PNS TSCO,EDGE NB PN9 TSCO

the files GSM_NB_ PN9 TSCO and EDGE_NB_PN9 TSCO are avail-
able.

Usage: Query only

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:PREDefined:
LOAD <Filename>

This command loads the selected file with predefined slot settings. The directory is pre-
set, therefore a path cannot be specified.

Setting parameters:
<Filename> string

Example: BB:GSM:SLOT:PRED:LOAD 'GSM _NB_PN9 TSCO'
loads the settings of file GSM_NB PN9 TSCO for slot 1 in frame 1.

Usage: Setting only

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:ULISt:CATalog?

This command reads out the files with user defined slot settings in the default directory.
The default directory is set using command MMEM: CDIRectory. Only files with the file
extension *.gsm_sluand *.gsm hslu will be listed.

|
Operating Manual 1171.5254.12 — 10 66



GSM/EDGE Remote-Control Commands

|
Save Recall Frame/Slots

Return values:
<Catalog> string

Example: MMEM:CDIR '<root>\user\slots

sets the default directory to <root>\user\slots.
BB:GSM:SLOT:ULIS:CAT?

reads out all the files with user defined slot settings in the default

directory.
Response: 'test 01'

the file test 01 with a user defined slot setting is available.

Usage: Query only

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:ULISt:DELete
<Filename>

This command deletes the selected file with user defined slot settings. The directory is
set using command MMEM: CDIRectory. A path can also be specified, in which case the
files in the specified directory are read. The file extension may be omitted. Only files with
the file extension *.gsm sluand *.gsm hslu will be deleted.

Setting parameters:
<Filename> string

Example: BB:GSM:SLOT:ULIS:DEL 'NB'
deletes file NB.

Usage: Setting only

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:ULISt:LOAD
<Filename>

This command loads the selected file with user defined slot settings. The directory is set
using command MMEM: CDIRectory. A path can also be specified, in which case the
files in the specified directory are read. The file extension may be omitted. Only files with
the file extension * .gsm sluand *.gsm hslu will be loaded.

Setting parameters:

<Filename> string

Example: BB:GSM:SLOT:ULIS:LOAD 'NB'
loads file NB.

Usage: Setting only
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[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:ULISt:STORe
<Filename>

This command stores the current slot settings into the selected file. The directory is set
using command MMEM: CDIRectory. A path can also be specified, in which case the
files in the specified directory are read. Only the file name has to be entered. User slots
are stored as files with the specific file extensions *.gsm _sluand *.gsm hslu.

Setting parameters:
<Filename> string

Example: BB:GSM:SLOT:ULIS:STOR 'EDGE'
stores the current slot settings into file EDGE.

Usage: Setting only

Modulation/Filter Settings

Modulation Settings

[:SOURCce<hw>]:BB:GSM:FORMAL. ....c.cciiiiiiiiiiiei e e e e e e e e e 68
[:SOURce<hw>]:BB:GSM:EDGE:FORMaL.......cccciiiiiiiiieii e 68
[:SOURCce<hw>]:BB:GSM:FSK:DEViIation.......uuuuuuaaieeeeeeeeeeieeeeeieiinieeaaseeseeeeeeeeeeeeeeeennnnnnns 69
[:SOURce<hw>]:BB:GSM:H16Qam:FORMEL.........cccuuueeieieeeiieeiriiieeieeeeereeertenieeeeeeseeesssnnnns 69
[:SOURce<hw>]:BB:GSM:H32Qam:FORMaL........ccuueeeeerrereeeriiieeeeteieereaneeeeeeneeeseeneeesennanns 70
[:SOURce<hw>]:BB:GSM:HQPSK:FORMAL......ccevurueiiiiiiiiuieieeeeieiies e ee et e e ee e e e s eeenaes 70
[:SOURce<hw>]:BB:GSM:N16Qam:FORMEL. ......cciiiiiiiiieiiie e e e e 70
[:SOURce<hw>]:BB:GSM:N32Qam:FORMAEL. ......ccuiiiiiiieiiee e e e e e 71

[:SOURce<hw>]:BB:GSM:FORMat <Format>

The command selects the modulation type.

Parameters:
<Format> MSK|FSK2

*RST: MSK
Example: BB:GSM:FORM FSK2

selects the GSM modulation type FSK.

[:SOURce<hw>]:BB:GSM:EDGE:FORMat?

The command queries the modulation type in the case of EDGE. The modulation type is
permanently set to 8PSK.
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P8EDge

BB:GSM:EDGE: FORM?

queries the modulation type.
Response: "PBED"

Query only

[:SOURce<hw>]:BB:GSM:FSK:DEViation <Deviation>

The command sets the modulation deviation when : BB: GSM: FORMat FSK2 is selected.
The range of values depends on the symbol rate (: BB:GSM: SRATe) : 0.1 x fSymb ... 1.5
* fSymb (max. 10 MHZ).

The maximum deviation is 10 MHz.

Parameters:
<Deviation>

Example:

float

Range: 0.1xf(symb) to 1.5xf(symb);(10MHz)
*RST: 67.708 kHz
Default unit: Hz

BB:GSM:FORM FSK2

selects the GSM modulation type GFSK.
BB:GSM:FSK:DEV 37.6 kHz

sets the FSK deviation to 37.6 kHz.

[:SOURce<hw>]:BB:GSM:H16Qam:FORMat?

The command queries the modulation type.

Return values:
<Format>

Example:

Usage:
Options:

QAM16EDge
*RST: QAM16EDge

BB:GSM:SRAT:MODE HSR

selects higher symbol rate mode.
BB:GSM:H16Q:FORM?
queries the modulation type.

Response: "QAM16ED"
Query only

(for Higher Symbol Rate and instruments equipped with option
K41 only)
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[:SOURce<hw>]:BB:GSM:H32Qam:FORMat?

The command queries the modulation type.

Return values:

<Format> QAMB32EDge
*RST: QAM32EDge
Example: BB:GSM: SRAT:MODE HSR

selects higher symbol rate mode.
BB:GSM:H32Q: FORM?

queries the modulation type.

Response: QAM32ED

Usage: Query only

Options: (for Higher Symbol Rate and instruments equipped with option
K41 only)

[:SOURce<hw>]:BB:GSM:HQPSk:FORMat?

The command queries the modulation type.

Return values:

<Format> QEDGe
*RST: QEDGe
Example: BB:GSM:SRAT:MODE HSR

selects higher symbol rate mode.
BB:GSM:HQPS: FORM?
queries the modulation type.

Response: QQODG

Usage: Query only

Options: (for Higher Symbol Rate and instruments equipped with option
K41 only)

[:SOURce<hw>]:BB:GSM:N16Qam:FORMat?

The command queries the modulation type.

Return values:
<Format> QAM16EDge

*RST: QAM16EDge
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Example: BB:GSM:SRAT:MODE NSR

selects normal symbol rate mode.
BB:GSM:N16Q:FORM?
queries the modulation type.

Response: QAM16ED
Usage: Query only
Options: (for instruments equipped with option K41 only)

[:SOURce<hw>]:BB:GSM:N32Qam:FORMat?

The command queries the modulation type.

Return values:

<Format> QAM32EDge
*RST: QAM32EDge
Example: BB:GSM: SRAT:MODE NSR

selects normal symbol rate mode.
BB:GSM:N32Q:FORM?
queries the modulation type.

Response: QAM32ED
Usage: Query only
Options: (for instruments equipped with option K41 only)
Filter Settings
[:SOURCe<hw>]:BB:GSM:FILTErRTYPE.... it r e e e e eeen e 71
[}SOURCe<hw>]:BB:GSM:FILTEr:PARGMEIE......cuvuueieeieeeeeeieeitiieeeeeeeeeeeeerrireeeeeeeeeseeesesaanns 72
[:SOURCce<hw>]:BB:GSM:FILTEr:OSAMPING....ciietierieeeeiiiteeeeeeeeteeeeeeerneeeeeerete e eeeerenaaanns 72
[:SOURce<hw>]:BB:GSM:FILTer:OSAMPING:AUTO.....ciuiiieiieieeeee et ee e e 72
[:SOURce<hw>]:BB:GSM:FILTEr:EDGE:TYPE.... .ot et 73
[:SOURce<hw>]:BB:GSM:FILTer:N16Qam:TYPE........o i 73
[:SOURce<hw>]:BB:GSM:FILTer:N32Qam:TYPE.......oo e eee e 73
[:SOURce<hw>]:BB:GSM:FILTer:H16Qam:TYPE. ... ..o e e 73
[:SOURce<hw>]:BB:GSM:FILTer:-H32Qam:TYPE......cccccietiiiiuieieeeetnce e eeeeree e e e eete e e e eernans 74
[:SOURCce<hw>]:BB:GSM:FILTErHQPSK:TYPE.....ciitiitiriiieietie i eeiins e eeeais s e eesan s s eeannns 74

[:SOURce<hw>]:BB:GSM:FILTer:TYPE?

The command sets the filter type GAUSSs. This is the only possible selection in the case
of digital standard GSM.

Return values:
<Type> GAUSs

*RST: GAUSs
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Example: BB:GSM:FILT:TYPE GAUS
sets the filter type GAUSS.

Usage: Query only

[:SOURce<hw>]:BB:GSM:FILTer:PARameter <Parameter>

The command sets the filter parameter. For Gaussian filter the BxT is the product of the
bandwidth and the symbol duration. The default value for GSM modulation is 0.3 and for
Gauss Linearized (EDGE), BT = 0.3.

Parameters:
<Parameter> float
Range: 0.15 to 2.5
Increment: 0.01
*RST: 0.3
Example: BB:GSM:FILT:PAR 0.4

sets the BT value to 0.4.

[:SOURce<hw>]:BB:GSM:FILTer:0SAMpling <OSampling>

The command sets the upsampling factor.

Parameters:
<OSampling> integer
Range: 1 to 32
*RST: 32
Example: BB:GSM:FILT:0SAM 32

sets the upsampling factor to 32.

[:SOURce<hw>]:BB:GSM:FILTer:OSAMpling:AUTO <Auto>

The command activates/deactivates the upsampling factor state. If activated, the most
sensible parameter values are selected. The value depends on the coherence check. If
deactivated, the values can be changed manually.

Parameters:
<Auto> 0]1|OFF|ON
*RST: ON
Example: BB:GSM:FILT:0SAM:AUTO ON

the most sensible parameters are selected automatically.
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[:SOURce<hw>]:BB:GSM:FILTer:EDGE:TYPE?

The command sets the filter type LGAuss. This is the only possible selection in the case
of digital standard GSM EDGE.

Return values:
<Type> LGAuss

Example: BB:GSM:FILT:EDGE:TYPE LGA
sets the filter type Gauss linearized.

Usage: Query only

[:SOURce<hw>]:BB:GSM:FILTer:N16Qam:TYPE?

Queries filter for 16QAM signal. The filter is permanently set to GAUSS linearized.

Return values:
<Type> LGAuss

Example: BB:GSM:FILT:N16Q:TYPE?

queries the filter type.
Response: LGA

Usage: Query only
Options: K41

[:SOURce<hw>]:BB:GSM:FILTer:N32Qam:TYPE?

Queries filter for 32QAM signal. The filter is permanently set to GAUSS linearized.

Return values:
<Type> LGAuss

Example: BB:GSM:FILT:N32Q:TYPE?
queries the filter type.
Response: LGA

Usage: Query only
Options: K41

[:SOURce<hw>]:BB:GSM:FILTer:H16Qam:TYPE <Type>
Sets the filter for HSR 16QAM signal.

Parameters:
<Type> ENPShape|EWPShape

*RST: ENPShape
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Example: BB:GSM:FILT:H16Q:TYPE ENPS

[:SOURce<hw>]:BB:GSM:FILTer:H32Qam:TYPE <Type>
Sets the filter for HSR 32QAM signal.

Parameters:
<Type> ENPShape|EWPShape
*RST: ENPShape
Example: BB:GSM:FILT:H32Q:TYPE ENPS

[:SOURce<hw>]:BB:GSM:FILTer:HQPSk:TYPE <Type>
Sets the filter for HSR QPSK signal.

Parameters:
<Type> ENPShape|EWPShape
*RST: ENPShape
Example: BB:GSM:FILT:HQPS:TYPE ENPS

4.4 Clock Settings

This section lists the remote control commands, necessary to configure the clock.

@ The clock settings are available for R&S SMx and R&S AMU instruments only.

[:SOURce<hw>]:BB:GSM:CLOCK:MODE........ceieiiiieeeei et et e e e enaae 74
[:SOURce<hw>]:BB:GSM:CLOCK:MULTIPHET.....cuieieeeee ettt 75
[:SOURce<hw>]:BB:GSM:CLOCK:DIVIAEN. ... .ttt ettt e e e 75
[:SOURce<hw>]:BB:GSM:CLOCK:SOURCE. ... . ieieeeeeieeiieiiniaaaaeeeeeeeeeeeaennaaaaaeeeeeeeeeeeennnnanns 76
[:SOURce<hw>]:BB:GSM:CLOCKk:SYNChronization:EXECUE......cc.cvvevuirieiiiieiiieeeeeeeieeeeeaae 76
[:SOURce<hw>]:BB:GSM:CLOCk:SYNChronization:MODE..........ccccecevrrruueeieeereeinniieeeeeeeennns 77

[:SOURce<hw>]:BB:GSM:CLOCk:MODE <Mode>

The command enters the type of externally supplied clock (: BB:GSM:CLOCk: SOURce
EXT).

When MSYMbol is used, a multiple of the symbol clock is supplied via the CLOCK con-
nector and the symbol clock is derived internally from this. The multiplier is entered with
the command :BB:GSM:CLOCk:MULTiplier.
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When FSYMbol is used, a fraction of the symbol clock is supplied via the CLOCK con-

nector and the symbol clock is derived internally from this. The divisor is entered with the
command :BB:GSM:CLOCk:DIVider. This selection is only possible for external sig-

nals with a clock rate of at least 200 Hz.

For two-path instruments, the only numerical suffix allowed for SOURCce is 1, since the
external clock source is permanently allocated to path A.

Parameters:

<Mode> SYMBol|MSYMbol | BIT[FSYMbol
*RST: SYMBol

Example: BB:GSM:CLOC:MODE SYMB
selects clock type "Symbols", i.e. the supplied clock is a symbol
clock.

[:SOURce<hw>]:BB:GSM:CLOCk:MULTiplier <Multiplier>

The command specifies the multiplier for clock type "Multiple Symbols"
(:BB:GSM:CLOCk : MODE MSYM) in the case of an external clock source.

For two-path instruments, the only numerical suffix allowed for SOURCce is 1, since the
external clock source is permanently allocated to path A.

Parameters:
<Multiplier> integer
Range: 1 to 64
Increment: 1
*RST: 4
Example: BB:GSM:CLOC:SOUR EXT
selects the external clock source. The clock is supplied via the
CLOCK connector.

BB:GSM:CLOC:MODE MSYM

selects clock type "Multiple Symbols", i.e. the supplied clock has
a rate which is a multiple of the symbol rate.
BB:GSM:CLOC:MULT 12

the multiplier for the external clock rate is 12.

[:SOURce<hw>]:BB:GSM:CLOCk:DIVider <Divider>

The command specifies the divider for clock type "Fractional Symbols"
(:BB:GSM:CLOCk :MODE FSYM) in the case of an external clock source.

For two-path instruments, the only numerical suffix allowed for SOURCce is 1, since the
external clock source is permanently allocated to path A.

|
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Parameters:
<Divider>

Example:

Clock Settings

float

Range: 1 to 65536
Increment: 1
*RST: 4

BB:GSM:CLOC:SOUR EXT

selects the external clock source. The clock is supplied via the
CLOCK connector.

BB:GSM:CLOC:MODE FSYM

selects clock type "Fractional Symbols", i.e. the supplied clock has
a rate which is a fraction of the symbol rate.
BB:GSM:CLOC:DIV 2

the divider for the external clock rate is 2.

[:SOURce<hw>]:BB:GSM:CLOCk:SOURce <Source>

The command selects the clock source.

For two-path instruments, selecting EXTernal is only possible for path A, since the exter-
nal clock source is permanently allocated to path A; selecting AINternal is only possible

for path B.

Parameters:
<Source>

Example:

INTernal|EXTernal|AINTernal

INTernal
The internal clock reference is used.

EXTernal
The external clock reference is supplied to the CLOCK connector.

*RST: INTernal

BB:GSM:CLOC:SOUR EXT
selects an external clock reference. The clock is supplied via the

CLOCK connector.
BB:GSM:CLOC :MODE SYMB

specifies that a symbol clock is supplied via the CLOCK connector.

[:SOURce<hw>]:BB:GSM:CLOCk:SYNChronization:EXECute

Performs automatically adjustment of the instrument's settings required for the synchro-
nization mode, set with the command BB : GSM: CLOC : SYNC : MODE.

Example:

Usage:

BB:GSM:CLOC:SYNC:MODE MAST

the instrument is configured to work as a master one.
BB:GSM:CLOC:SYNC:EXEC
all synchronizations settings are adjusted accordingly.

Event
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[:SOURce<hw>]:BB:GSM:CLOCk:SYNChronization:MODE <Mode>
Selects the synchronization mode.

This parameter is used to enable generation of very precise synchronous signal of several
connected R&S SMBVs.

Note:

If several instruments are connected, the connecting cables from the master instrument
to the slave one and between each two consecutive slave instruments must have the
same length and type.

Avoid unnecessary cable length and branching points.

Parameters:
<Mode> NONE|MASTer|SLAVe
NONE
The instrument is working in stand-alone mode.
MASTer
The instrument provides all connected instrument with its
synchronisation clock (including the trigger signal) and its
reference clock signal.
SLAVe
The instrument receives the synchronisation and reference clock
signal from another instrument working in a master mode.
*RST: NONE
Example: BB:GSM:CLOC: SYNC:MODE MAST
the instrument is configured to work as a master one.
Trigger Settings

The trigger settings are available for R&S SMx and R&S AMU instruments only.

EXTernal<ch>

The numeric suffix to EXTernal<ch> distinguishes between the external trigger via the
TRIGGER 1 (suffix 1) and TRIGGER 2 (suffix 2) connector.

[:SOURce<hw>]:BB:GSM[:TRIGQEr]:SEQUENCE...........cevverrrrrrurerieieieseeseeeeeeeseeeeeeesesssrannnnan 78
[:SOURce<hw>]:BB:GSM:TRIGGErARM:EXECULE........ceieeiiriieeeeiieieieeeeerie e e et e e e eerananns 78
[:SOURce<hw>]:BB:GSM:TRIGQENEXECULE......cuiieiieiiiiiiiii et 79
[:SOURce<hw>]:BB:GSM:TRIGger:EXTernal:SYNChronize:OUTPUL..........cccoeimiriniiiiiieiiaennns 79
[:SOURce<hw>]:BB:GSM:TRIGger:OBASeband:DELay.........ccoeuiiiiiiiiiiiiiii e 80
[:SOURce<hw>]:BB:GSM:TRIGger:OBASeband:INHIbit..........ccceuruerireieiiniieireeeeecce e 80
[:SOURce<hw>]:BB:GSM:TRIGGEINRMODE..........cceeererenaiieeeeeeeeeninaaeeeeereeeeanneeeeseeeeeeennnnns 81

|
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[:SOURce<hw>]:BB:GSM:TRIGGEIrSLENGth. ....uuciiieieieieieiiiiceee e e e e e 81
[:SOURCe<hw>]:BB:GSM:TRIGQEMNSLUNIL......cevureieeiiiiieeeeeeiie e e et e e e et e e e e e e e e e eeranees 82
[:SOURCe<hw>]:BB:GSM:TRIGQEINSOURGCE........cvtueieeiiteeeeerieeeeetaieerranaeeeeennaeesentaeeesesnanns 82
[:SOURce<hw>]:BB:GSM:TRIGger[:EXTernal<Ch>]:DELaY......cccceturimiiiiiiieeieeiieeeeeeeeeeeaas 83
[:SOURce<hw>]:BB:GSM:TRIGger[:EXTernal<ch>]:INHibit..........ccoouiiiiiiiieas 84

[:SOURce<hw>]:BB:GSM[:TRIGger]:SEQuence <Sequence>

The command selects the trigger mode.

Parameters:

<Sequence> AUTO|RETRIigger|[AAUTo|ARETrigger|SINGle
AUTO
The frames are generated continuously.
RETRigger
The frames are generated continuously. A trigger event (internal
or external) causes a restart.
AAUTo
The frames are generated only when a trigger event occurs. After
the trigger event the signal is generated continuously. Signal
generation is stopped with command
SOUR:BB:GSM: TRIG:ARM:EXEC and started again when a
trigger event occurs.
ARETrigger
The frames are generated only when a trigger event occurs. The
device automatically toggles to RETRIG mode. Every subsequent
trigger event causes a restart. Signal generation is stopped with
command SOUR:BB:GSM: TRIG:ARM: EXEC and started again
when a trigger event occurs.
SINGle
The signal is generated only when a trigger event occurs. After the
trigger event the signal is generated once to the set sequence
length (SOUR:BB:GSM: TRIG: SLEN). Every subsequent trigger
event causes a restart.
*RST: AUTO

Example: BB:GSM:SEQ AAUT

sets the "Armed_auto" trigger mode; the device waits for the first
trigger (e.g. with *TRG) and then generates the frames continu-
ously.

[:SOURce<hw>]:BB:GSM:TRIGger:ARM:EXECute

The command stops signal generation for trigger modes Armed_Auto and Armed_Ret-
rigger. A subsequent internal or external trigger event restarts signal generation.
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Example:

Usage:

Trigger Settings

BB:GSM:TRIG:SOUR INT

sets internal triggering.
BB:GSM:TRIG:SEQ ARET

sets Armed_Retrigger mode, i.e. every trigger event causes signal
generation to restart.
BB:GSM:TRIG:EXEC

executes a trigger, signal generation is started.
BB:GSM: TRIG:ARM:EXEC

signal generation is stopped.
BB:GSM:TRIG:EXEC

executes a trigger, signal generation is started again.

Event

[:SOURce<hw>]:BB:GSM:TRIGger:EXECute

The command executes a trigger. The internal trigger source must be selected using the
command :BB:GSM: TRIGger:SOURce INTernal and a trigger mode other than
AUTO must be selected using the command :BB:GSM: SEQ.

Example:

Usage:

BB:GSM: TRIG:SOUR INT

sets internal triggering.

BB:GSM:SEQ RETR

sets Retrigger mode, i.e. every trigger event causes signal gen-
eration to restart.

BB:GSM: TRIG:EXEC

executes a trigger.

Event

[:SOURce<hw>]:BB:GSM:TRIGger:EXTernal:SYNChronize:OUTPut <Output>

(enabled for "Trigger Source" External)

Enables/disables output of the signal synchronous to the external trigger event.

For R&S SMBYV instruments:

See also "Sync. Output to External Trigger" on page 33for a detailed description of the
applications of this setting.
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Parameters:
<Output>

Example:

Trigger Settings

0|1|OFF|ON

ON

The signal calculation starts simultaneously with the external
trigger event but because of the instrument's processing time the
first samples are cut off and no signal is outputted. After elapsing
of the internal processing time, the output signal is synchronous
to the trigger event.

OFF

The signal output begins after elapsing of the processing time and
starts with sample 0, i.e. the complete signal is outputted.

This mode is recommended for triggering of short signal
sequences with signal duration comparable with the processing
time of the instrument.

*RST: ON

BB:GSM:TRIG:SOUR EXT

sets external triggering.
BB:GSM:TRIG:EXT:SYNC:0UTP ON

enables synchrounous output to external trigger

[:SOURce<hw>]:BB:GSM:TRIGger:OBASeband:DELay <Delay>

The command specifies the trigger delay (expressed as a number of symbols) for trig-
gering by the signal from the second path.

Parameters:
<Delay>

Example:

float

Range: 0 Symbols to 2232-1 Symbols

Increment: 1 symbol for CLOCk:SOURce EXT 0.01; symbols for
CLOCk:SOURce INT

*RST: 0 Symbols

BB:GSM:TRIG:SOUR OBAS

sets for path A the internal trigger executed by the signal from the
second path (path B).

BB:GSM:TRIG:0BAS:DEL 200

sets a delay of 200 symbols for the trigger.

[:SOURce<hw>]:BB:GSM:TRIGger:OBASeband:INHibit <Inhibit>

The command specifies the number of symbols by which a restart is to be inhibited fol-
lowing a trigger event. This command applies only for triggering by the second path.
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Parameters:
<Inhibit>

Example:

Trigger Settings

integer

Range: 0 Symbols to 232-1 (67 108 863) Symbols
Increment: 1 Symbol
*RST: 0 Symbols

BB:GSM:TRIG:SOUR OBAS
sets for path A the internal trigger executed by the signal from the

second path (path B).
BB:GSM:TRIG:0BAS:INH 200

sets a restart inhibit for 200 symbols following a trigger event.

[:SOURce<hw>]:BB:GSM:TRIGger:RMODe?

The command queries the status of frame generation for all trigger modes with GSM/

EDGE modulation on.

Return values:
<RMode>

Example:

Usage:

STOP|RUN

RUN
the GSM/EDGE signal is generated. A trigger event occurred in
the triggered mode.

STOP

the GSM/EDGE signal is not generated. A trigger event did not
occur in the triggered modes, or signal generation was stopped by
the command :BB:GSM: TRIG:ARM: EXECute (armed trigger
modes only).

BB:GSM:TRIG:SOUR EXT

sets external triggering via the TRIGGER 1 connector.
BB:GSM: TRIG:MODE ARET

selects the Armed_Retrigger mode.
BB:GSM: TRIG:RMOD?

queries the status of frame generation.
Response: RUN

the frame is generated, an external trigger was executed.

Query only

[:SOURce<hw>]:BB:GSM:TRIGger:SLENgth <SLength>

The command defines the length of the signal sequence to be outputin the "Single" trigger
mode. The unit is defined with command SOUR:BB:GSM: TRIG: SLUNit. It is possible
to output deliberately just part of a frame, an exact sequence of a frame, or a defined
number of repetitions of a frame.
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Parameters:

<SLength> integer
Range: 1 Symbol to 2432-1 Symbols
*RST: 1 Symbol

Example: BB:GSM:SEQ SING

sets trigger mode Single.
BB:GSM:TRIG:SLUN SYMB

sets unit symbol for the entry of signal duration.
BB:GSM:TRIG:SLEN 200

sets signal duration of 200 symbols. 200 symbols will be output
after the next trigger event.

[:SOURce<hw>]:BB:GSM:TRIGger:SLUNit <SLunit>

The command defines the unit for the entry of the length of the signal sequence
(SOUR:BB:GSM: TRIG: SLEN) to be output in the "Single" trigger mode
(SOUR:BB:GSM:SEQ SING).

Parameters:

<SLunit> FRAMe|SYMBol
*RST: FRAMe

Example: BB:GSM:SEQ SING

sets trigger mode Single.

BB:GSM: TRIG:SLUN FRAM

sets unit frame for the entry of signal duration.
BB:GSM:TRIG:SLEN 2

sets signal duration of 2 frames. The current frame will be output
twice after the next trigger event.

[:SOURce<hw>]:BB:GSM:TRIGger:SOURce <Source>

The command selects the trigger source.

|
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Parameters:
<Source>

Example:

Trigger Settings

INTernal|[EXTernal| BEXTernal|OBASeband|ECLock

INTernal

Triggering is executed by means of the Trigger command in the
case of remote control, and by means of "Execute Trigger" in the
case of manual operation.

EXTernal
Triggering is executed by means of the signal on the TRIGGER 1
connector.

BEXTernal

Triggering is executed by means of the signal on the TRIGGER 2
connector.

OBASeband

Triggering is executed by means of the signal from the second
path (two-path instruments only).

ECLock

Triggering is executed by means of the signal on the CLOCK
connector. This signal is also used as clock. The selection is only
available if external clock source (: BB:GSM: CLOC: SOUR EXT)is
selected. In case of two-path instruments, the selection is only
available for baseband path A.

*RST: INTernal

BB:GSM:TRIG:SOUR INT
sets internal triggering.

[:SOURce<hw>]:BB:GSM:TRIGger[:EXTernal<ch>]:DELay <Delay>

The command specifies the trigger delay (expressed as a number of symbols) for external
triggering. The numeric suffix to EXTernal distinguishes between the external trigger via
the TRIGGER 1 (suffix 1) and TRIGGER 2 (suffix 2) connector.

Parameters:
<Delay>

Example:

float

Range: 0 Symbols to 2%16-1 Symbols

Increment: 1 symbol for CLOCk:SOURce EXT; 0.01 symbols for
CLOCk:SOURce INT

*RST: 0 Symbols

BB:GSM:TRIG:SOUR EXT

selects an external trigger via the TRIGGER 1 connector.
BB:GSM:TRIG:DEL 200

sets a delay of 200 symbols for the trigger.
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[:SOURce<hw>]:BB:GSM:TRIGger[:EXTernal<ch>]:INHibit <Inhibit>

The command specifies the number of symbols by which a restart is to be inhibited fol-
lowing a trigger event. This command applies only in the case of external triggering. The
numeric suffix to EXTernal distinguishes between the external trigger via the TRIGGER
1 (suffix 1) and TRIGGER 2 (suffix 2) connector.

Parameters:
<Inhibit> integer
Range: 0 symbols to 2726-1 Symbols
Increment: 1 Symbol
*RST: 0 Symbols
Example: BB:GSM:TRIG:SOUR EXT
selects an external trigger via the TRIGGER 1 connector.
BB:GSM:TRIG:INH 200
sets a restart inhibit for 200 symbols following a trigger event.
Marker Settings

This section lists the remote control commands, necessary to configure the markers.

The marker delay settings are available for R&S SMx and R&S AMU instruments only.

[:SOURce<hw>]:BB:GSM:TRIGger:OUTPuUt:DELay:FIXed......cccuiimieiiiiiiiiieeiii e 84
[:SOURce<hw>]:BB:GSM:TRIGger:OUTPUt<Ch>:DELAY.....c.cctereuiieinieieiereeee e e eeene 85
[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:DELay:MAXIMUM.......ccceuirermrirenrerineeennnas 85
[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:DELay:MINiMUuM.........cccuuruceierrrreeerrennnnnnnns 86
[:SOURce<hw>]:BB:GSM:TRIGger:OUTPUt<Ch>:MODE........cccoeeeeeireiieeeeeeiieeeeeeeeereeeeeeeenes 86
[:SOURce<hw>]:BB:GSM:TRIGger:OUTPUt<Ch>:ONTIMe....c.cieuiimiiiiaiiiee e 87
[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:0OFFTime....cccccuiiiiiiiiiiiiiii e 87
[:SOURce<hw>]:BB:GSM:TRIGger:OUTPUt<Ch>:PATTEIMN.....ccceeieieeieieeeeeice et eee e eenens 88
[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:PERIOA:SLOT.....ccetiieereerierineie e e e eeeeeeeennes 88
[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:PERIOA[:FRAME].........cceeerrrccrnrrrrrreneneeenns 88
[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:PULSE:DIVIder.........ccevvvuierrrrrerrnieeeeeennnnns 89
[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:PULSE[:FREQUENCY].....rvrvrerererereeererererenen. 89

[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut:DELay:FIXed <Fixed>

The command restricts the marker delay setting range to the dynamic range. In this range
the delay can be set without restarting the marker and signal. If a delay is entered in
setting ON but is outside this range, the maximum possible delay is set and an error
message is generated.

The numeric suffix in OUTPut has no significance for this command, since the setting
always affects every marker.

|
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Parameters:
<Fixed> 0|1|OFF|ON
*RST: OFF
Example: BB:GSM:TRIG:OUTP:DEL:FIX ON
restricts the marker signal delay setting range to the dynamic
range.

[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:DELay <Delay>

The command defines the delay between the signal on the marker outputs and the start
of the frame/slot, expressed in terms of symbols.

Command :BB:GSM: TRIGger :OUTPut:DELay:FIXed can be used to restrict the
range of values to the dynamic range, i.e. the range within which a delay of the marker
signals can be set without restarting the marker and signal.

Parameters:
<Delay> float
Range: 0 Symbols to 2424-1 Symbols
Increment: 1 Symbol
*RST: 0 Symbols
Example: BB:GSM:TRIG:0UTP2:DEL 16
sets a delay of 16 symbols for the signal on connector MARKER
2.

[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:DELay:MAXimum?

The command queries the maximum marker delay for set-
ting :BB:GSM: TRIGger :OUTPut : DELay:FIXed ON.

Return values:

<Maximum> float

Example: BB:GSM:TRIG:OUTP:DEL:FIX ON
restricts the marker signal delay setting range to the dynamic
range.

BB:GSM:TRIG:0UTP:DEL:MAX

queries the maximum of the dynamic range.
Response: '2000'
the maximum for the marker delay setting is 2000 symbols.

Usage: Query only

|
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[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:DELay:MINimum?

The command queries the minimum marker delay for set-
ting :BB:GSM: TRIGger:OUTPut:DELay:FIXed ON.

Return values:

<Minimum> float

Example: BB:GSM:TRIG:OUTP:DEL:FIX ON
restricts the marker signal delay setting range to the dynamic
range.

BB:GSM:TRIG:OUTP:DEL:MIN

queries the minimum of the dynamic range.
Response: '0'

the minimum for the marker delay setting is 0 symbols.

Usage: Query only

[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:MODE <Mode>

The command defines the signal for the selected marker output.

|
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Parameters:
<Mode>

Example:

Marker Settings

SDEF|FRAMe|SLOT|PULSe|PATTern|RATio|TRIGger

As defined in slots
The marker defined in the burst editor is used.

SLOT

A slot clock with the slot period specified using command
SOUR:BB:GSM: TRIG:0UTP:PER:SLOT is generated on the
output connector. The marker signal is generated after every
specified number of slots. It is important to be aware of the
variation in the GSM/EDGE slot length between 156 and 157
symbols. At a slot length of 156 symbols, a period of 1 symbol and
a symbol rate of 270.833 ksymb/s the clock is 0.577 ms, and at
157 symbols it is 0.580 ms.

FRAMe

A frame clock with the frame period specified using command
SOUR:BB:GSM:TRIG:OUTP:PER:FRAM is generated on the
output connector. The marker signal is generated after every
specified number of frames. A GSM/EDGE frame has 1250
symbols. At a symbol rate of 270.833 ksymb/s and a period of 1
the clock is 4.615 ms.

PULSe
A pulsed marker signal is generated. The pulse frequency

PATTern

A marker signal is generated with the aid of a user-definable bit
pattern. The bit pattern is entered with the aid of command
SOURce :BB:GSM: TRIGg:0UTP: PATT. The bit pattern is a
maximum of 32 bits long.

RATio

A regular marker signal corresponding to the Time Off / Time On
specifications in the commands

SOUR:BB:GSM: TRIGge:OUTP:OFFT and
SOUR:BB:GSM:TRIGg:0UTP:ONT is generated.

*RST: FRAMe

BB:GSM: TRIG:0UTP2:MODE PULS
selects the pulsed marker signal on output MARKER 2.

[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:ONTime <OnTime>
[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:0OFFTime <OffTime>

The command sets the number of symbols in a period (ON time + OFF time) during which
the marker signal in setting SOURce : BB: GSM: TRIGger : OUTPut : MODE RATio on the
marker outputs is OFF.
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Parameters:

<OffTime> integer
Range: 1 Symbol to 2424-1 Symbols
Increment: 1 Symbol
*RST: 1 Symbol

Example: BB:GSM:TRIG:OUTP2:0FFT 20

sets an OFF time of 20 symbols for marker signal 2.

[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:PATTern <Pattern>

The command defines the bit pattern used to generate the marker signal in the setting
SOURce :BB:GSM: TRIGger:0UTPut :MODE PATTern O is marker off, 1 is marker on.
The pattern has a maximum length of 64 bits.

Parameters:
<Pattern> integer
*RST: 0
Example: BB:GSM:TRIG:0UTP2:PATT #H81,8

sets a bit pattern.
BB:GSM: TRIG:OUTP2:MODE PATT

activates the marker signal according to a bit pattern on output
MARKER 2.

[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:PERiod:SLOT <Slot>

The command sets the repetition rate for the slot clock at the marker outputs.

Parameters:

<Slot> integer
Range: 1 Slot to 2*26-1 Slots
Increment: 1 Slot
*RST: 1 Slot

Example: BB:GSM:TRIG:OUTP2:MODE SLOT

sets the slot clock for the signal on connector MARKER 2.
BB:GSM: TRIG:0UTP2:PER:SLOT 16

sets a period of 16 slots, i.e. the marker signal is repeated every
16th slot.

[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:PERiod[:FRAMe] <Frame>

The command sets the repetition rate for the frame clock at the marker outputs.

|
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Parameters:

<Frame> integer
Range: 1 Frame to 2"26-1 Frames
Increment: 1 Frame
*RST: 1 Frame

Example: BB:GSM:TRIG:0UTP2 :MODE FRAM

sets the frame clock for the signal on connector MARKER 2.
BB:GSM: TRIG:0OUTP2:PER 16

sets a period of 16 frames, i.e. the marker signal is repeated every
16th frame.

[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:PULSe:DIVider <Divider>

The command sets the divider for the pulsed marker signal in the setting
SOURce:BB:GSM: TRIGger: OUTPut : MODE PULSe. The pulse frequency is derived by
dividing the symbol rate by the divider.

Parameters:
<Divider> integer
Range: 2 to 2M0
Increment: 1
*RST: 2
Example: BB:GSM:TRIG:0UTP2:PULS:DIV 2
sets the divider for the marker signal on output MARKER 2 to the
value 2.

BB:GSM: TRIG:0UTP2:FREQ?

queries the resulting pulse frequency of the marker signal.
Response: 66 000

the resulting pulse frequency is 66 kHz.

[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:PULSe[:FREQuency]?

The command queries the pulse frequency of the pulsed marker signal in the setting
SOUR:BB:GSM:TRIG:0UTP:MODE PULS. The pulse frequency is derived by dividing
the symbol rate by the divider. The divider is defined with command
SOUR:BB:GSM:TRIG:OUTP:PULS:DIV.

Return values:
<Frequency> float
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4.7

Power Ramping/Slot Attenuation

Example: BB:GSM:TRIG:0UTP2:PULS:DIV 4
sets the divider for the marker signal on output MARKER 2 to the
value 4.
BB:GSM:TRIG:0UTP2:MODE PULS

enables the pulsed marker signal.
BB:GSM:TRIG:0UTP2:PULS:FREQ?

queries the resulting pulse frequency for the marker signal.
Response: 33 000

the resulting pulse frequency is 33 kHz.

Usage: Query only

Power Ramping/Slot Attenuation

[:SOURce<hw>]:BB:GSM:PRAMP:BBONIY[:STATE]......cctterrrrrrniieireeeeereeerrnrnaeeeeeeeeseeessnnanns 90
[:SOURCe<hw>]:BB:GSM:PRAMP:IFDELAY.......cciieiiitiiieeeieiiiieeeeeeiiiee e e eeeetee e e e eeet e e e e eeennnnnns 90
[:SOURCE<hW>]:BB:GSM:PRAMDIRDELAY ... veeeeeereseseesesesesesesesesessesessesesessesesessesesesens 91
[:SOURCce<hw>]:BB:GSM:PRAMP:SHAPE......cciiiiieee e e e e 91
[:SOURce<hw>]:BB:GSM:PRAMP:TIME.... e et e e e e e e e e e e e 91

[:SOURce<hw>]:BB:GSM:PRAMp:BBONIy[:STATe] <State>
Note: This command is available for instruments with RF output only.

This command selects power ramping in the baseband only or mixed power ramping in
the baseband and the RF section. The "ON" setting is mandatory if, with power ramping
active, only the baseband signal is output (I/Q outputs), or, in case of two-path instru-
ments, if a baseband signal is applied to two RF paths (RF A and RF B).

Only then can a signal with a defined, predictable level be output.

Parameters:
<State> 0]1|OFF|ON

*RST: OFF
Example: BB:GSM: PRAM: BBON ON

selects power ramping in the baseband only.

[:SOURce<hw>]:BB:GSM:PRAMp:FDELay <FDelay>

The command sets the offset in the Falling edge of the ramp envelope at the end of a
slot. A positive value gives rise to a ramp delay and a negative value advances the ramp.
The setting is expressed in symbols.
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Parameters:

<FDelay> float
Range: -9 Symbols to 9 Symbols
Increment: 1 Symbol
*RST: 0 Symbols

Example: BB:GSM:PRAM:FDEL -1

sets an advance of 1 symbol in the falling edge of the envelope at
the end of the slot.

[:SOURce<hw>]:BB:GSM:PRAMp:RDELay <RDelay>

The command sets the offset in the Rising edge of the ramp envelope at the start of a
slot. A positive value gives rise to a ramp delay and a negative value advances the ramp.
The setting is expressed in symbols.

Parameters:

<RDelay> float
Range: -9 Symbols to 9 Symbols
Increment: 1 Symbol
*RST: 0 Symbols

Example: BB:GSM:PRAM:RDEL -1

sets an advance of 1 symbol in the rising edge of the envelope at
the start of the slot.

[:SOURce<hw>]:BB:GSM:PRAMp:SHAPe <Shape>
The command sets the edge shape of the ramp envelope.

Parameters:
<Shape> LINear|COSine

LINear
The transmitted power rises and falls linear fashion.

COSine
The transmitted power rises and falls in the shape of a cosine.

*RST: COSine

Example: BB:GSM:PRAM: SHAP LIN
sets a cosine-shaped rise and fall to the edge.

[:SOURce<hw>]:BB:GSM:PRAMp:TIME <Time>

The command sets the edge slope of the ramp envelope. This specifies the number of
symbols over which the switching operation should be stretched when the transmitted
power is turned on and off.

|
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Parameters:

<Time> float
Range: 0.3 Symbols to 16.0 Symbols
Increment: 0.1 Symbols
*RST: 5.0 Symbols

Example: BB:GSM:PRAM:TIME 6

sets the duration of the switching operation to 6 symbols.

4.8 Burst Editor

FRAMe<di>

Value range [1] ]2
SLOT<st0>

Valuerange 0| [1] .. 7
USER<ch>

Value range [1] ]2

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<StO>:TYPE........ccetriieriiiriniene et 93
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:.LEVel......cccccverieieriirinrenn. 93
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:ATTenuation...................... 93
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:FILTer:-TYPE...........cc.c...... 94
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:MULTislot<st0>:COUNL........ccorriiiiiiiiiiiiiieeeeeens 94
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:MULTIislot<sSt0>:STATE......ctttuerrrrirerereeeereeianeennnas 95
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>][:SOURce]:DATA................ 95

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>][:SOURce]:DATA:DLISt....... 96
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>][:SOURCce]:DATA:

[ IS o 072N 1= 1o 97
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>][:SOURCce]:DATA:

NN I =Y o o N 97
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0O>[:USER<ch>]:SFLag......cc.eseevucrrrrrurrerennn. 97
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:SFLag:USE...........c.c.ceeru... 98
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>][:SOURce]: TSC:

] Yo SRR 98
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>][:SOURce]:TSC:USER........ 99
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0O>[:USER<Ch>]:ETSC.....c.cccevuerrrrererrnrernnn. 99
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:ETSC:USER..........c........... 99
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:SYNC:SELect.................. 100
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:SYNC:USER................... 100
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:FCORrection:FIXed.......... 101
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:FCORrection:FIXed:

A N =Y o D 101
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:DUMMy:MIXed:

AN I 1= o 101
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Burst Editor

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>:TYPE <Type>
The command selects the burst (slot) type.

The types All Data GSM (ADATa), All Data EDGE (AEDGe), All Data 16QAM (A1 6Qam),
All Data 32QAM (2320am), HSR All Data QPSK (HAQPsk), HSR All Data 16QAM
(HA160am) and HSR All Data 32QAM (HA32Qam) are not defined in the standard.

Note: "Higher Symbol Rate" Mode and higher order modulation schemes (16QAM and
32QAM) are available for instruments equipped with option R&S SMx/AMU-K41 only.

Parameters:

<Type> NORMal|HALF|EDGE|SYNC|FCORrection| DUMMy|ACCess|
ADATa|AEDGe|N16Qam|N32Qam|A16Qam|A32Qam|HQPSK|
H16Qam|H32Qam|HAQPsk|HA16Qam|HA32Qam
*RST: NORMal

Example: BB:GSM:SLOT:TYPE DUMM

selects DUMMY burst type for slot 1.

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:LEVel <Level>
The command defines the power control level of the selected slot.

Parameters:
<Level> OFF|ATT|FULL

OFF
The slot is inactive.

ATT
The power is reduced by the amount defined
using :BB:GSM:SLOT:ATT.

FULL
Full power as specified by the level setting.

*RST: Slot 0: FULL; Slots 1...7: OFF

Example: BB:GSM:SLOT2:LEV FULL
selects power control level Full Power for slot 2.

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:ATTenuation
<Attenuation>

The command selects one of seven possible values for the level attenuation. This value
defines by how much the power of the selected slot with power control

level :BB:GSM:SLOT:LEV ATT will be reduced in relation to the normal output power
(attribute . .. :LEVEL FULL). The seven possible values are set using the com-

mand : SOURce:BB:GSM: SATTenuation<n>.
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Burst Editor

Parameters:

<Attenuation> A1|A2|A3|A4|A5|AB|AT
Increment: 0.01 dB
*RST: 0dB

Example: BB:GSM:MODE SING

selects GSM mode Frame (Single).
BB:GSM:SLOT1:LEV ATT

sets level attenuation mode for slot 1.
BB:GSM:SATT1 12dB

sets the level attenuation for selection A1 to 12 dB.
BB:GSM:SLOT1:ATT Al

sets the level attenuation for slot 0 to 12 dB.

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:FILTer:TYPE
<Type>

(for Higher Symbol Rate slots and instruments equipped with K41 only)

Selects whether a Narrow Pulse Shape or a Wide Pulse Shape filter should be use for
the selected burst type and modulation.

Parameters:

<Type> ENPShape|EWPShape
*RST: -

Example: BB:GSM:SRAT:MODE HSR

selects higher symbol rate mode.
BB:GSM:FRAMI : SLOT1:TYPE H16Q

selects HSR 16QAM burst type for slot 1.
BB:GSM:FRAM1:SLOT1:FILT:TYPE EWPS

selects Wide Pulse Shape filter for slot 1.

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:MULTislot<st0>:COUNt <Count>

The command defines the number of slots combined in a multislot. Since multislot
involves connecting multiple slots to a single user channel, this configuration is possible
for Normal (Full Rate) bursts Normal (8PSK / EDGE) burst

(SOUR:BB:GSM:FRAM: SLOT: TYPE NORM|EDGE) and EDGE Evolution bursts.

The suffix in MULTis1ot defines the first slot in a multislot group. In a multiframe con-
figuration this setting applies to the slots in all frames.

Parameters:
<Count> integer

Range: 1t 8
*RST: 1
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Example: BB:GSM:MODE SING

selects GSM mode Frame (Single).
BB:GSM:SLOTO0:TYPE NORM

selects the NORMal burst type for slot 0.
SLOT1 ... SLOT7

selects burst type for slots 1 to 7 correspondingly.
BB:GSM:MULTO0:COUN 8

defines a multislot from all 8 slots.
BB:GSM:MULTO:STAT ON

switches the multislot configuration on.

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:MULTislot<st0>:STATe <State>
The command switches the multislot configuration on.

The suffix in MULTislot defines the first slot in a multislot group. In a multiframe config-
uration this setting applies to the slots in all frames.

Parameters:
<State> 0]1|OFF|ON

*RST: OFF
Example: BB:GSM:MODE DOUB

selects GSM mode Frame (Double).
BB:GSM:SLOTO: TYPE NORM
selects the NORMal burst type for slot 0.

SLOT1 ... SLOT7
selects burst type for slots 1 to 7 correspondingly.
BB:GSM:MULTO:COUN 8
defines a multislot from all 8 slots.
BB:GSM:MULTO: STAT ON
switches the multislot configuration on.

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>][:SOURce]:DATA
<Data>

The command defines the data source for the DATA fields in the burst. This command
is valid only when burst types that contain data fields are selected. If a burst contains
multiple DATA fields, these are treated as a continuous field, and for instance data such
as a pseudo-random sequence is continued without interruption from one DATA field to
the next.

In "GSM Mode Unframed", this command defines the data source for the unframed signal.
The suffix in : SLOT has to be set to 0 (BB: GSM: SLOTO : DATA).
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Parameters:

<Data> PN9|PN11|PN15|PN16|PN20|PN21|PN23|DLISt|ALLO|ALL1|
PATTern
PNxx
The pseudo-random sequence generator is used as the data
source. There is a choice of different lengths of random sequence.
DLISt
Adatalistis used. The datallist is selected with the aid of command
SOURce:BB:GSM: SLOT:DATA:DLISt.
ALLO | ALL1
Internal 0 or 1 data is used.
PATTern
Internal data is used. The bit pattern for the data is defined with
the aid of command : SOURce :BB:GSM: SLOT : DATA: PATTern.
*RST: PN9

Example: BB:GSM:SLOT2:TYPE NORM

selects NORMAL burst type for slot 2.

BB:GSM:SLOT2:DATA PN15

selects internal PRBS data with period length 2'5-1 as the data
source for the DATA fields in the burst. The pseudo-random
sequence is continued without interruption from one DATA field to
the next.

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>][:SOURce]:
DATA:DLISt <DList>

The command selects a data list. This command is only valid for bursts with DATA fields.
This data list is only used if it is set as the data source with the aid of com-
mand :BB:GSM:SLOT:DATA DLIS.

Parameters:
<DList> string
Example: BB:GSM:SLOT2:TYPE NORM

selects NORMAL burst type for slot 2.

BB:GSM:SLOT2:DATA DLIS

selects internal data lists as the data source for DATA fields.
BB:GSM:SLOT2:DATA:DLIS 'test'

selects the test data list. The data list is continued without inter-
ruption from one DATA field to the next.
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[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>][:SOURce]:
DATA:DLISt:CATalog?

This command reads out the data list files in the default directory. The default directory
is set using command MMEM: CDIRectory. Only files with the file extension *.dm iqd
will be listed.

Return values:
<Catalog> string

Example: MMEM:CDIR '<root>\user\dlist gsm
sets the default directory to <root>\user\dlist_gsm.
BB:GSM:SLOT2:DATA:DLIS:CAT?

queries the available data lists in <root>\user\dlist_gsm.
Response: 'test 01','test 02'

data lists test 01 and test_ 02 are available in <root>\user
\dlist_gsm.

Usage: Query only

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>][:SOURce]:
DATA:PATTern <Pattern>

The command selects the data pattern for the internal data when PATTern is selected
as the data source. The length depends on the length of the data fields in the selected

burst type.
Parameters:
<Pattern> integer
*RST: 0
Example: BB:GSM:SLOT2:TYPE ACC

selects the Access burst type for slot 2. This burst type contains a
36-bit data field.
BB:GSM:SLOT2:DATA PATT

selects Pattern as the data source.
BB:GSM:SLOT2:DATA:PATT #HS801FA,20

generates the data for the data field in the burst.

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:SFLag <SFlag>

The command sets the Stealing Flag state (only for Normal burst : BB: GSM: SLOT : TYPE
NORM).

Parameters:
<SFlag> 0|1

*RST: 0
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Example: BB:GSM:SLOT2:TYPE NORM

selects NORMAL burst type for slot 2.
BB:GSM:SLOT2:SFL 1

sets Stealing Flags for slot 2 to the value 1.

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:SFLag:USE
<Use>

The command enables or disables the use of Stealing Flags. If not used, the Stealing
Flags bits are allocated to the DATA fields (only for Normal burst : BB: GSM: SLOT : TYPE

NORM).
Parameters:
<Use> 0|1|OFF|ON
*RST: On
Example: BB:GSM:SLOT2:TYPE NORM

selects NORMAL burst type for slot 2.
BB:GSM:SLOT2:SFL 1

sets Stealing Flags for slot 2 to the value 1.
BB:GSM:SLOT2:SFL:USE ON

enables the use of Stealing Flags for slot 2.

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>][:SOURce]:TSC:
SELect <Select>

The command selects the training sequence code. The values specified in GSM 5.02 are
TO...T7. When USER s selected, the value specified with the aid of the ...: TSC: USER
command described next is used.

Parameters:

<Select> TO|TA|T2|T3|T4|T5|T6|T7|JUSER
*RST: TO

Example: BB:GSM:MODE SING

selects Single Frame mode.
BB:GSM:SLOT2:TYPE NORM

selects Normal burst for slot 2.
BB:GSM:SLOT2:TSC:SEL T3

selects training sequence code T3 for slot 2.
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[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>][:SOURce]:TSC:
USER <User>

The command specifies the user-defined training sequence code. This code is used if
the USER parameter is set with the aid of the : BB: GSM:SLOT: TSC: SEL command
described above. The length is 26 bits for : BR:GSM: SLOT: TYPE NORMal and 78 bits
for :BB:GSM:SLOT: TYPE EDGE.

Parameters:

<User> integer
Range: #B0,1 to #B111 ,1...26/78 bits
*RST: #H0970897

Example: BB:GSM:SLOT3:TSC:USER #H3FFFFFF

enters the user-defined training sequence for slot 3.

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:ETSC <Etsc>

The command selects an extended training sequence for the Synchronization burst.
There is a choice of three predefined sequences STANdard | CTS | COMPact and, if
defined, a USER sequence (only for selection of burst type :BB:GSM: SLOT : TYPE

SYNC).

Parameters:

<Etsc> STANdard|CTS|COMPact|USER
*RST: STANdard

Example: BB:GSM:SLOT:TYPE SYNC

selects Synchronization burst for slot 1.
BB:GSM:SLOT:ETSC CTS

selects the extended training sequence CTS.

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:ETSC:USER
<User>

(only for selection of burst type :BB:GSM: SLOT: TYPE SYNC)

The command selects an extended training sequence for the Synchronization burst
USER sequence.

Parameters:
<User> integer
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Example: BB:GSM:SLOT:TYPE SYNC
selects Synchronization burst for slot 1.
BB:GSM:SLOT:ETSC USER
selects the extended training sequence User.
BB:GSM:SLOT:ETSC:USER #H5ab5ab5a5a5a5ab5aba, 64
sets the ETSC.

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:SYNC:SELect
<Select>

The command selects a training sequence (SYNC sequence) for the Access burst (only
for burst type selection :BB:GSM: SLOT: TYPE ACC).

Parameters:
<Select> TO|T1|T2JUSER
*RST: TO
Example: BB:GSM:SLOT1:TYPE ACC

selects Access burst for slot 1.
BB:GSM:SLOT1:SYNC:SEL T1

selects Sync sequence T1.

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:SYNC:USER
<User>

The command outputs the bit pattern of the User Sync sequence for the Access burst.
The length is 64 bits. Superfluous bits are truncated on input. Missing bits are filled with
0. The command is valid only for selection :BB:GSM: SLOT: SYNC: SEL USER and for
burst type selection :BB:GSM: SLOT: TYPE ACC.

Parameters:
<User> integer
Range: #B0,1 to #B111...,.41
*RST: Bit pattern from TO
Example: BB:GSM:SLOT1:TYPE ACC

selects Access burst for slot 1.
BB:GSM:SLOT1:SYNC:SEL USER

selects the User Sync sequence.
BB:GSM:SLOT1:SYNC:USER #HFFFFFFFFFFO0, 41

enters the User Sync sequence.
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[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:FCORrection:
FIXed <Fixed>

The command selects the content of the FIXED field for the Frequency Correction burst.
There is a choice of two predefined sequences STANdard and COMPact and, if defined,
a USER sequence (only for burst type selection :BB: GSM: SLOT: TYPE

FCORrection).

Parameters:

<Fixed> STANdard|COMPact|USER
*RST: STANdard

Example: BB:GSM:SLOT:TYPE FCOR

selects Frequency Correction burst for slot 1.
BB:GSM:SLOT:FCOR:FIX COMP

selects content type COMPact for the Fixed field.

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:FCORrection:
FIXed:PATTern <Pattern>

The command enters the bit pattern of the FIXED field for the Frequency Correction burst.
The length is 142 bits. Superfluous bits are truncated on input. Missing bits are filled with
0. The command is valid only for the selection :BB:GSM: SLOT: FCOR: FIX USER and
for burst type selection :BB:GSM: SLOT: TYPE FCOR.

Parameters:
<Pattern> integer
Range: #B000...0,142 to #B111...1,142
*RST: Bit pattern from the STANdard
Example: BB:GSM:SLOT:TYPE FCOR

selects Synchronization burst for slot 1.
BB:GSM:SLOT:FCOR:FIX USER

selects content type USER for the Fixed field.
BB:GSM:SLOT:FCOR:FIX:PATT #B0,142

enters the content of the field.

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:DUMMy:MiXed:
PATTern?

This command outputs the bit pattern of the Mixed field of the Dummy burst. The contents
of the Mixed field is fixed and specified by the standard, the length is 142 bits.

Return values:
<Pattern> integer

|
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Slot Marker Definition

Example: BB:GSM:SLOT1:TYPE DUMM

selects Dummy burst for slot 1.
BB:GSM:SLOT1:DUMM:MIX:PATT?

outputs the bit pattern of the Mixed field.
Response:

Usage: Query only

4.9 Slot Marker Definition

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:TRIGger:
OUTPut:TAG?

The command queries the content of the specified marker in the selected file.

Suffix:

<di> <di>

<st0> o|1]..7

<ch> <di>

Parameters:

<Tag> string

Example: BB:GSM:FRAM: SLOT0:UER] : TRIG:OUTP: TAG? "MARKER
LIST 1"
queries the content of the marker list 1.
Response: 0:1;59:0;64:1,70:0

Usage: Query only

|
Operating Manual 1171.5254.12 — 10 102



GSM/EDGE List of Commands

List of Commands

[:SOURCe<hW>]:BB:GSM:CLOCK:DIVIET.......cciiuiietiieiieeiie ettt e et e e saee e s e e sneeeeseaenns 75
[:SOURCce<hw>]:BB:GSM:CLOCK:MODE............coitiiiiieiiie ettt ettt s e e sbeestaesneeeeneeaseeanes
[:SOURce<hw>]:BB:GSM:CLOCk:MULTiplier..
[:SOURCe<hw>]:BB:GSM:CLOCK:SOURCE.......coeiuiieiiieiieaiee ettt ettt ste e et e e st e e saeeeeeeeneeesnseaaseaanns
[:SOURce<hw>]:BB:GSM:CLOCk:SYNChronization:EXECULE. .........ccccoriiiiiiiiiiiiie e 76
[:SOURce<hw>]:BB:GSM:CLOCK:SYNChronization:MODE.............ccccecoiiiiiiiiee e 77
[:SOURce<hw>]:BB:GSM:EDGE:FORMEL.........ccoiiiiiiiiiiii ettt eaee e e sneeeneee e 68
[:SOURce<hw>]:BB:GSM:FILTErEDGE:TYPE.........oiii it 73
[:SOURce<hw>]:BB:GSM:FILTer:H16Qam:TYPE.........coui ittt st 73

[:SOURce<hw>]:BB:GSM:FILTer:H32Qam:TYPE.........cci ettt 74
[:SOURce<hw>]:BB:GSM:FILTEerHQPSK:TYPE.........otiiiiieiii et 74
[:SOURce<hw>]:BB:GSM:FILTErN16Qam:TYPE.........coi ittt 73
[:SOURce<hw>]:BB:GSM:FILTer:N32Qam:TYPE.........ccci ittt 73
[:SOURce<hw>]:BB:GSM:FILTErOSAMPIING. ... ..ciitiiitieiiee ittt ettt tee e 72
[:SOURce<hw>]:BB:GSM:FILTer:OSAMPING:AUTO. . ..ottt ettt ae e e e 72
[:SOURCce<hw>]:BB:GSM:FILTEr:PARAMELEN ...ttt e e e e e 72
[:SOURCe<hW>]:BB:GSM:FILTEINTYPE. ... ittt 71
[:SOURCE<hW>]:BBIGSMIFLENGN. ...ttt e beesnee e 56
[:SOURCE<hW>]:BBIGSMIFONE.......c.oiiiiiiietiiiete ettt ettt ea ettt et ettt et e ente e anees 57
[:SOURCE<hW>]:BB:GSMFORMEL.......coiiiiiiiiiiie ittt ettt tee e 68
[:SOURce<hw>]:BB:GSM:FRAMe<di>:REPELItIONS.........ccueiiiiiiieciee e 58
[:SOURce<hw>]:BB:GSM:FRAME<di>:ULISt:CATAIOG. .....ccueiiieiieieitieieeieesee et 64
[:SOURce<hw>]:BB:GSM:FRAMe<di>:ULISt:DELE.........cooiiiiiiiiiiiieet e 64
[:SOURce<hw>]:BB:GSM:FRAME<Ai>:ULIStILOAD..........viiiieieeie ettt e e e e 64
[:SOURce<hw>]:BB:GSM:FRAME<di>:ULISt:STORE. ......coiiiiiiiiieiieeiiie e 65
[:SOURCe<hw>]:BB:GSM:FSKIDEVIGtON. .....ccoctiiiiiiiiiieiii ettt ettt st
[:SOURce<hw>]:BB:GSM:H16Qam:FORMEL...........coiiiiiieiiieiieeiet ettt ee e
[:SOURce<hw>]:BB:GSM:H32Qam:FORMat...

[:SOURce<hw>]:BB:GSM:HQPSK:FORMEL........cooiiiiiiiiiiiiiie ettt
[:SOURCE<hW>]:BB:IGSM:ISLENGLN........eiiiieiii ittt ettt et e et e s bee st e e seeebeesnneanee
[:SOURCE<hW>]:BB:GSMIMODE...... ..ottt b ettt nnees 59
[:SOURce<hw>]:BB:GSM:N16Qam:FORMEL...........coiiiiiiiiiieiii e e 70
[:SOURce<hw>]:BB:GSM:N32Qam:FORMEL..........ccoitiiiiieiiieiiie ittt sieeesiee e 71
[:SOURce<hw>]:BB:GSM:PRAMP:BBONIY[:STATEL.....ceeitiiiiitieiieteeie ettt 90
[:SOURce<hw>]:BB:GSM:PRAMp:FDELay
[:SOURce<hw>]:BB:GSM:PRAMP:IRDELAY......ccc.ciitiiiiieiiieeiee ettt ettt et et esaeeesbeeesneeesneeenseeanes 91
[:SOURCe<hw>]:BB:GSM:PRAMPISHAPE. ... ..ottt ettt 91
[:SOURCe<hw>]:BB:GSM:PRAMP:TIME........ciiiiiiiiiiieee ettt ettt nne e nine e 91
[:SOURCEShW>]:BB:GSIMIPRESEL........cciiitiiie ettt e et e e e et e e e et be e e e eaae e e e sareeeeenbaeeeannes 59
[:SOURCce<hw>]:BB:GSM:SATTENUAIONSCN> ... ..ottt e e st e e e enneee e e 59
[:SOURCce<hw>]:BB:GSM:SETTING:CATAIOF. ... .ccitiiitiiiiieaiiee ettt sttt ettt nine e 60
[:SOURCce<hw>]:BB:GSM:SETTING:DELELE.......eiiiiiiiiieie ettt seee e 60
[:SOURCce<hw>]:BB:GSM:SETTING:LOAD. ......ooiiiiiii ittt sttt nnees 61
[:SOURCe<hw>]:BB:GSM:SETTING:STORE. ......ciiiiiiiiiiitiecie ettt ettt siee e 61
[:SOURCE<hW>]:BBIGSMISLENGLN.......ciiiiiiiii ittt sttt et e e e b e st e e seeebeesneeanee 57
[:SOURce<hw>]:BB:GSM:SMODe

[:SOURCEShWS]:BBIGSIMISRATE. ...ttt ettt b ettt e e bt e et e e ae e e nneeeteeenes
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[:SOURCe<hw>]:BB:GSM:SRATEIMODE.........ccoiiiieiiiee ettt et e et e e etae e e eare e e e neeeeenaeeennnes 62
[:SOURCESNWS]:BBiGSMISTATE. ...ttt ettt b bbbt ab e ab e e b abe e neanees 63
[:SOURce<hw>]:BB:GSM:TRIGGErARM:EXECULE. .......oiiiiiiiiiiiie ettt e 78
[:SOURce<hw>]:BB:GSM:TRIGGEINEXECULE. ........ciiiiiiiiiieiiie ittt ettt estee e 79
[:SOURce<hw>]:BB:GSM:TRIGger:EXTernal:SYNChronize:OUTPUL............cooiiiiiiiiiiiiiee e 79

[:SOURce<hw>]:BB:GSM:TRIGger:OBASeband:DELay
[:SOURce<hw>]:BB:GSM:TRIGger:OBASeband:INHibit

[:SOURce<hw>]:BB:GSM:TRIGger:OUTPuUt:DELay:FIXed..........coooiiiiiiiiiiiieeee e 84
[:SOURce<hw>]:BB:GSM:TRIGger:OUTPUt<Ch>:DELAY........ccccociiiiiiiiiieiiee et 85
[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:DELay:MAXIMUM.........ccccuiiiiriiianiieie e 85
[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:DELay:MINIMUM...........ccccoiiiiiiiiiiiiiiiie e 86
[:SOURce<hw>]:BB:GSM:TRIGger:OUTPU<Ch>:MODE...........cccociiiiiiiiieiie e 86
[:SOURce<hw>]:BB:GSM:TRIGger:OUTPUt<Ch>:OFFTIME.......cccceiiiiiiieiiieiiee et 87
[:SOURce<hw>]:BB:GSM:TRIGger:OUTPUt<Ch>:ONTIME........c.ciiiiiiiiiiieiii ettt 87
[:SOURce<hw>]:BB:GSM:TRIGGer:OUTPUt<Ch>PATTEIM. ...ttt e 88
[:SOURce<hw>]:BB:GSM:TRIGger:OUTPuUt<ch>:PERIOA:SLOT ........ccoiiiiiiiieiieeriie e e 88
[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:PERIOA[:FRAME].........coiiiiiiiiiiaiiieie e 88
[:SOURce<hw>]:BB:GSM:TRIGger:OUTPuUt<ch>:PULSE:DIVIEr.........c.ceiiiiiiiiiiiiiiienieeec e 89
[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:PULSe[:FREQUENCY]..........ccceeiuieriiiiiiieniiiesiie e 89
[:SOURce<hw>]:BB:GSM:TRIGGEIRMODE..........coitiiiiiaiiie ittt ettt e e st e st e e saeeesteeeeneeesneeeaseaanns 81
[:SOURce<hw>]:BB:GSM:TRIGGEISLENGIN. .......oiiiiiiiiiiee et 81
[:SOURCce<hw>]:BB:GSM:TRIGGEISLUNIL........cceiiiiiiitiiee ittt ebeeseee e 82
[:SOURce<hw>]:BB:GSM:TRIGGEISOURCE. ......cueiitiiiiieaiiie ettt ettt ese e e beeeeeeeneeesnseesseaenes 82
[:SOURce<hw>]:BB:GSM:TRIGger[:EXTernal<Ch>]:DEL@Y..........cccociiriiiiiiiiiniieiiee et 83
[:SOURce<hw>]:BB:GSM:TRIGger[:EXTernal<ch>]:INHIbit..............ccoiiiiiiiiiiiiie e 84
[:SOURce<hw>]:BB:GSM:WAVEfOrMICREALE. ........ccciiiiiiiiieiie ettt st 63
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:MULTIislot<st0>:COUNL...........coeriiiiirieieeriesee e 94
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:MULTISIOt<St0>:STATE.....ccccirrieeeiiieeeeccteeee e e e e rrre e e 95
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:PREDefined:CATalOg..........ceriuiiiiiaiiiieiiieaie e 65
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:PREDEfINE€d:LOAD..........cceiriiiiriieiiii i 65
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<StOZ:TYPE........ccooiiie et ecteee et e e 93
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:ATTenuation..............ccccceerurrnirenienainannns 93
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:DUMMy:MIXed:PATTern.........ccccccccu... 101
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<stO>[:USER<Ch>]:ETSC.......ccceeiiirieeecir e 99
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:ETSC:USER..........cccceeiiiiiiiiiriiireieens 99
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:FCORrection:FIXed...........c.cccoeerverrnren. 101
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:FCORrection:FIXed:PATTern............... 101
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:FILTer:TYPE..
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<Ch>]:LEVEl........ccceerorriririiieneee e
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:PREDefined:CATalog.........c.cccceerurrrreruns 66
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:PREDefined:LOAD........c..cccceeerrierriurannns 66
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<Ch>]:SFLag.......c..cecrtvrrerrrrirreeneaeereee e 97
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:SFLag:USE............cccccecuiiiniiirrieniniieanns 98
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:SYNC:SELect..........c.ceccerriririeriraen. 100
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:SYNC:USER...........cccceeverrrrrrrrrrenne. 100
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:TRIGger:OUTPuUt: TAG............coeeerrurenn. 102
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:ULISt:CATalog........cccevurrerrirerieeaiireas 66
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:ULISt:DELete..........ccerreerrrrirrirarerrnnnns
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:ULISt:LOAD...
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:ULISt:STORE........c.ceeetereiiiireiieaeirees
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[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>][:SOURCE]:DATA.......ccceserereririrerrerennns 95
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>][: SOURce]:DATA:DLISt.........ccecvevirrencnn 96
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>][:SOURce]:DATA:DLISt:CATalog............. 97
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>][:SOURce]:DATA:PATTerN..........cccceeeruues 97
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>][:SOURce]: TSC:SELect...........c.ccocverrnren. 98
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>][:SOURce]: TSC:USER............ccccceerrurue.. 99
[:SOURce<hw>]:BB:GSM[:TRIGEr:SEQUENCE..........coceeeiriieiirieeie et 78
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